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ご注意 

1. 本書に記載した内容は、予告なしに変更することがあります。 

2. 本書は、内容について細心の注意をもって作成いたしましたが、万一ご不審な点や誤り、記載もれ等、

お気付きの点がございましたら当社までお知らせください。 

3. 当社では、下記の項目を補償の対象から除外いたします。 

 ユーザーの誤った操作に起因する機器などの損傷、性能上のトラブル、損害 

 本装置の本来の用途以外の使用に起因する機器などの損傷、性能上のトラブル、損害 

 本装置の不適切なユーテリティや使用環境に起因する機器などの損傷、性能上のトラブル、

損害 

 当社が指定した業者以外で本装置の修理や改造をしたことに起因する機器などの損傷、性能

上のトラブル、損害 

 当社提供外のソフトウエアの使用による信頼性、機器などの損傷、性能上のトラブル、損害 

 分析結果に基づく損失 

4. 本書の内容の一部または全部を無断で複写、転載したり、他のプログラム言語に翻訳することは法律

で禁止されています。複写、転載等の必要が生じた場合は、当社にお問い合わせください。 

5. 本製品パッケージとして提供した本マニュアル、またはＣＤ-ＲＯＭ等の媒体は本製品用だけにお使

いください。プログラムをコピーする場合はバックアップ用だけにしてください。プログラムをその

ままの形で、あるいは変更を加えて第三者に販売することは固く禁じられています。 



 

 

分析機器を安全にお取扱いいただくために 

1. 本分析機器は、当該分野に関して基礎的知識のある人が使用することを前提として設計、製作されて

います。 

2. 分析機器内部には、高温部、高圧部、高電圧部、可燃性ガス/液体、毒性ガス/液体、高輝度部、放射

線源等が存在することがあります。当該製品を取り扱う際は、本書の安全に関する指示事項に従って

ください。なお、これらの指示事項に反する扱いをされた場合、当社は安全性を保証いたしません。 

3. 本説明書は、お求めいただいた機器を安全に、正しく操作するために必要な事項が書かれています。

本書をよく読み、内容を理解してから機器の操作を開始してください。 

4. 本書を読んで不明な点、あるいは機器を操作して不明な点や異常がありましたら、本書巻末に記載さ

れている当社カストマコンタクトセンタにお問い合わせください。 

5. 本説明書は、必要なときにすぐ取り出せる場所に、大切に保管してください。万一、本説明書を汚損、

紛失した場合には新本を購入してください。 

6. シンボルマークの種類と意味は下記の通りです。ただし、下記のシンボルマークが全て本製品に使用

されているとは限りません。 

シンボルマーク 意 味 

 

一般的な警告、注意、危険の通告 

 

特定の条件下での、高温による傷害の可能性の注意、警告 

 

特定の条件下での、感電の可能性の注意、警告 

 
特定の条件下での、発火の可能性の注意、警告 

 

放射性同位元素の使用による危険の警告 

 

保護接地端子。接地要求 

危険/DANGER 
無視して取扱いを誤った場合、死亡又は重傷を負う、切迫し

た危険状態の存在を示す 

警告/WARNING 
無視して取扱いを誤った場合、重傷又は軽傷を負う、潜在的

危険の存在を示す 



 

 

注意/CAUTION 
無視して取扱いを誤った場合、物的損害が発生する潜在的危

険の存在を示す 
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第１章  立ち上げと操作の流れ、分析の準備 

始動操作から終了操作までの流れは次の通りです。 

 

始動操作（電源 ON →キャピラリー、バッファ、サンプルをセット）  

↓  

分析 １．分析条件（メソッド）設定 

２．データ取り込み 

３．データ解析（定性・定量） 

４．報告書作成 

↓   

終了操作（電源 OFF） 

 

 

１－１．装置、ChemStation の起動と終了 

【装置、ChemStation の起動 】 

① 各機器のメイン電源スイッチを下記の順番で投入します。 

プリンター、モニター 

↓    イニシャライズを確認する 

コンピューター 

↓    イニシャライズを確認する 

Agilent 7100 キャピラリー電気泳動本体 
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Windows を起動中、ログオンの開始（Begin Logon）ウィンドウが表示されます。 

指示に従って Ctrl + Alt + Delete キーを同時に押します。（設定によっては、この操作

が不要な場合もあります。） 

 

② ログオン情報（Logon Information）でユーザー名とパスワードを入力します。ユーザ

ー名に対するパスワードは下表のとおりです。 

 

OS の種類 ユーザー名 

（User Name）
パスワード 

（Password） 

システムを変更する権限 

Windows XP Administrator 3000hanover 有り。 

通常こちらを使用します。 

Windows XP Chemist hp 無し 

Windows 
Vista 

admin 3000hanover 有り。 

通常こちらを使用します。 

Windows 
Vista 

Chemist hp 無し 
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③ ChemStation を起動します。Windows の起動後、Windows のスタートメニューから

下記のように選択します。 

 

Start → Programs → Agilent ChemStation → Instrument 1 Online 
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④ ChemStation のオンライン画面が起動します。 

      ChemStation 初期起動画面 

 

⑤ 起動後、まずランプを点灯します。 

 

ランプの絵を右クリックして、表示される 

メニュー内、Switch UV Lamp On を 

クリックします。 
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(参考) ランプ点灯状況の変化 

 

 

 

 

  未点灯      点灯中      点灯後 

 

⑥ ランプが点灯し、キャピラリーカセット温度が設定値で安定すると、システムが

Ready 状態になります（下図）。この状態になると分析を開始できます。 
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【装置、ChemStation の終了】 
① データ取り込み中でないことを確認します。 

② ランプが点灯中の場合は消灯します。ランプの絵を右クリックして、表示されるメニ

ュー内、Switch UV Lamp Off をクリックし消灯します。 

③ Agilent ChemStation を終了します。 

メニュー File → Exit をクリックするか、画面右上の×をクリックして終了します。 

 

＜注意＞ ChemStation を次回起動する時は、最後に終了した Method（メソッド／条件）

が読み込まれます。ChemStation の終了前に、次回起動時の Method を読み込み直しておく

か、保存しておくと便利です。 

 

④ 全てのアプリケーションプログラムを終了します。 

⑤ Start → Turn Off Computer →  Turn off  をクリックして終了します。 

⑥ Agilent 7100 キャピラリー電気泳動本体 

        ↓   

  コンピューター 

        ↓   

プリンター、モニター   

   の順番で電源をオフにします。 

 

＜注意＞  

分析に使用したキャピラリーを洗浄してから、システムを終了して下さい。詳細は 14-2

「キャピラリーの保管方法」と 14-3 節「シーケンス終了時のキャピラリー洗浄について」

を参照して下さい。 
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１－２．操作の流れ 

【データ取り込みのフロー】 

データ取り込みは、以下のフローで行います。 

 

新規メソッドの読み込み          （2 章） 

       ↓ 

メソッドの編集           （2 章） 

       ↓ 

メソッドファイルの保存           （2 章） 

       ↓ 

メソッドの実行                  （3 章） 
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１－３．分析の準備 

 

本章では弊社標準据付時の動作確認、および点検（Agilent メンテナンス）時に用いられ

る Installation Qualification Kit（以下 IQ キットと略称、納入時付属部品 P/N:5063-6514）

を例に取り、分析の準備と手順、および注意点について説明します。 

 

【準備品】       (＊)は IQ キットに含まれます。 

 品名 条件 

 バッファ（＊） 20mM ホウ酸バッファ pH9.3 

サンプル  (＊） 4-hydroxy acetophenone (1mM) 

キャピラリー id:50μm L:40cm                     P/N:G1600-60211

アラインメント 

インターフェース 
id:50μmキャピラリー用                  P/N:G7100-60210

バイアル 

（バッファ用） 

･CE専用ガラス製バイアル                P/N:5182-9697
･ポリプロピレン製バイアル        P/N:5182-0567

バイアル 

（サンプル用） 
･ポリプリピレン製バイアル        P/N:9301-0978

キャップ 
･ポリウレタン製 半透明         P/N:5181-1512
･ポリエチレンオレフィン製 乳白色    P/N:5181-1507

 

＜注意＞ 

・ バイアル（バッファ用）は、ガラス製がポリプロピレン製に対して約 3倍程度の容量大

となります。そのため、ガラス製を使用するとバッファの消耗を遅らせると共に、再現

性の向上にもつながります。 
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特別なアプリケーション以外では、ガラス製バイアルのご使用を強く推奨します。なお、

ガラス製バイアルは必ず指定部品（P/N：5182-9697）を使用して下さい。このバイアルは

耐圧性です。指定以外のガラス製バイアルを使用すると破損の危険性があります。 

 

・ キャップは 2 種類のそれぞれについて特性が違います。  

1.ポリウレタン製（半透明）：密閉性に優れていますが、耐薬品性に多少劣ります。 

2.ポリエチレンオレフィン製（乳白色）：耐薬品性に優れていますが、密閉性に劣ります。 

特別なアプリケーション以外は、ポリウレタン製（半透明）を使用して下さい。 

 

・ 上記 2 種類以外のキャップは使用しないで下さい。クリンプタイプやスクリュータイプの

キャップは決して使用しないで下さい。 

 

・ 箱から出した新品のキャピラリーは、まずコンディショニングを実施する必要がありま

す。通常は使用するバッファで 20～30 分程度実施します。なお、NaOH による洗浄は

基本的に推奨しません。 

（コンディショニングに要する時間は分析条件毎に異なります。） 

 

・ ただし、キャピラリーの汚れが多い場合など、バッファによるコンディショニングのみ

で安定しない場合は、NaOH を追加して使用することで改善につながる場合もありま

す。NaOH を用いたコンディショング例として以下の手順を紹介します。 

1N NaOH (Flush 10min) → Ultrapure Water (Flush 10min) → Buffer (Flush 20min) 

それぞれの洗浄時間はキャピラリーの状態によって適宜変更してください。 
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＜注意＞ 

・ NaOH による洗浄はアプリケーション、あるいは使用しているキャピラリーの種類によ

って実施不可な場合があります。詳しくは各アプリケーションキットのマニュアル（手

順書）を確認してください。 

・ コーティングキャピラリー使用の場合は、付属の取扱説明書を熟読してください。 

・ 詳細は、14-1 節の「水酸化ナトリウム水溶液によるキャピラリー洗浄とその効果」を

参照してください。 
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【実施手順】バイアルの準備 
① 100～1000μl のピペットを用い、バッファをバイアル(バッファ用)に入れてキャップし

ます。 

  ・ガラス製バイアル    ：通常 1.4～1.6ml 入れます。 

  ・ポリプロピレン製バイアル：通常 500μl 入れます。 

② 廃液用のバイアルには、バイアル内底面から約 5mm 程度の高さ（約 400～500μl）ま

で水を入れて下さい（キャピラリー先端が浸かる高さが目安です。） 

 

＜注意＞ 

・ キャップをする際、キャップの内側に液が付かないようにして下さい。もしついてしま

った場合は、一度キャップを外し、付着した液を拭きとって下さい。液がついたままで

分析を実施すると、再現性に悪影響を与える可能性があります。 

・ インレット側とアウトレット側のバイアル（バッファ用）は、同じ液量（液面高さ）に

なるようにして下さい。 

・ ガラス製バイアルはポリプロピレン製バイアルに対して約 3 倍程度の容量があります。

そのため、ガラス製を使用するとバッファの消耗を遅らせると共に、再現性の向上にも

つながります。 

 

③ 10～100μl のピペットを用い、サンプルをバイアル（サンプル用）に入れてキャップし

ます。 

・サンプルの量は 20μl とします。 

また最低限必要なサンプル量としては、それぞれ以下の液量が必要となります。 

a) 加圧注入法：  キャピラリーの先端が浸かる液量。 

b) 電気的注入法： 電極の先端が十分に浸かる液量。 
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＜注意＞ 

・ バイアル（サンプル用）はポリプロピレン製で撥水性が高く、かつ内部が先細い形状の

ため、バイアル底面に空気が残りやすい構造になっています。サンプルバイアルに空気

が入らないようにしてください。 

空気が残ったままで分析を実行した場合、注入が不十分になり、分析に支障をきたす場

合があります。そのため、空気が残った場合は、キャップをしたままでバイアルを軽く

振り、残った空気を抜いて下さい。その際キャップ内側に液が付かないように慎重に実

施下さい。 

・ 誤動作の原因となるため、バイアルにラベルを貼らないでください。バイアルやキャッ

プ側面へのペンによる記入は可能です。 

 



 

- 13 - 

【実施手順】キャピラリーカセットの取り外し 
① まず検出器のランプを消灯します。（任意） 

Method＆Run control 画面上のランプの絵を右クリックしてメニューを表示させます。 

この中の Switch UV lamp off   をクリックします。 

     

② 続けて Method＆Run control 画面上のカセットの絵を右クリックしてメニューを表示

させます。この中の  Change Cassette   をクリックします。この操作により、キャ

ピラリーの末端からバッファバイアルが自動的に取り除かれます。 

 

            ここをクリックします 
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③ Change Cassette   をクリック後、以下のウィンドウが表示されます。 

        

カセットを交換する準備を行っています。  

『Reload Vials』にチェックを入れてある場合、 

カセットを交換する際のインレット、アウトレット   

の各バイアルが再度セットされます。 

 

 

トップカバーを開けてカセットの交換が可能です。 

この表示になったらトップカバーを開けて、カセット

ガイドを前に倒します。続けてカセットを注意深く取

り外します。 

 

 

④ トップカバーを開けます      ⑤ キャピラリーカセットを取り外します 

       

図 キャピラリーカセットの取り外し手順 
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＜注意＞ 

・ 分析条件を変更するなど、キャピラリーを交換する場合は、バッファバイアルをバイア

ルトレイにセットしたまま（残したまま）キャピラリーカセット交換を実施することが

あります。この場合、新しくセットしたキャピラリーがバイアルトレイに残った古いバ

ッファの中に浸かり、コンタミネーションの原因になる可能性があります。 

これを防ぐため、キャピラリーカセット交換実施前にインレット側およびアウトレット

側のバイアルを取り除いておくことが重要です。各バイアルの絵を右クリックでメニュ

ーが表示されます。Unload Inlet lifter と Unload outlet lifter をクリックします。  

 

 

 

 

 

 

あるいは、カセット交換時に『Reload Vials』のチェックを外してください。 
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【実施手順】キャピラリーカセットからのキャピラリーの取り外し 
キャピラリーカセットは、ラベルを貼る側の前面部とキャピラリーを固定する側の背面部の

2 つから成ります。両者を重ねてスライドさせると、Z 型の接合部が合い、磁石で前面部と

背面部が留まる仕組みでロックされる仕組みになっています。 

 

① キャピラリーカセットを両手で持ちます。 

② キャピラリーカセットの中心付近を、前面から指で押しながらゆっくり 8mm 程度スラ

イドさせます。前面に刻んである半円状の滑り止め部分を弦から弧の方向へ押してス

ライドさせます。 

③ カセットの上部を持ち上げて取り外します。 

 

＜注意＞ 

キャピラリーカセットを開けるとき、無理な力を加えるとカセット内部の部品が壊れること

があります。 

 

図 カセットのロック解除 

  

8mm 程度スライドさせる 

Z 型接合部 
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図 カセットを開けた状態 

 

＜警告＞ 

キャピラリーカセットを開けてキャピラリーを取り外す時は、目を保護するために安全メガ

ネを着用して下さい。 

 

④ インレット側のキャピラリー末端を留めているキャピラリーロックを押しながら、カセ

ットからキャピラリーを注意して取り外します。 

⑤ アラインメントインターフェースをキャピラリーごと注意して外します。 

 

磁石 

キャピラリーロック

フック 

フック

キャピラリー挿入ツール

(予備用) 

アラインメント 

インターフェース 
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【実施手順】キャピラリーからのアラインメントインターフェースの取り外し 

① キャピラリー挿入ツールを平らな面に置きます。 

② 挿入ツールの上にアラインメントインターフェースを載せ、外側の銀色のリングだけ

を押し付けて下さい。これでキャピラリーを固定しているアラインメントインターフ

ェースのバネ(黒いプラスチック部分)が緩んだ状態になります。 

③ 銀色のリングを下に押し付けたまま、アラインメントインターフェースから、キャピ

ラリーを注意して引き抜きます。 

④ 使用しないキャピラリーは、セル窓に白いプラスチックの保護カバーを付けてから、

箱にしまって下さい。 

 

＜注意＞ 

・ キャピラリーを動かしている間は、必ずアラインメントインターフェースの銀色のリン

グを押し続けてください。手を放してキャピラリーを動かすと、キャピラリーのセル窓

が破損する恐れがあります。 

・ キャピラリーの保管方法については 14-2 節を参照して下さい。 
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【実施手順】キャピラリーの取り付け 

① キャピラリー挿入ツールを平らな面に置きます。 

② キャピラリーを箱から取り出して、セル窓に白いプラスチックの保護カバーを取り外し

ます。 

③ 挿入ツールの上にアラインメントインターフェースを載せ、外側の銀色のリングだけを

押し付けて下さい。これでキャピラリーを固定しているアラインメントインターフェ

ースのバネ(黒いプラスチック部分)が緩んだ状態になります。 

④ 銀色のリングを下に押し付けたまま、アラインメントインターフェースの矢印刻印に沿

ってキャピラリーを差し込みます。この際、セル窓より前側(長さ 8.5cm の短い側)を持

って差し込むようにし、セル窓に無理な力が加わらないようにしてください。 

 

キャピラリーの取り付け/取り外しツール    キャピラリーの取り付け 

 

＜注意＞ 

・ アラインメントインターフェースの差込み部分の色と、キャピラリーのストッパーの色

はキャピラリーの内径とセルの形状を示しています。そのため、アラインメントインタ

ーフェースとキャピラリーのストッパーは必ず同じ色の組み合わせで使用して下さい。 

・ キャピラリーを動かしている間は、必ずアラインメントインターフェースの銀色のリン

グを押し続けてください。手を放してキャピラリーを動かすと、キャピラリーのセル窓

が破損する恐れがあります。 
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キャピラリーを差し込む際に、セル窓より後ろ側(長い側)のキャピラリーやストッパー部分

を持たないようにしてください。キャピラリーのセル窓が破損する恐れがあります。 

・ セル窓部分には触れないようにしてください。セル窓が汚れるとノイズ増大の原因にな

ります。万一、誤ってセルの部分を汚してしまった場合は、ケバのない柔らかい布また

は紙にメタノールもしくはイソプロパノール等を浸したもので注意して拭いて下さい。 

 

 

（参考） 

 

ストッパー 

 

 

 

   ＜取り付け良好な状態＞         ＜取り付け不十分な状態＞ 

※ストッパーが奥まで押し込まれている  ※ストッパーが奥まで押し込まれていない 

 

 

⑤ アラインメントシンターフェースを取り付けたキャピラリーを、キャピラリーカセット

に載せてキャピラリーを巻きつけます。 

⑥ キャピラリーカセット内の足（突起）の内側と外側を交互に巻くようにして下さい。巻

き終えた時点でキャピラリー同士が接触していないように調整して下さい。 

⑦ キャピラリーカセットに上部ふたをかぶせてスライドさせ閉めます。 

⑧ カセットから出ているアウトレット側のキャピラリーの長さがインレット側と同じに

なるように、調整します。カセットのキャピラリーロックを押すと、アウトレット側

のキャピラリーの長さを変更できます。 
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⑨ キャピラリーカセットを装置に取り付けます。キャピラリーが電極の中にスムーズに入

るように注意しながら差込んでください。キャピラリーカセットを軽く下に押さえつ

けるようにしながらガイドを後ろに倒しこんでキャピラリーカセットを固定します。 

 

⑩ トップカバーを閉めて、Change Cassette 画面の OK をクリックします。 

        

 

 

 

 OK をクリックします。 

 

⑩ キャピラリー情報の入力（任意） 

 Change Cassette を行うと、最後に使用するキャピラリーの情報を入力するかの設定画

面が表示されます（下図）。使用したキャピラリーの情報を残す場合は、この画面で YES

を入力し、使用しているキャピラリーの種類を一覧から選択、または入力して下さい。特

に分析後に mobility（移動度）の計算をしたい場合、分析前に入力をしておく必要があり

ます。分析後に変更することはできません。 

 特に入力を実施しなくても、分析自体は可能です。 
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次に分析パラメータを設定し、IQ テストサンプルを分析します。 

まずバッファとサンプルを以下の通りにセットします。 

バイアルの種類 バイアル番号

泳動用バッファ インレット：分析用  
20mM ホウ酸バッファ pH9.3 6 

泳動用バッファ アウトレット：分析用  
20mM ホウ酸バッファ pH9.3 7 

廃液用バイアル フラッシュ時の廃液用バイアル 1 

フラッシュ用バッファ フラッシュ用のバッファ 
20mM ホウ酸バッファ pH9.3 5 

IQ テストサンプル 1mM 4-Hydroxyacetophenone 20 
 

【バイアルセッティング時の注意事項】 

■ バイアルがバッティングしないように注意してください。 

グラフィック画面で、インレット、アウトレットのバイアルの位置にバイアルがセットされ

ていないかを確認します。もしセットされていたら、バイアルのアイコンを右クリックして 

Unload Inlet lifter または Unload Outlet lifter を選択し、バイアルをトレイにおろしてくだ

さい。 

 

■ バイアルのキャップの内側に、サンプルやバッファの液がつかないように注意して下さ

い。 

再現性の悪化や故障の原因になる場合があります。万一バイアルを倒してキャップの内側に

液がついた場合は、キャップをはずして、けば立ちのないウエスなどで液体を拭き取ってく

ださい。 

 

■ サンプル用バイアルに空気が入らないように、サンプルを入れてください。 

サンプル用バイアルは、サンプルを入れる際に底に空気が残りやすいテーパード形状をして

います。空気が残るとサンプルを注入することができなかったり、キャピラリー内に空気が

注入され、電流が流れなくなったりする場合があります。 
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【実施手順】メソッドの設定 

下記の IQ キット分析メソッドのパラメータ一覧表を参照して、メソッドを作成します。 

メソッドの設定の詳細については、第 2 章を参照して下さい。 

IQ キット 分析メソッド パラメータ一覧表 

ダイアログボ

ックス 
設定項目 設定 備考 

Edit Method Method Information 
Instrument/Acquisition
Data Analysis 
Run Time Checklist 

On 
On 
On 
On 

 

Method 
Information 

 (例) IQ Test Method  

DAD Signals: A: 
        B: 
        C: 
Peak width: 
 
Stop time  
Post time 
Spectrum 
 
 
 
Autobalance 
Lamps on required for 
acquisition 

325nm, Bw10nm, Ref off 
235nm, Bw10nm, Ref off 
192nm, Bw4nm, Ref off 
＜0.05min（1.0sec response 
time）  
As CE 
Off 
All in peak 

190～400nm 
Step 2nm 
Threshold 10mAU 

Prerun 
UV Lamp : On 

 
 
 
Peak width は S/N
に大きな影響を与

えます。有機酸のよ

うにピークが若干

太い場合は＜

0.10min の方が良い

場合があります。 

CE Inlet Home 
Outlet Home 
Cassette 
Temperature 
High Voltage System 
 Voltage 
 Current 
 Power 
 Low Current alarm 
limit 

Stop time 
Post time 
Replenishment 
Preconditioning 
 
 

6 
7 
20℃ 
 
Enable High Voltage : On 
30kV 
100μA 
6.0A 
On 2 μA 
 
10min（結果により変更） 
Off 
設定なし 
Flush 240sec Inlet:5  
            Outlet:1 
 

6、7 番に泳動用の

バッファバイアル

をセットします。 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

- 24 - 

 
Injection 
 
 
 
 
 
 
 
Time Table 
Post conditioning 

 
Apply Pressure  
(1)50mbar for 4sec 

Inlet:Injection Vial 
Outlet:Outlet Home Vial 

 
(2)50mbar for 4sec  

Inlet:IInlet Home Vial 
Outlet:Outlet Home Vial 

設定なし 
設定なし 

 
サンプルを注入し

た後にバッファを

注入し、サンプルを

バッファで挟み込

みます。 

Signal Details Available Signals DAD 1A  
Edit 
Integration 
Events 

Baseline Correction 
Initial Slope 
Sensitivity 
Initial Peak Width 
Initial Area Reject 
Initial Height Reject 
Initial Shoulders 

Advanced 
1 
0.04 
1 
1.7 
Off 

 

Peak top type selected Method parabolic interpolation  
Specify 
Report 

Quantitative Results 
 Calculate 
 Based on 
 Sorted By 
Style 
 Report Style 
 
Destination 

 
Percent 
Area 
Signal 
 
Short 
Add Electropherogram 
Output 
Screen 

 

Instrument 
Curves 

Instrument Data 
Curves: 

Current, Temperature, 
Voltage は取り込んでおく

と便利です。 

（注１） 

Run Time 
Checklist 

Check Method 
Sections to Run 
･Pre-run 
Command/Macro 
Data Acquisition 

･Standard Data 
Analysis 

･Customized Data 
Analysis Macro 

･Save GLP Data 
･Post-Run 
Command/Macro 

 
 
Off 
 
 
On 
 
Off 
 
Off 
Off 
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（注１）2010 年 3 月時点（ChemStation Rev.04.02[118]）では、取り込み後に表示させ

ることができません。次バージョンにて対応予定です。 

 

① メソッドが完成したら、次のメソッド名で保存します。 

メソッド名：“ IQTEST.M ” 

 

② 次のディレクトリとファイル名を設定し、分析を開始します。 

サブディレクトリ名：” IQTEST “ 

ファイル名：” IQTEST1 “ 

分析開始については、第 3 章「シングルサンプルの分析」を参照して下さい。 
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１－４．ChemStation のマニュアル操作 

【ナビゲーションパネル】 

Agilent 7100 CE をコントロールする ChemStation は次の 3 つの画面で構成されています。 

１．Method and Run Control ：メソッド＆ランコントロール 

２．Data Analysis ：データ解析 

３．Report Layout ：レポートレイアウト 

   

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

 

ChemStation の画面左にナビゲーションパネルが左記のように

表示されます。このパネル下部のボタンから、各画面に移動する

ことができます。 

 

パネル上部のツリー表示からダブルクリックしてファイル選択

を行うことで、シーケンスファイルやメソッドファイルを直接読

み込むことができます。（シーケンスタブ、メソッドタブで、ツ

リー表示を切り替えます。） 

あるいは、メニューの View からも画面を切り替えることができ

ます。 



 

- 27 - 

【マニュアル操作】 

Agilent ChemStation ソフトウェアでは、グラフィカルユーザーインターフェース(GUI)を採

用しています。装置のアイコンをクリックして機器のコントロールし、その状態をモニター

することができます。 

機器をコントロールするには、コントロールしたい部分のアイコンをマウスで右クリックし

ます。そのアイコンに関係する操作のメニューが表示されます。 

 

ここでは、マニュアル操作でキャピラリーを泳動バッファでフラッシュした後、電圧を印加

し、電流値を確認する方法を例にとって説明します。 

  

＜インレット、アウトレットバイアルの変更＞ 

図のインレットの部分を右クリックすると、メニューが表示されます。 Set Inlet Vial… を

選択します。 

 

 

 

 

 

 

 

 

 

セットしたいバイアル番号を選択し、 OK ボタンをクリックします。 
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セットしたバイアルの番号が画面上に表示されます。 

同様に、アウトレットバイアルの設定を行います。 

※  Unload Inlet/Outlet lifter はバイアルをトレイに降ろす機能です。この機能を実行する

と、バイアルはトレイに降ろされ、画面上のバイアル番号の表示が消えます。 

 

＜キャピラリーのフラッシング＞ 

ボンベ（レギュレータ）の絵を右クリックし、 Flush… を選択します。 

 

時間（秒単位）を入力し、 OK ボタンをクリックします。 
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インレットバイアル内が加圧され、キャピラリー内がフラッシュされます。このとき、レギ

ュレータからインレットバイアルまでのラインが青く変わり、圧力値（900～940mbar 程度）

が表示されます。 

 

この操作は、キャピラリーの気泡や試料の追い出しや、キャピラリーのコンディショニング、

あるいは分析終了後のキャピラリーの純水洗浄を行う際などに利用できます。 

 

＜電圧の印加＞ 

インレットとアウトレットに適切なバイアル（通常は泳動用の Inlet home および Outlet 

home バイアル）をセットし、電池の絵を右クリックします。  Apply Voltage… を選択

します。 
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印加電圧、時間（秒単位）を入力し、 OK ボタンをクリックします。印加電圧は Positive

（インレット側が陽極）の場合は正の数を、Negative（インレット側が陰極）の場合は負の

数（例 -25kV）を入力します。 

 

電圧が印加されると、システムダイアグラムの下の Actual Values に印加電圧、実際の電流

値等が表示されます。システムダイアグラムの左下には、現在の動作時間が表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

  動作の進行時間が表示されます。
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動作を途中で終了させたい場合は、再度右クリック（ここでは電池の絵）して、 Abort を

選択します。 

 

 

 

 

 

 

 

 

 

 

＜分析中の分析時間の変更方法＞ 

分析中にシステムダイアグラム内で右クリックし、 Method… を選択します。 
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ストップタイムを変更し、 OK ボタンをクリックします。 
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第２章  メソッドの設定 

２－１．メソッドの構成 

 

メソッドには次ページの表の４つの項目が含まれています。 

一連の操作でメソッド全体を編集する場合は、Method → Edit Entire Method… を選択し

ます。 

  

 

 

 

 

 

 

 

   

 

 

 

 

 

 
編集する項目の選択 
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項目の意味および個別に編集する場合は、下の一覧表をご参照ください。 

メソッドに含まれる項目 個別に編集する場合 
Method Information 
メソッドに関する情報（メモ） 

Method → Method Information 

Instrument/ Acquisition 
装置、データ取り込み条件の設定 

Instrument → Set up Instrument Method… 

Data Analysis 
データ解析の設定 

View → Data Analysis → Integrate etc. 

Run Time Checklist 
メソッドの実行範囲の設定 

Method → Run Time Check List 
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【メソッドの編集方法】 

メソッドの編集は①Set up Instrument Method…を用いて編集する、②GUI の絵を右クリッ

クして各項目を設定する、あるいは、③Edit Entire Method…を用いてメソッド全体を編集

する方法があります。 

 

① Set up Instrument Method…を用いて各項目を編集する。 
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② GUI をクリック（システムダイアグラム上で右クリック）してメソッドを編集する。 

 

 

 

③ Edit Entire Method…を使用し、メソッド全体を編集する。 
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２－２. メソッド全体の編集（Edit Entire Method…） 
 

【メソッド全体の編集の準備】 

編集するメソッドの元になるメソッドを呼び出します。 

Method → Load Method… → 目的のメソッドファイルの選択 

 

 

 

 

 

①メソッドファイルを

選択します。 

② OK ボタンを

ク リ ッ ク し ま

す
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【メソッドの編集】 

① メソッドの編集をします。 

 Method → Edit Entire Method…  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

② OK をクリックすることにより、後述の画面が表示されます。 

 （Check Method Section to Edit で選択した項目の編集画面のみが表示されます。） 

 

 

編集したい項目にチェ

ックを入れます。 



 

- 39 - 

 

＜Method Information＞ 

ここではメソッドの情報（メモ書きなど）を入力します。入力した内容は、印刷したレポー

トに記載されます。 

 

 

＜Instrument / Acquisition＞ 

Instrument / Acquisition は 3 つのタブより構成されています。タブを切り替えて設定を行い

ます。 

 CE ：検出器以外の CE 本体の設定 

 DAD ：ダイオードアレイ検出器の設定 

Instrument Curves：分析中の温度、電流値、圧力などの保存の設定 
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１．CE タブ 

＜Vials＞ 

Inlet Home, Outlet Home  泳動に使用する最初のバッファバイアルを示しま

す。 

    Inlet Home が注入側、Outlet Home が検出側を示します。 

 

バイアル番号は、トレイの番号を入力する方法以外に、“ユーザーバイアル（User Vial）”

機能を用いる方法があります。この方法については、5-3 節「ユーザーバイアル機能を用い

たシーケンス分析」にて詳しく説明します。 

 

＜Cassette Temperature＞   

キャピラリーカセットの初期温度設定をします。 

設定可能な温度範囲は室温-10℃～60℃です。 
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＜Replenishment＞ 

バッファを自動交換（リプレニッシュ）するための設定を行います。 

 Parallel  バッファの自動交換と分析を平行して行います。 

この場合、分析中のバイアルと自動交換するバイアルが重複し

ないように設定する必要があります。 

Serial  バッファの自動交換終了後に引き続き分析を行います。分析時

間は長くなりますが、バイアルの重複等を考慮する必要はあり

ません。 

 

＜注意＞ 

・ 2010 年 3 月時点（ChemStation Rev.04.02[118]）では、Parallel の機能が使用できませ

ん。次バージョンにて対応予定です。 

・ リプレニッシュメントシステムを使用する場合は、第 11 章の「リプレニッシュメント

（バッファ自動交換）システムの洗浄」を参照し、必ずリプレニッシュメントシステム

の洗浄、準備を行ってから使用ください。 
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＜Preconditioning＞ 

 分析前のコンディショニングの設定を行います。 

① Function の矢印ボタンをクリックし、ファンクションを選択します。 

 通常の分析では Flush の機能を選択します。 

 

 

 

 

 

 

 

② Flush の時間（秒）と、インレットバイアルとアウトレットバイアルを指定します。 

 

多段階でコンディショニングを行う場合は、 Append  、  Insert  、 Copy  のボタン等

を使用し、プレコンディショニングのプログラムを作成します。 

  

矢印ボタンをクリッ

クします。 
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＜Injection＞ 

試料の注入の設定を行います。 

① Function の矢印ボタンをクリックし、ファンクションを選択します。通常の加圧注入の

場合、Apply Pressure の機能を選択します。 

 

 

 

 

 

 

 

② Parameter の行をクリックし、加圧時の圧力（通常は 50mbar）、時間、インレットバ

イアル、アウトレットバイアルを指定します。 

 

 Injection Vial 注入するサンプルバイアル。バイアル番号は第 3 章「シングルサンプ

ルの分析」3-1 節で説明する Sample Info（サンプル情報）または第 5

章「シーケンス分析」5-2 節で説明するシーケンステーブル内で指定し

ます。 

 Inlet Home Vial 前述の CE タブの＜Vials＞で指定したインレット側のバイアル 

 Outlet Home Vial 前述の CE タブの＜Vials＞で指定したアウトレット側のバイアル 

多段階で注入を行う場合は、 Append  、  Insert  、 Copy  のボタン等を使用し、注入

矢印ボタンをクリッ

クします。 
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のプログラムを作成します。 

 

＜Time Table＞ 

分析中の印加電圧の変更やインレットバイアルの加圧などのタイムテーブルを設定します。 

①  Add ボタンをクリックします。 

② 時間を入力し、Function から目的の機能を選択し、必要な設定値等を入力します。 

 

 

 

 

 

 

 

＜Postconditioning＞ 

分析後のコンディショニングの設定を行います。Preconditioning と同様の手順で設定を行

います。 

 

＜High Voltage System＞ 

印加電圧の設定を行います。通常の分析では、Enable High Voltage にチェックをし、印加

電圧を入力します。印加電圧の極性が Positive（インレット側が陽極）の場合は正の値を、

Negative（インレット側が陽極）の値は負の値（例 -30kV）を入力します。また電流、電

力のリミット値を設定します。 
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 Current ：電流のリミット値 （0～300μA） 

 Power ：電力のリミット値 （0～6W） 

 Current、Power の値が分析中に設定したリミット値に到達した

場合、リミット値を超えないように自動的に電圧を調整します。分析が

ストップすることはありません。 

Low Current alarm limit ：電流値が設定した値以下になった場合、分析をスト

ップします。通常、1～2 μA の値を入力します。 

 

 

 

＜Stoptime、Posttime＞ 

分析時間、ポストタイムの入力を行います。 

 

 

Stoptime  ：電圧を印加する分析時間を入力します。 

Posttime ：分析終了後のポストタイムを入力します。キャピラリー電気泳動の場

合、ポストタイムを使用することは殆どありません。 
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２．DAD タブ 

＜Signals＞ 

測定波長の設定を行います。Use Signal でチェックをしたシグナルのデータが保存されま

す。最大 8 波長のシグナルの保存が可能です。リファレンス波長を設定する場合には、

Reference Wavelength のチェックボックスにもチェックをし、リファレンス波長を入力し

ます。 

 

 

＜Peakwidth＞ 

データの取り込み周期に関する設定を行います。矢印ボタンをクリックし、適切なピーク幅

（response time）を設定します。キャピラリー電気泳動では、2.5Hz または 5Hz が一般的

です。 
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＜Stoptime、Posttime＞ 

ダイオードアレイ検出器に関するストップタイム、ポストタイムの設定を行います。ストッ

プタイムは通常 As CE に、ポストタイムは Off にチェックをします。 

 

 

＜Spectrum＞ 

スペクトルの取り込みの設定を行います。スペクトルを取り込む場合には、Store の右の矢

印をクリックし、目的の取り込み形式を選択します。 

 

 

 

 

 

 

 None   ：スペクトル採取なし 

 Apex   ：頂点のスペクトル採取 

 Apex+Baselines  ：頂点とベースラインのスペクトル採取 

 Apex+Slopes  ：頂点と立ち上がりと立ち下がりのスペクトル採取 

Apex+Slopes+Baselines ：頂点、ベースライン、立ち上がりと立ち下がりのス

ペクトル採取 
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All in Peak ：ピークの全ポイントのスペクトル採取 

Every 2nd Spectrum ：2 ポイント毎にスペクトル採取 

All ：全ポイントでスペクトル採取 

 

 Range ：スペクトルを取り込む波長の範囲 

Step    ：スペクトル採取の分解能の設定。0.1～100nm の範囲で、0.1nm ステ

ップで設定可能 

 Threshold：ピークとして認識してスペクトルを取り込む場合のしきい値 

 

 

＜Analog Output＞ 

アナログアウトプットの設定を行います。外部へ信号をアナログ出力する場合に設定し

ます。 

 

 

＜Indirect UV – Margin for Negative Absorbance＞ 

間接吸光度法で検出を行う場合に、負のピークのマージンの設定を行います。 
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＜Autobalance、Lamps on required for acquisition＞ 

ダイオードアレイ検出器のオートバランスのタイミングと、分析時のランプの点灯の有

無の設定を行います。 

 

検出器のオートバランスは通常分析前に行うため、Prerun にチェックをします。Prerun

にチェックをすると、プレコンディショニング終了し、注入動作の前にオートバランス

を実行します。 

エレクトロフェログラムを採取する場合は、UV Lamp にチェックをします。CE/MS など

の場合に、ダイオードアレイ検出器のデータを採取しない場合は、チェックを外します。

チェックを外すことによりランプが点灯していなくても、装置は Ready 状態になります

(12-3 節参照)。 

 

＜Time Table＞ 

ダイオードアレイ検出器に関するタイムテーブルの設定を行います。 

 

 Add ボタンをクリックし、Function の矢印ボタンをクリックし、目的の機能を設定し、

それに応じた時間や波長等を設定します。複数の設定を行う場合は、 Add  、  Copy  、 

 Paste  のボタン等を使用し、ダイオードアレイ検出器に関するプログラムを作成します。 
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３．Instrument Curves 

エレクトロフェログラムと一緒に取り込んでおきたいデータにチェックをします。 

 

 

＜Signal Details＞ 

メソッド実行時に解析で使用するシグナルの設定を行います。 
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Available Signals の矢印ボタンをクリックし、 Add to Method ボタンをクリックして目的

のシグナルを追加します。シグナルを削除する場合は、Signal Description の削除したいシ

グナルを選択し、 Delete Row ボタンをクリックします。 

 

＜Edit Integration Events＞ 

エレクトロフェログラムの積分条件の設定を行います。積分条件を設定後、 OK ボタンを

クリックします。 

 

積分条件は、分析終了後に変更することができます。イベントの詳細につきましては、第５

章で詳しく説明します。 
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＜Peak top type＞ 
ピーク頂点の決定方法を指定します。 

 

 highest datapoint  ：最も高いデータポイント 

 parabolic interpolation ：放物線近似より推定 

 center of gravity  ：重心 

 Gaussian fit  ：ガウス分布近似より推定 

 

＜Specify Report＞ 
レポートの出力条件を設定します。 

 

 Quantitative Results ：定量計算の方法 
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 Style   ：レポートのスタイル 

 Destination  ：レポートの出力先 

 Calculation Factors ：サンプルデータの使用 

 Electropherogram Output ：エレクトロフェログラムの出力方法 

 Destination  ：レポートの出力先 

 
＜Instrument Curves＞ 

エレクトロフェログラムと同時に表示するデータカーブの設定を行います。表示させたい項

目のチェックボックスにチェックをします。 
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＜Run Time Checklist＞ 

メソッドの実行部分を指定します。 

 

 

あらかじめ ChemStation にインストールされているデフォルトのメソッド（DEF_CE.M）

は、Data Acquisition と Standard Data Analysis の両方にチェックは入っています。分析終

了後に自動で解析する必要がない場合は、Data Acquisition のみにチェックをします。 

データ解析も同時に行う場合には、Standard Data Analysis にもチェックをします。設定後、   

OK ボタンをクリックします。 
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【メソッドの保存】 

メソッドの保存のメニューを呼び出します。 

Method → Save Method As… 

 

 

 

ファイル名を入力し、 OK ボタンをクリックします。 

上書き保存をする場合は、Method → Save Method を選択するか、メソッド保存のアイコ

ンをクリックします。 
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第３章  シングルサンプルの分析 

 

分析の実行には、シングルサンプルの分析、すなわちメソッドに従って１度だけ分析を行う

Run Method と、複数の分析を連続して行う Sequence（シーケンス）があります。 

この章では、Run Method を含む RunControl について説明します。 

シーケンスについては、第 4 章を参照ください。 

 

1 回分析（Run method） 

 

 

 

 

 

 

 

連続分析（Run Sequence） 
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３－１．サンプル情報の設定 

 

オペレータ名、データの保存先、データ名、サンプル情報、バイアル番号などをサンプル情

報として入力します。 

 

 

 

 

Run Control → Sample Info… を選択します。または、Sample Information のバイアルの

絵を右クリックして、Sample Info…を選択します。 

 

 

  

クリック 

します。 
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① Operator Name 

オペレータの名前を入力します。 

② Data File 

<Subdirectory> 

データのパス、サブディレクトリ、データファイル名を設定します。 

Subdirectory（サブディレクトリ）名は、データをわかりやすく分類して保存するため

に設定し、ファイル名の重ね書きを防ぐのに役立ちます。 

サブディレクトリ名が異なれば、同じデータファイル名を使用することが可能です。 

新規にサブディレクトリを作成すると、以下のようなメッセージが表示されますので、 

① 

② 

③ 
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 OK ボタンをクリックします。 

 

<Prefix/Counter> 

Prefix で入力した文字をファイル名の冒頭にし、つぎに Counter の数字をつけて、

自動的にカウントアップされます。 

例）Prefix  SIG1  Counter  0001   → ファイル名 SIG10001.D 

  <Manual> 

    分析ごとに Filename にファイル名を入力します。 

③ Sample Parameters 

バイアル番号、サンプル名、コメントなどを入力します。 

<Sample Parameter> 

・Vial  ：トレイの何番名のサンプルを注入するかを設定します。 

・Sample Name ：サンプルの名前を入力します。 

・Sample Amount ：特殊な定量計算をするときに入力します。（通常は空欄） 

・ISTD Amount ：ISTD 法で定量計算するときのみ入力します。（通常は空欄） 

    ISTD 法の場合、内部標準の濃度を入力します。 
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３－２．メソッドの実行 

 

メニューのRunControl →Run MethodまたはStart Single Sampleのアイコンをクリックし

ます。 

 

 

 

 

 

分析がスタートします。 

 

【オンラインシグナル表示（Online Signals）】 

Method & Run Control 画面で表示されるシグナル情報の設定が可能です。２つのプロット

画面を表示することができます。シグナルを画面上にプロットすることができます。 

View → Online Signals → Signal Window1 

 

① プロット画面が表示されます。 

 Change ボタンをクリックします。 
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② Available Signals（表示可能なシグナル）からプロットしたいシグナルを選択し、 Add  

ボタンをクリックすると、Selected Signals に項目が移動します。画面にプロットする

際のスケールの設定は、Selected Signals からデータを選択後、Window で時間軸を、

select one signal で縦軸のスケール設定を行います。 

  プロット画面 の矢印をクリックして直接変更することも可能です。 
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表示を取り消したい場合は、Selected Signals 内のシグナルを選択し、 Remove ボタ

ンをクリックします。 

ウィンドウ内でエレクトロフェログラムをドラッグして拡大して表示することが可能

です。ドラッグを繰り返すことで、さらに拡大して表示させることが可能です。ダブル

クリック 1 回で 1 つ前の画面に、もう 1 回ダブルクリックすることで、Edit Signal Plot

で設定したスケールに戻ります。 

 

【オンラインスペクトル表示(Online Spectra)】 

  オンラインスペクトル表示の On/Off の設定が可能です。 

  View → Online Spectra 
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【サンプリングダイアグラム(Sampling Diagram)】 

バイアルトレイ（CE Tray ウィンドウ）

表示の On/Off の設定が可能です。 

シーケンスで分析を行う場合は、表示し

ておくと便利です。 

View → Sampling Diagram 

 

 

 

表示させる吸光度範囲

の設定 

表示させる波長範囲の設定 
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【システムダイアグラム(System Diagram)】 

システムダイアグラム表示の On/Off の設定が可能です。 

View → System Diagram または のボタンで表示の切り替えが可能です。 

 

【スナップショット(Snapshot)】 

分析中に、それまでに採取したデータを抽出してデータ解析を行うことが可能です。スナッ

プショットは Offline より行います。 

目的の分析時間が経過した時点で、Offline の

Data Analysis の画面の File → Snapshot を選

択します。 

スナップショットを繰り返すと、データは上書

きされます。 
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スナップショットのデータも、他のエレクトロフェログラムとの重ねがきや積分などの解析

を行うことが可能です。 
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第４章 シーケンス分析を始める前に 

シーケンス(Sequence)とは、  

「何番のバイアルを」「どのメソッドで」「何回」 

「何番のバイアルを」「どのメソッドで」「何回」 

 ･････････････････ 

のように、複数のサンプルをサンプル毎に指定したメソッドに従って、連続自動分析を行う

ためのプログラムです。シーケンス分析を行うためには、シーケンステンプレートを設定す

る必要があります。 

 

シーケンス分析を行うようになると、効率的に多数の分析データが得られるようになります。

そのため、その後に続くデータ解析やデータ管理の運用方針をあらかじめ定めておくことを

推奨します。本章では、それらの管理方法について紹介します。 
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４―1． シーケンスコンテナ、メソッドの概念 

 

ChemStation ではデータファイルとメソッド間の統合性を強化するために、新しいデータ

管理基本構造であるシーケンスコンテナを搭載しています。シーケンスコンテナを使用する

ことにより、便利なデータ管理と、一括再解析による一貫性のあるデータ処理とレポート出

力が可能となります。 

 

データ採取時にシーケンスコンテナを使用する／しないの設定は、ChemStation の「シー

ケンスプレファレンス」でユニークなフォルダ作成をオン/オフで選択します。また、現在

どちらの設定になっているかを確認するには、4-4 節の「シーケンスプレファレンスの設定」

を参照して下さい。 

 

4-1～4-3 節で、シーケンスコンテナの概念とそれに関連したデータと解析メソッドの管理

について説明します。大きく分けて３つの管理パターンが存在しますので、ぞれぞれの利点

と注意点をまとめました。 

 

シーケンスコンテナの操作方法の詳細については、別冊の“新しいケミステーション ワー

クフロー（Publication Number：G2170-96041）を参照ください 
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図 シーケンスコンテナの概念図 

 

マスターメソッド：フォルダ Chem32¥1¥methods¥CE（Default 設定）内の 

メソッドはマスターメソッドとなります。 

これは、取り込み中とデータ解析中は変更されません。 

 

シーケンステンプレート：フォルダ Chem32¥1¥sequence（Default 設定）内の 

シーケンスはシーケンステンプレートとなります。 
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４―２． データ保管のパターン 

連続自動分析されたデータの保存パターンはシングルサンプル分析かシーケンス分析かに

よって異なります。また、シーケンス分析においても、ユニークなフォルダをオンにするか、

或いはオフにするかでデータ保存パターンは異なります。それぞれの特徴を下記に示します。 

 

４―２－１． シングルサンプルの分析の場合 

指定したサブディレクトリの下に、分析を１回行うごとに 1 つのデータファイル（*.d）が

保存されます。同じ名前でデータファイルを上書きしてしまわないように、毎回別のデータ

ファイル名を指定する必要があります。 

第３章の「シングルサンプル分析」を行った場合の操作がこれに相当します。 
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４―２－２． シーケンスデータ採取（ユニークなフォルダをオフにする場合） 

（シーケンスコンテナ無しの場合）： 

指定したサブディレクトリの下にデータファイル（*.d）が保存されます。 

サブディレクトリ内に同じデータファイル名が存在する場合、データは上書きされます。

このため、以前に作成したシーケンステンプレートから分析を実行する場合、分析前に別の

サブディレクトリを指定する必要があります。 

 

 

 

 

 

 

 

４―２－３． シーケンスデータ採取（ユニークなフォルダをオンにする場合） 

（シーケンスコンテナ有りの場合）： 

指定したサブディレクトリの下に新しいフォルダ（シーケンスコンテナ）が自動的に作成

され、その下にデータファイ（*.d）等が保存されます。 

シーケンスコンテナ名は、設定に従って自動的に特有のサブディレクトリ名がつきます。 

 

 

 

 

 

 



 

- 71 - 

 

 

 

 

 

 

 

 

 

 

 

 

 

シーケンスコンテナに格納される主なファイルを次に挙げます。  

・取り込まれたデータファイル 

・実行したシーケンステンプレート（*.s）のコピー 

・シーケンスで使用する全メソッド（*.m）のコピー（→シーケンスメソッドと呼びます） 

 

その他には、バッチファイル（*.b）やシーケンスログファイル（*.log）も共に保存されま

す。 
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シーケンスコンテナ内のデータの解析を行う場合、シーケンスコンテナ内のシーケンスメソ

ッドを編集して、積分条件や検量線の更新等を行います。更新されたシーケンスメソッドを

再び同じコンテナ内に保存します。 

この操作により、その解析メソッド(＝シーケンスメソッド)を採取データと同じシーケンス

コンテナ内で管理することができます。 

 

そのため、シーケンス関連タスク（データ再解析など）を実行しても、おおもとのファイル

であるシーケンステンプレートとマスターメソッドは影響を受けません。 

 

 

 

 

 

 

 

 

 

 

シーケンスコンテナ内で検量線を作成し定量するイメージ図 
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4-2-3 節で紹介した、シーケンスデータ採取においてユニークなフォルダをオンにする（シ

ーケンスコンテナを使用する）利点を下記にまとめます。 

 

・一連のデータ、連続解析に使用する（シーケンスメソッド）及びシーケンスが 

 一括して１つのフォルダに格納されるため、管理しやすい。 

 

・シーケンスコンテナ名に時刻を入れられるので、上書き防止になる。 

 

・再解析は、シーケンスコンテナ内のみで行われる。（他に影響を与えない） 

 

・マスターメソッドは、データ取り込み用の設定だけになる。 

 

 マスターメソッドに解析用の設定（積分条件、検量線の設定など）を混在させな

くてよい。 
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４―３．データと解析メソッドの管理方法 

 

ChemStation のメソッドの構成は 2-1 節の通り、装置／データ採取条件の設定の他に、デ

ータ解析の設定の項目も含まれます。採取したデータを解析する条件（Data Analysis：フ

ェログラムの表示、積分、検量線、レポート形式など）もメソッドとして保管します。 

 

ここでは、データ解析のために編集したメソッドをどのように管理するかの例を挙げます。

データと解析メソッドの管理方針の参考にして下さい。 

 

なお、データ解析の詳細については、第 5章で説明します。 

 

 

データと解析メソッドの保管方法の例として次の３通りが挙げられます。 

① データと解析メソッドを常に組にして管理する 

 

メソッドの保管場所やメソッド名の付け方にルールが必要となり、ファイルの管理がやや煩

雑になります。 

シングルサンプル分析(4-2-1 項)と、ユニークなフォルダ作成オフ(シーケンスコンテナな

し)のシーケンス分析(4-2-2 項)を行った場合、これに相当します。 

 

････････････････････････････････････

…

…

…
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② シーケンスコンテナ内で一括管理する。 

 

一連のデータとその解析メソッドを 1つのフォルダ内で一括管理できるため、シーケンスコ

ンテナごと外部記録メディアにバックアップを取ることができます。 

 

ユニークなフォルダ作成オン(シーケンスコンテナあり)のシーケンス分析(4-2-3 項)を行っ

た場合、これに相当します。この管理方法を採用するには、4-4 節の「シーケンスプレファ

レンスの設定」で「ユニークなフォルダをオンにする（シーケンスコンテナをオンにする）」

設定(4-4-1 項)が必要となります。 

 

③ 常に各データ内の DA.M を使用する 

解析操作(シーケンス再解析)を行った場合、DA.M が意図しない

変更を受ける恐れがあります。 

DA.M の設定や管理がやや煩雑になります。 

 

シングルサンプル分析(4-2-1 項)と、ユニークなフォルダ作成オン(シーケンスコンテナあ

り)のシーケンス分析(4-2-3 項)を行った場合、個々のデータファイル内に分析時に利用した

メソッドのコピー(ACQ.M と DA.M の 2 つ)が含まれるようになります。 
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＜注意＞ 

ユニークなフォルダ作成オフ(シーケンスコンテナなし)の条件(4-2-2 項)では、ACQ.M と

DA.M のいずれもデータファイルに含まれません。 

 

【ACQ.M と DA.M について】 

ACQ.M と DA.M の解説は次の通りです。 

 

・ACQ.M → 取り込みに使用された装置のメソッド。（読み取り専用） 

データ採取部分が完了した後に直接保存されます。 

後で採取時のメソッドの設定内容を確認できます。 

 

・DA.M → 解析部分のメソッド。 

取り込み時のデータ解析部分が完了した後に初めて保存されます。 

また、シーケンス再解析で変更を受けます。 

必ずしもマスターメソッドと同じではありません。 

 

・DA.M は、各データにそれぞれ別の解析メソッドを適用したい場合に便利です。データフ

ォルダ内にいつも存在しているからです。 

 

・ユニークなフォルダをオンにする場合は、各 DA.M に関して操作せず、コンテナ内のシー

ケンスメソッドでも解析できます。 
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４－４．シーケンスプレファレンス（Sequence Preference）の設定 

シーケンス分析を開始する前に、シーケンスプレファレンスで次の設定を行います。 

1、 シーケンスコンテナの設定 (4-4-1 項)（分析前に設定必須） 

・ユニークなフォルダのオン／オフの設定 

・自動作成されるシーケンスコンテナ名の設定 

2、 メソッド/シーケンス/データ保存パスの設定 (4-4-2 項)（任意） 

  3、 シグナル/レビュー オプションの設定（分析前の設定不要） 

データ解析時に注意（ここでは述べません。詳細は 7-0 節を参照ください） 

 

４－４－１.ユニークなフォルダのオン／オフの設定（必須） 

シーケンスコンテナの設定によって、データを保存するフォルダ構成が異なります。 

詳細は 4-1 節「シーケンスコンテナ、メソッドの概念」を参照ください。 

 

メニューの View  → Preference から Sequence タブを選択します。 

（Preference がみつからない場合は、View → Full Menu を一度クリックしてメニュー項

目を表示させます。） 

ユニークなフォルダ作成のオン／オフを切り替えられます。  
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注意：このユニークなフォルダのオン/オフ（シーケンスコンテナをオン/オフにする）設

定はシーケンステンプレートの内容として保管されません。もし、用途に合わせて日常的

に切り替える場合には、意図しないフォルダへのデータの保存を避けるため、分析を開始

する前に、必ず「ユニークなフォルダ」のオン／オフを確認してください。 

 

   （例：日付時刻ごとに新しくコンテナが作られるはずが、 

      ユニークなフォルダ作成がオフだったため、シーケンスパラメータ項目で 

      設定した別のフォルダに保存されてしまう、といったことを防ぎます） 

 

【自動作成されるシーケンスコンテナ名の設定】 
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名前のパターンを設定します。 

右端のボタンをクリックすると項目選択メニューが

表示されるので、その中から項目をクリックします。 

デフォルトの設定は<SeqN> <Date> <Time>になっ

ています。 

 

注意：シーケンス名のパターンを設定する際、 

シーケンス名が 40 文字を超えないように設定してください。 

また、以下の文字は、シーケンス名、ファイル名、ディレクトリ名には含めません。 

• < > : " / \ | @ % * ? ' & 空白 ( スペース) など。 

 

４－４－２． メソッド/シーケンス/データ保存パスの設定（任意） 

必要に応じて、各ファイル保存先のパスを複数設定することが可能です。 

  View → Preference  
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 Add キーを押して、保存したい先のパス名を選択してください。選択するパスは、予め、

Explorer 等で作成しておく必要があります。 

 

注意：各ファイルのデフォルトパス（C:¥Chem32¥1¥SEQUENCE¥、

C:¥Chem32¥1¥1DATA¥、C:¥Chem32¥¥1METHODS¥CE）は削除できません。 

 

注意：すでに登録されたパスのさらに下の階層のディレクトリを追加することは 

できません。 
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第５章 シーケンス分析 

シーケンスとは、  

「何番のバイアルを」「どのメソッドで」「何回」 

「何番のバイアルを」「どのメソッドで」「何回」 

 ･････････････････ 

のように、複数のサンプルをサンプル毎に指定したメソッドに従って、連続自動分析を行う

ためのプログラムです。 

 

シーケンスを行うためにはシーケンステンプレート（Sequence Template）を設定する必要

があります。シーケンステンプレートは以下の内容が含まれます。 

・シーケンス パラメータ（Sequence Parameters） 

データファイル保存場所（サブディレクトリ）の指定などを行います。 

・シーケンステーブル（Sequence Table） 

  実行メソッドとバイアル番号の設定 

リキャリブレーション（再解析）の設定 

サンプル名などの設定 

（Sequence Preference はシーケンステンプレートに含まれません） 

シーケンステンプレートもメソッドと同様、読み込み、保存、印刷などができます。 

   Load Sequence ：シーケンステンプレートを呼び出す 

   Save Sequence As… ：シーケンステンプレートに名前を付けて保存 

   Save Sequence  ：シーケンステンプレートを上書き保存する 

   Print Sequence ：シーケンステンプレートの内容を印刷する 

シーケンステンプレートは「*.S」フォルダとして保存されます。 
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５－１．シーケンスパラメータ（Sequence Parameters）の設定  

メニューから 

   Sequence → Sequence parameters 

を選択します。 

 

シーケンスパラメータの設定画面が表示されます。 

 

① 

② 

⑤ 

③ ④
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① Operator Name（オペレータ名）：オペレータの名前を入力します。 

② Data File（データファイル名）：データファイル名と保存先サブディレクトリを設定し

ます。 

Path：サブディレクトリ名（Subdirectory）を設定します。 

補足：   新しいサブディレクトリ名を設定後、下図のような“Subdirectory 

C:¥CHEM32¥1¥DATA¥*** does not exist. Create it? （サブディレクトリ＊＊＊は存

在しません。作りますか？）”という画面が表示されます。 OK  をクリックし、

必ずディレクトリを作成してください。 

 

 

データファイル名の設定は以下の通りです。シーケンステーブルでデータファイル名を設定

している場合はシーケンステーブルでの設定名が優先されます。 

 

・Auto：バイアル番号、シーケンスライン、注入回数から自動的に設定されます。 

   例： 001 - 02 03 .D 

[バイアル番号]－[シーケンスライン][注入回数] 

 

・Prefix/Counter：プレフィックス＋カウンタ(数字）で構成されます。 

最大合計で 15 文字の名前が付けられます。 

例：プレフィックス部分＋カウンタ部分（最大 6 桁）  TEST 000001.D 
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③ Part of Method to Run（メソッド実行部分）：メソッドのどの部分を実行するか設定し

ます。 

・According to Runtime Checklist（ランタイムチェックリストに従う）：メソ

ッドの中で指定したランタイムチェックリストどおりに実行します。 

・Data Acquisition（データ取り込みのみ）：データ取り込みのみを実行します。 

・（オフラインソフトのみ有効） 

  Reprocessing Only（データ解析のみ）：データ再解析のみを実行します。 

メソッドの構成は 2-1 節を参照してください。 

 

④ Shut Down：シーケンス終了後に装置を OFF にしたい場合、この項目を設定します。 

シーケンス終了後 CE のランプを消す場合には Post-Sequence Command/Macro にチェ

ックを入れ、矢印を押して、Shut down を選択します。（シーケンス終了後にマクロを

実行する場合もこの項目を設定します） 

 

 

⑤ Sequence Comment：コメントがあれば入力します。 

 

設定が完了したら OK  をクリックします。 
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５－２．シーケンステーブル（Sequence Table）の設定 

 

シーケンスには以下の内容が含まれます。 

・シーケンステーブル（Sequence Table） 

    ：実行メソッド，バイアル番号等の設定を行います。 

 

・シーケンスパラメータ（Sequence Parameters） 

    ：データの保存場所（ディレクトリ）の指定などを行います。 

 

メソッド＆ランコントロール画面左上の 3 本のバイアルのアイコンをクリックします。 

 

画面の GUI が、シーケンス実行用に変化します。 

 

メニューから 

    Sequence   → New Sequence 

を選択して新規テンプレート（DEF_CE.S）を読み込みます。 

    Sequence   → Sequence table 

を選択しシーケンステーブルを表示します。 

テーブルに分析する順番にサンプルの詳細を入力します。 

 入力後 OK  をクリックします。 
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① Line：シーケンスライン番号で自動的に付きます。 

② Vial：分析を行うサンプルのバイアル番号を入力します。 

③ Sample Name：サンプル名。入力しなくても分析できます。 

④ Method Name：矢印を押すと、保存されているメソッドファイル名 

   が表示されます。使用するメソッドファイル名を選択します。（直接入力も可） 

⑤ Inj / Vial：1 バイアル毎の注入回数を入力します。 

⑥ Sample Type：通常の分析ではサンプル(Sample)にしておきます。 

① ②  ③    ④     ⑤  ⑥  
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必要に応じてシーケンスのテーブル下のバーを用いてテーブルを右側にスライドして項目

を入力します。 

 

⑦ Dilution：サンプル希釈率を入力します。定量値は希釈後サンプルの定量値×Dilution の

値となります。入力しなくても分析できます。 

⑧ Data File：データファイル名を入力します。入力しなくても分析できます。（入力しな

い場合はバイアル番号、シーケンスライン、注入回数から自動的に設定されます） 

⑨ Voltage：メソッドで設定した Voltage 以外の電圧で分析を行う場合、この欄に入力する

と、そのラインのみ入力した電圧での分析が可能です。通常は設定不要です。 

⑩ Stop time：メソッドで設定した Stop time 以外の時間分析を行う場合、この欄に入力す

ると、そのラインのみ入力した時間での分析が可能です。通常は設定不要です。 

 

※User1～User10：そのラインで使用するユーザーバイアルバイアル番号を入力します。メ

ソッドで User vial 機能を使用している場合は必ず入力が必要です。ユーザーバイアル機能

の詳細は次項で設定します。 

 

⑦   ⑧    ⑨  ⑩     User1～10 
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＜ヒント：シーケンステーブルの表示変更＞ 

シーケンステーブル画面右下にある Configuration Table をクリックするとシーケンステー

ブルの表示項目と表示幅を設定することができます。 

普段使用する項目だけを選択しておくと、シーケンステーブルの画面表示を簡素化できます。 

 

 

 

 

＜ヒント：シーケンステーブルのウィザード＞ 

連続するバイアルで同じメソッドを設定する場合、以下の機能を使用すると入力が簡単です。 

 

シーケンステーブル画面左下にある Insert/FillDown Wizard をクリックします。次の画面が

表示されます。 
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① Action：シーケンスの行を追加する場合は Append、新規作成の場合は Insert

を選択します。 

② Starting location：同じ条件を使用するバイアルの開始位置を入力します。 

③ Increment by：いくつずつサンプル番号を増加させるか設定します。 

④ Fields：Method name（メソッド名）、Sample type（サンプルタイプ）を選

択します。Inj/Location に 1 バイアル毎の注入回数を入力します。その他、

Sample name（サンプル名）、Dilution（希釈率）等は任意で入力します。 

⑤  OK  をクリックすると、テーブルに行が挿入されます。 

① ② 

③ 

④ 
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５－３．ユーザーバイアル（User Vial）機能を用いたシーケンス分析 

 

ChemStation のユーザーバイアル（User Vial）機能を用いることによって、通常はメソッ

ドで設定する「InletHome Vial」「Outlet Home Vial」等のバイアル番号をシーケンスの行

ごとに設定が可能です。 

たとえば「10 回の分析ごとに Flush、Inlet/Outlet Home に使用するバイアルの番号を変更

したい」場合、User Vial 機能を使用しない場合は、バイアル番号を変更するごとに別のメ

ソッドの作成が必要ですが、User Vial 機能を使用すると、シーケンステーブル上でバイア

ル番号を指定することにより一つのメソッドで分析することができます。 

 

 

CE メソッドの機器設定を開きます。 

（Instrument control 画面にて右クリックし「Method」を選択します。） 

 

ユーザーバイアル機能を使用するには、CE メソッドの機器設定で、 

バイアル番号に User1～User10 を指定します。 

（例 1：Inlet Home、Outlet Home バイアルの設定） 

 

 

バイアルの▼をクリックして

プ ル ダ ウ ン よ り User1 ～

User10 を選択します。 
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（例 2：Preconditioning、Injection の設定） 

 

設定が終了したら OK をクリックし、メソッドを保存します。 

Sequence Table を開き、User Vial を使用したメソッドを指定します。 

メソッドの User Vial に対応するバイアル番号を User1～User 10 に入力します。 

 

シーケンス分析をスタートします。上記のように User1～User5 を設定した場合、同じ分

析メソッドのまま、シーケンスの 1 行目と 2、3 行目の分析で使用するバイアル番号のみ

が変わります。 

メソッドで設定した User Vial を設定した場合は、必ず Sequence Table の User にバイ

アル番号を入力してください。（入力されていない場合その行の分析はスキップされます）
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５－４．シーケンスファイルの保存（Save Sequence） 

 

シーケンスファイルを保存します。 

上書きする場合はメニューから 

Sequence→Save Sequence  

を選択するか、右図のアイコンをクリックします。 

 

新しく名前を付けて保存する場合には、メニューから 

Sequence→Save Sequence As 

を選択します。 
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５－５．シーケンスの実行（Run Sequence） 

シーケンスを実行するとシーケンスの最初の行のメソッドが読み込まれます。そのため、シ

ーケンス実行前に、シーケンスで最初に使用するメソッドを読み込んでおくと、シーケンス

開始後のメソッド読み込み時に、キャピラリー温度の変化等がありませんので、すぐにシー

ケンスを開始できます。 

 

3 本のバイアルのアイコンをクリックします。 

画面の GUI がシーケンスモードになります。 

 

装置が Idle 状態（緑色のステータス）になっていることを確認し、下図の「Sequence」ボ

タンをクリック、またはメニューバーから 

Run Control→ Run Sequence 

を実行します。 



 

- 94 - 

＜ヒント：シーケンスステータス画面からのショートカットアクセス＞ 

シーケンスのステータス画面から、Sequence Parameters、Sequence Table、CE Tray（バ

イアルトレイ）画面にアクセスすることができます。（下図参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

バイアルのグラフィックを 
左クリックすると Sequence Table 表示、

右クリックすると Sequence メニュー 
（一部）表示ができます。 

トレイのグラフィックを 
右クリックすると CE Tray 
ウィンドウの表示/非表示を 
切り替えられます。 

CE Tray の赤色の部分はバイアルが置かれている場所、

白色の部分は Sequence Table では設定されているが

バイアルが置かれていない場所です。 
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＜ヒント：サンプルの追加／分析順序の変更＞ 

シーケンス実行中に、予定していなかったサンプルを追加で分析したい場合、またはサンプ

ルの分析順序を変更したい場合は、シーケンスを中断させずに現在のシーケンスを編集する

ことができます。 

シーケンス実行中でもメニューの 

Sequence → Sequence Table 

を選択して、シーケンステーブルを編集します。追加したいサンプルは、サンプルトレイド

アを開けて、トレイに置きます。 

 

 

 

＜＜必ずお読みください＞＞ 

※ 電圧印加中でもサンプルトレイドアは開けられます（ドアを開けても分析中のデータ

に影響はありません）。ただし、注入動作中等でトレイが高速に回転している場合は、

回転が終了するのを待ってサンプルトレイドアを開けてください。 

※ バイアルが重複（上にあがっているバイアルの番号に、サンプルバイアルを追加）し

ないようご注意ください。 

※ バイアルを置いた後、サンプルトレイドアを確実に閉めてください。ドアを閉め忘れ

ると「Not Ready」状態が続き、分析が先に進みません。 

※ 追加したバイアルがサンプリングダイアグラム（CE Tray ウィンドウ）で認識された

ことを必ず確認して下さい。認識されないと、「バイアルがない」と判断され、分析

がスキップされます。 

シーケンステーブルを編集する際

は Insert（選択した行の上に行を挿

入する）や Append Line（選択した

行の下に行を追加する）ボタンが便

利です。 

すでに分析が行われている行はロ

ックされ編集ができません。 
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Agilent 7100 CE には、バイアルセンサーが搭載されています。サンプルトレイが自転する

際に、バイアルセンサーはトレイ上に置かれたバイアルを認識し、サンプリングダイアグラ

ム（CE Tray ウィンドウ）上に表示される情報を更新します。 

 

＜例＞ 
・ 追加した 40 番のバイアルが認識されていない状態 

 

↓40 番の位置が白色になっています。 

 

 

 

この場合、 

40 番のサンプルはスキップされ、分析されません。 

 

 

 

・ 追加した 40 番のバイアルが認識された状態 
 

↓40 番の位置が赤色になっています。 

 

 
 

 
40 番のサンプルは分析されます。 
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＜ヒント：ポストシーケンス設定の変更＞ 

シーケンス実行中にも、ポストシーケンスの設定を変更することが可能です。 

メニューの 

Sequence → Sequence Parameters 

を選択し、ポストシーケンスの設定を変更します。 

 

 

５－６．シーケンスの一時停止 

 実行中のシーケンスの一時停止／中止など操作は以下の通りです。 

 

・現在のランを最後までデータを採取して、 

次のサンプルの分析の手前で一時停止させたい場合 

 →メニューの Run Control → Pause Sequence  

またはステータス画面の Pause を選択します。 

 

ChemStation のステータスは「Pause」になり、は機器のステータスは現在の分析終了後に

Ready 状態で待機します。 

 

再開するには、 

メニューの Run Control → Resume Sequence  

またはステータス画面の Resume を選択します。 

 

 



 

- 98 - 

・現在のランを直ちに終了させて、 

 次以降のシーケンス分析を実施しない場合（停止） 

 →メニューの Run Control → Stop Run を選択します。 

  

現在のランが直ちに終わり、ここまでのデータは採取、保存されます。 

機器のステータスは Idle 状態、ChemStation のステータスは Ready 状態になります。 

 

・現在のランを直ちに中断させて、 

次以降のシーケンス分析を実施しない場合（中断） 

 →メニューの Abort → Abort を選びます。 

   

現在のランが直ちに終わり、ここまでのデータは採取、保存されます。 

データ採取後のアクション（解析、レポート出力等）は行われません。 

機器のステータスは Idle 状態、ChemStation のステータスは Ready 状態になります。
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第６章  データ解析  

― シングルサンプル分析  

及び ユニークなフォルダ作成（シーケンスコンテナ）をオフにした場合 － 

 

データ解析は「Data Analysis（データ解析）画面」で行います。データ解析とは、メソッ

ドの解析部分の編集です。捜査を始める前にどのメソッドを編集しているのかを必ず確認

して下さい。オフラインソフトの解析画面での実施を推奨します。 

 

本章では、 

・シングルサンプル分析 

・ユニークなフォルダ（シーケンスコンテナ）オフ 

の設定で採取したデータを解析する場合について説明します。 

ユニークなフォルダ（シーケンスコンテナ）オンの場合については、第７章を参照ください。 

 

データ解析の詳細については、別冊の「新しいケミステーション ワークフロー入門」

(G2170-96043)を参照ください。 
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データ解析の流れは以下の通りです。 

 

解析条件を設定するメソッドの読み込み （6-1 節参照） 

 ↓ 

標準サンプルデータ(STD)読み込み （6-1, 6-2 節参照）  

 ↓ 

積分（面積値の決定） （6-3 節参照） 

 ↓ 

検量線作成  （6-4 節参照） 

 ↓ 

定量レポート条件設定 （6-5 節参照） 

 ↓ 

解析メソッドの保存 →[マスターメソッドとして利用可能]* （6-6 節参照） 

 ↓ 

未知濃度サンプルデータの読み込み （6-7 節参照） 

 ↓ 

定量レポート出力 （6-7 節参照） 

 

＜ヒント＞ 

取り込みメソッドの解析部分を編集すると、マスターメソッドとして扱うことができます。 

 

＜注意＞ 

オンラインソフトで現在使用中のメソッドを編集する場合、上書き保存ができません。一旦

別名で保存するか、オンラインソフトがプレランかスタンバイ中に編集する方法もあります



 

- 101 - 

オフラインソフトのデータ解析のナビゲーションボタンをクリックします。 

データ解析（Data Analysis）を選択します。  

 
 

６－１．フェログラムの呼び出しと表示 

 

解析に用いるメソッドファイルを読み込みます。 

解析したいフェログラム（データファイル）を読み込みます。 

メニューバーから File → Load Signal をクリックするか、またはアイコンをクリックし

ます。 

Load Signal(シグナル読み込み）画面が表示されます。 
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① Folders(フォルダ）名をダブルクリックすると、中に含まれるファイル名が表示され

ます。   ②            ① 

 

 

 

    ③ 

 

 

異なるフォルダの中を見るには、一度 Folders で上の階層のフォルダをダブルクリッ

クしてから、目的のフォルダを選択します。 

 

② File Name(データファイル名）を選択します。 

③ 多波長でデータを採取した場合は  Full  >> をクリックします。 

下に画面が追加されます。                                                      

  

 

⑦ 

 

 

④ 

 

 

 

         ⑤   ⑥ 
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④ Signals: 解析する波長を選択します。 

  Ctrl キーを押しながら選択を実行すると、複数の波長/シグナルを同時に表示できます。 

 

⑤ Integrate after load: チェックを入れた場合、データ読み込みをすると自動的に、現

在読み込まれているメソッドの積分条件を使用して積分を行います。 

 

  ⑥ Load using Signal Details: チェックを入れた場合、Method の Signal Details で設定

した波長のみを読み込むことが可能です。 

 

⑦  OK  をクリックします。 
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６－２．データ表示条件の変更 

 

フェログラムやデータの画面表示、表示内容を変更します。 

 

メニューバーから Graphics → Signal Options.. をクリックします。 

 

 

 

 

 

 

 

 

「Signal Options」画面が表示されます。 

    

   a) Include 

   b) Peak Leader Font 

    

   c) Ranges 

    

   d) Multi-Electropherogram 
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a) Include  フェログラムに含まれる／表示される内容の設定 

 × Axis：縦軸、横軸 

 × Compound Names：成分名 

 × Migration times : マイグレーションタイム 

 × Baselines：ベースライン 

 × Tick Marks：積分の開始／終了マーク 

 × Non overlapping peek labels：複数のフェログラムを表示させた際にピークラベル

を重ならないように表示 

 

b) Peak Label Font  ピーク名、マイグレーションタイムのフォント設定 

 字体の設定を変更する場合は Font をクリックして設定画面を開き詳細を設定します。  
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c) Ranges  フェログラム表示レンジ（スケール）の設定 

 ◎ Full：フルスケール 

 ◎ Use Ranges ：スケールを設定 

   ・Time Range     : 横軸（時間軸）の範囲 

   ・Response Range : 縦軸の範囲 

 ◎ Autoscale : スケールを自動設定（横軸のみ範囲設定可能） 

 

d) Multi-Electorpherogram  複数のフェログラム表示に関する設定 

  ・ Layout  ： レイアウトの設定 

    ・Separated :フェログラムを分割表示 

・Overlaid ：フェログラムの重ね書き表示 

・  Scale   : フェログラムのスケール設定 

     ・All the same scale : 全てのフェログラムを同じスケールで表示 

     ・Each in full scale  : 各々のフェログラムをフルスケールで表示 
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６―３．積分（Integration） 

 

積分を行うためのツールバーに切り替えます。 

 

 

積分には以下の３つの方法があります。 

1. 自動積分で適切なパラメータを提示させる（Auto Integrate） 

2. 積分条件（Integration Events）を変更して積分パラメータを最適化する 

3. マニュアル積分(Manual Integrate) 

 

 

 

積分条件関連 

 

自動積分 

 

マニュアル積分関連 

 

 

 

 

 

 

 
①
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６―３－１．自動積分（Auto Integrate） 

エレクトロフェログラムに適した積分条件を ChemStation が自動的に計算し、後述の積分

イベント欄に提示します。初回の積分パラメータ設定時など、適当な積分条件が決める時な

どに使用します。最適なパラメータが決まったら、次回以降は自動積分の必要はありません。 

    

＜注意＞ 

マニュアル積分をした後に、自動積分をすると、マニュアル積分イベントが消去される場

合があります。マニュアル積分の 6-3-3 項を参照ください。 

 

メニューバーから Integrate → Auto Integrate をクリックするか、または積分ツールバ

ー上のアイコン（下図）をクリックします。自動積分が実行されます。 
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６―３－２．積分条件（Integration Events）を変更して積分 

 

Integrate → Integration Events をクリックするか、 

積分ツールバー上の該当アイコンをクリックします。 

 

 

    

メソッド作成画面で入力した、積分条件変更の

画面が表示されます。 

    ① 

 ⑤ 

  ③ 

 

 

 

 ② 

 ④ 

 

 

 

 

ChemStation では、複数のフェログラムを同時に扱うため、シグナル毎にイベントテーブ

ルの設定が必要です。（例：波長違い、検出器違い） 
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① 積分すべきシグナルを選びます。 

 

② シグナル名に対応するテーブルを表示させます。 

 

③ タンジェントスキムモードに関するパラメータ条件を設定します。各項目を適切な値に

変更します。 

 

④ その他の積分条件を設定します。各項目を適切な値に変更します。 

 

⑤ Integration Events を付け加えるには、行を追加するアイコンをクリックします。

Integration Events に新規の行が追加されます。矢印をクリックして、新しい積分イベ

ント（Events）を選択し、値（Value）を入力します。 

 

 

 

⑥ Integrate → Integrate をクリックするか、積分ツールバー上の該当  アイコンをク

リックします。変更した Integration Events に従って積分が実施されます。 

   

 

 

⑦ 積分結果を確認し、良ければ積分条件を保存して閉じるアイコンをクリックします。 

結果が適切でない場合は③から⑥を繰り返します。 
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６―３－３．マニュアル積分（Manual Integrate） 

 

積分条件の変更だけでは、適当な積分を行うことのできない複雑なエレクトロフェログラム

などに利用します。 

 

ChemStation の Rev.B.04.01 以降では、各データファイル内にマニュアル積分条件を保存

できます。 

（マニュアル積分の条件はメソッドに保存することも可能です。ただし、メソッドに保存し

たマニュアル積分条件を別のエレクトロフェログラムに適用した場合は、積分結果を確認す

る必要があります。） 

 

マニュアル積分を行う前に、マウスのドラッギングによるエレクトロフェログラム上の該当

ピーク部拡大を実施、またはシグナルツールバー上の拡大／縮小のアイコン(下図)を使って、

積分したいピークを拡大しておくと便利です。 

 

         拡大と縮小 

   

    

            

                               

 

各アイコンをクリックすると、ポインターの絵が変化します。 

  

 

① ② ③ ④ ⑤
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① Draw Baseline（ベースラインを引く） 

カーソルを積分開始点に移動し、積分終了点までドラッグします。ピーク

は自動的に積分され、引かれたベースラインとエリア値が表示されます。 

 

② Negative peak(s)(ネガティブピークのベースラインを引く) 

負のピークを積分します。カーソルを積分開始点に移動し、積分終了点ま

でドラッグします。ピークは自動的に積分され、引かれたベースラインと

エリア値が表示されます。 

 

③ Tangent Skim(タンジェントスキムによるマニュアル積分) 

カーソルを積分開始点に移動し、積分終了点までドラッグします。ピー

クは自動的にタンジェントスキムモードに基づいて積分され、引かれた

ベースラインとエリア値が表示されます。 

 

④ Split(ピークの垂直分割） 

うまく分離していない２つのピークの、１つめのピークの積分開始点か

ら２つめのピークの積分終了点までベースライン（Draw Baseline）を引

きます。 

ピークの垂直分割（Split）のアイコンをクリックして、カーソルの形を

変えます。２つのピークの分割点でクリックします。 

 

⑤ Delete Peak (s)(ピーク削除） 

積分されているピークをクリックします。 
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【マニュアル積分の保存】 

マニュアル積分が適切に設定できたら、データファイルにマニュアルイベントを保存

します。 

 

① ナビゲーションパネルのレビューウインドウで、現在解析中のデータファイル行

を右クリックしてメニューを出します。 

 

② Copy current Manual Events to data Files…をクリックします。 
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③ ｢This will copy Manual Integration Events of following signals:シグナル名（データ

名）to the selected files.｣のメッセージが表示され、マニュアル積分条件を現在の

データに保存するかを聞いてきます。 

 

 

 

 

 

 

 

  ④ OK  をクリックすると、データファイル内にマニュアルイベントが保存されます。 

 

 

 

    

マニュアル積分イベントが保存されると、ナビゲーションパネル上の対象データに

M のマークが追加されます。 
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【マニュアル積分の削除】 

 

① ナビゲーションパネルのレビューウインドウで、現在マニュアル積分実施済みの

データファイル行を右クリックしてメニューを出します。 

 

② Remove Manual Events from data Files…をクリックします。 
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③ ｢This will permanently remove Manual Integration Events from following signals:デー

タ名｣のメッセージが表示され、マニュアル積分条件を現在のデータから削除しても

よいかを聞いてきます。 

 

 

  ④ OK  をクリックすると、データファイル内のマニュアルイベントが消去されます。 
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＜注意＞ 

マニュアル積分をした後に自動積分をすると、マニュアル積分イベントが消去される場合

があります。自動積分機能は、積分イベントテーブルを更新し、マニュアル積分を無効に

します。 

 

詳細：レビュー画面で、マニュアル積分イベントの存在する行を選択している時、 

  （M マークのついた行が青色太字になってフェログラムが表示されている時） 

 

 

 

 

この状態から、自動積分を実行した後に、行を移るなどの動作をした時、 

｢There are unsaved changes for the signal(s): シグナル名（データ名）Do you want to save 

them? ｣のメッセージが表示され、マニュアル積分条件を現在のデータから削除してもよい

かを聞いてきます。; 

 

 

ここで「Yes」とするとマニュアルイベントは消去されます。 

また「No」とするとマニュアルイベントは保持されます。 

いずれの場合もイベントテーブルは自動積分により変更されています。 
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６－４．検量線の作成 

 

 

 

ここでは、メソッド内に検量線を作成します。 

検量線の作成には、標準溶液のエレクトロフェログラムから導き出された面積値と

MT を使用します。 

メソッドは、MT と面積値の入ったキャリブレーションテーブルを用意するので、 

「成分名」 

「標準溶液の濃度」 

を入力します。するとメソッドは、MT ウィンドウ内のピークを「成分名」と同定す

るようになり、検量線をあてはめる準備ができます。 

 

 

標準溶液などを分析したデータファイルを読み込みます。（6-1 節 参照） 

また、積分結果を確認しておきます。（6-3 節 参照） 

検量線作成（Calibration）を行うためのツールバーに切り替えます。 
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６―５．絶対検量線法（ESTD）による定量 

【１点検量線の作成】 

 

新しい検量線テーブルを作成します。 

Calibration → New Calibration Table、またはキャリブレーションツールバー上の

該当アイコンをクリックします。 

 

 

 

   

   

      ① 

   

   

   ② 

   

  ③ 

   

   

        ④ 

 

① Level が 1（検量線の 1点目）であることを確認します。 

 

  ② 目的とする化合物の濃度が全て同じ場合は、Default Amount(に数値を入れます。

個々に濃度が異なる場合は入力しません。（0.000 のままで OK） 

 

③ ２波長、または２検出器以上の場合は、チェックを入れてください。 

すると、多波長で測定した場合に、波長別テーブルが作成されます。 
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  ④  OK  をクリックします。 

Calibration Table（検量線テーブル）が表示されます（下図） 

             ③ 

 

       ①                ② 

① Compound Name を入力します。 

② Amount（標準溶液の既知の濃度）を入力します。 

＃（ピーク番号）、MT（マイグレーションタイム）、Signal（シグナルの種類）、 

Area（面積値）は自動的に入力されています。 

 ③  OK  をクリックします。 
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【多点検量線の作成】 

 

１点検量線と同様に作成します。 

① 2 点目のデータファイルを読み込み、積分されて

いること、及びピークが同定されていることを確

認しておきます。File → Load Signals…の設

定画面で、Integrate after load にチェックをする

と、読み込み後積分されて表示されます。 

② Add Level アイコンをクリックします。または、メニューから Calibration → 

Add Level を選択します。 

 

 

 

 

 

 

③ Level に 2 と入力します。化合物の濃度が全て同じ場合は Default Amount に数

値を入力します。 個々に濃度が異なる場合は入力しません。 

 

④    OK  をクリックします。 

  

⑤ キャリブレーションテーブルに 2点目用の行が追加されます。 

この 2点目の行に、濃度（Amount）を入力します。 

化合物名（Compound）は必要ありません。 

 

⑥ OK  をクリックします。 

 

⑦ 3 点目以降のデータファイルついても①～⑦を同様に繰り返します。 
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【検量線の条件設定】 

 

メニューバーより Calibration  → Calibration Settings… を選択します。 

          ①       ②      ③ 

 

                                  検量線の条件設定画面が表示されます。 

① Amount Unit ：サンプル濃度の単位ラベルを入力します。 

 

② Default MT Windows：ピークを同定する MT の範囲を設定します。この範囲 MT があ

るものの最大ピークが、テーブル上の成分と同定されます。「その他のピーク」の入力

欄に入力します。 

例： 0.00min + 5%  (0.00±2.5%) 

MTが5分の場合、ピークとして認識される範囲は4.875分 ～ 5.125分となります。 

 

③ Default Calibration Curve：Type（検量線の種類）と Origin（原点）の処理法、Weight

（検量線上のデーターポイントの重み付け）を指定します。
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【定量レポートの計算の設定】 

 

計算方法の設定をします。また、メソッドが実行された場合のレポートの出力先を決

めておきます。 

メニューバーより 

Report  → Specify Report を選択します。 

または、ツールバー上の該当アイコンをクリックします。 

 

 

メソッド作成時に設定した、レポート条件設定の画面が表示されます。 

 

 

Quantitative Results の Calculate を ESTD に変更します。 
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６―６. 解析メソッドの保存 

 

以上で、メソッドの解析部分が設定できました。メソッド保管前の注意点を挙げます。 

 

注意：メソッドの保存場所を確認してください。 

（マスターメソッドとしますか？ DA.M(解析用メソッド)としますか？） 

メソッドファイル名を変更して保存する場合は、メニューの 

Method →  Save Method As… を実施します。 

   

＜ヒント＞ 

取り込みメソッドにもとに、検量線を作成してメソッド保存すると、このメソッドは「取り

込み」と「定量レポートの印刷」ができるようになります。 

ただし、印刷するには、メニューの Run Time Checklist Standard → Standard Data 

Analysis にチェックがされていることが必要です。 

 

 

例１：次回、このメソッドで未知サンプルをシングルサンプル分析すると、 

    分析終了後に定量レポートが印刷されてきます。 

例２：シングルサンプル分析で CE 条件と解析条件を最適化して、 

    シーケンスコンテナを用いた連続分析のマスターメソッドとして利用できます。 
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６－７．未知濃度サンプルのレポートの印刷 

【データの読み込み】 

定量したいサンプルのデータファイルを読み込みます。 

 

【レポートの印刷】 

  

 Print Report アイコンを 

クリックしてレポートを出力します。 

 

或いは、メニューから Report  → Print Report をクリックします。 
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６―８. 内部標準法（ISTD）による定量 

 

【内部標準検量線の作成】 

 

絶対検量線と同様にキャリブレーションテーブルを設定します。（6-5 節 参照） 

注意：テーブル上のアマウントを先に入力してください。 

 

                               ①   ④ 

① 内部標準ピークの、ISTD 欄で YES を選択します。 

ISTD 設定画面が表示されます。 

 

② ISTD Amount を入力します。 

内部標準物質を 2つ以上使用する場合、ISTD#に番号を入れてから濃度を入力します。 

③  OK  をクリックして、左の画面を閉じます。   

④ キャリブレーションテーブル右端の # に、使用する ISTD の番号を入力します。 
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【内部標準検量線の条件設定】 

 

絶対検量線作成時と同様に設定します。（6-5 節 参照） 

 

 

  

  通常、入力した ISTD Amount が表示されています。 
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【定量レポートの計算の設定】 

 

6-5 節「絶対検量線法(ESTD)による定量」の【定量レポートの計算の設定】と同様に、Specify 

Report 画面で計算方法を選択します。 

 

 

 

Quantitative Results 内の Calculate を ISTD に変更します。 

 

【メソッドの保存】  

手順は絶対検量線法(ESTD)と同様です。（6-6 節参照） 

 

【未知濃度サンプルの定量レポートの印刷】  

手順は絶対検量線法(ESTD)と同様です。（6-7 節参照） 
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第７章  データ解析  

― ユニークなフォルダ作成（シーケンスコンテナ）をオンにした場合 － 

 

データ解析は「Data Analysis（データ解析）画面」で行います。データ解析とは、メソッ

ドの解析部分の編集です。操作を始める前にどのメソッドを編集しているのかを必ず確認

して下さい。オフラインソフトの解析画面での実施を推奨します。 

 

本章では、 

ユニークなフォルダ（シーケンスコンテナ）オン 

の設定で採取したデータを解析する場合について説明します。 

 

シングルサンプル分析、及び、ユニークなフォルダ（シーケンスコンテナ）オフの場合につ

いては、第６章を参照ください。 

 

データ解析の詳細については、別冊の「新しい ChemStation ワークフロー入門」

(G2170-96043)を参照ください。 
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データ解析の流れは以下の通りです。 

 

データレビューの設定 （7-0 節参照） 

 ↓ 

標準サンプルデータ(STD)読み込み 

＋ 解析条件を設定するメソッドの読み込み    （7-1,7-2 節参照）  

 ↓ 

積分（面積値の決定） （7-3 節参照） 

 ↓ 

検量線作成  （7-4 節参照） 

 ↓ 

定量レポート条件設定 （7-5 節参照） 

 ↓ 

解析メソッドの保存 →[マスターメソッドとして利用可能]* （7-6 節参照） 

 ↓ 

未知濃度サンプルデータの読み込み （7-7 節参照） 

 ↓ 

定量レポート出力 （7-7 節参照） 

 

-----------------------------------------------------(応用編)----- 

（さらに進めて連続再解析が可能です）（7-9 節参照）  

 ↓ 

シーケンス出力の設定 
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 ↓ 

シーケンスの選択分析の設定 

 ↓ 

シーケンス再解析スタート[レポート印刷] 

 

 

＜ヒント＞ 

取り込みメソッドの解析部分を編集すると、マスターメソッドとして扱うことができます。 

 

＜注意＞ 

シーケンスコンテナがオンの場合、データ解析は必ずオフラインソフトウェア上で実施し

てください。 

 

オフラインソフトのデータ解析のナビゲーションボタンをクリックします。 

データ解析（Data Analysis）を選択します。  
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７－０．データレビューの設定 

 

ChemStation では、データをクリックするだけで、指定したメソッドで分析結果をレビュ

ーすることができます。 

 

【データレビューの設定 】(重要) 

設定は、レビュー画面左上のプルダウンから選択します。 

 

 ← プルダウンで選択 
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＜注意＞ シーケンスプレファレンスのシグナル/レビュー オプションの設定 
あらかじめ、シーケンスプレファレンスの Data Review Option を「Sequence  Method」

に設定してください。 

View → Preference → Signal/View option → Data Review Options 

 

↑シーケンスプレファレンスによるデータ レビューの初期設定 

この設定は、データをレビューする際の初期設定となります。解析操作途中で前述のレビュ

ー画面のプルダウンを変更すると、その変更の方が優先されるので、解析前に必ずレビュ

ー画面のプルダウンの設定を確認して下さい(前述)。 

 

＜注意＞ 

データレビューの設定は、データを読み込む際に使用するメソッドの選択を容易にするため

の補助であり、シーケンス連続解析を実行する際の解析メソッドを設定したものではありま

せん。すなわち、シーケンスコンテナ内でシーケンス連続解析を実行する場合、このデータ 

レビューの設定は使用されません。 
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７－１．フェログラムの読み込み 

 

解析したい一連のデータを読み込みます。 

① 画面に左のナビゲーションパネルのDataタブ内からシーケンスコンテナをダブルクリ

ックし、含まれる Sequenceデータを読み込みます。 

エレクトロフェログラム表示の上のナビゲーションテーブルに、シーケンスコンテン

ナ内の全データがテーブルとして表示されます 

                          ②                      ③ 

 

① 

 

 

 

 

             ④ 

    

② レビュー画面左上のレビューに使用するメソッド選択欄が「Use sequence method」
であることを確認します。 

 

③ 各データを読み込むときは、テーブル上のラインをダブルクリックします。するとエレ

クトロフェログラムが画面下に表示されます。 
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④ この＋ボタンをクリックするとテーブル上の選択したデータの詳細を確認／設定する

ことができます。 

      a) Signals 画面 

     データ内に含まれる波長や Instrument Curve（Current、Voltage など）の確認を

できます。右側にある〝Load？″に ✓マークがある場合はそのチェックがあ

る Signal のみを選択して表示することが可能です。 

 

 

 

 

 

 

 

     b) General Info 画面 

     データ採取に関する情報を確認できます。 

Data time（分析日時）、Operator（担当者）、Acq.Method（分析メソッド）等。 
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７－２．データ表示条件の変更 

 

フェログラムやデータの画面表示、表示内容を変更します。 

 

メニューバーから Graphics → Signal Options.. をクリックします。 
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「Signal Options」画面が表示されます。 

    

   a) Include 

   b) Peak Labels Font 

    

   c) Ranges 

    

   d) Multi-Erectropherogram 

    

    

   

 

a) Include  フェログラムに含まれる／表示される内容の設定 

 × Axis：縦軸、横軸 

 × Compound Names：成分名 

 × Migration times : マイグレーションタイム 

 × Baselines：ベースライン 

 × Tick Marks：積分の開始／終了マーク 

 × Non overlapping peek labels：複数のフェログラムを表示させた際にピークラベル

を重ならないように表示 

 

b) Peak Label Font  ピーク名、マイグレーションタイムのフォント設定 

 字体の設定を変更する場合は Font をクリックして設定画面を開き詳細を設定します。  
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c) Ranges  フェログラム表示レンジ（スケール）の設定 

 ◎ Full：フルスケール 

 ◎ Use Ranges ：スケールを設定 

   ・Time Range     : 横軸（時間軸）の範囲 

   ・Response Range : 縦軸の範囲 

 ◎ Autoscale : スケールを自動設定（横軸のみ設定可能） 

 

d) Multi-Electorpherogram  複数のフェログラム表示に関する設定 

 ◎ Layout  ： レイアウトの設定 

    ・Separated :フェログラムを分割表示 

・Overlaid ：フェログラムの重ね書き表示 

◎ Scale   : フェログラムのスケール設定 

     ・All the same scale : 全てのフェログラムを同じスケールで表示 

     ・Each in full scale  : 各々のフェログラムをフルスケールで表示 
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７―３．積分（Integration） 

７－３－１．自動積分（Auto Integrate） 

７－３－２．積分条件（Integration Events）を変更して積分 

７－３－３．マニュアル積分（Manual Integrate） 

 

積分の操作は、6-3 節を参照してください。 

 

＜注意＞  

・ 操作の途中でメソッドを保管するとき、保存先はシーケンスメソッドです。 

Method → Save Sequence Method 

・ 各データに保管されたマニュアルイベントは、自動積分を実行すると上書きされ（変

更を受け）ます。 

・ 各データフォルダ内の DA.M は、シーケンスメソッドによる再解析を受けると全て上

書きされ（変更を受け）ます。 

 

 

７－４．検量線の作成 

 

検量線作成の操作は、6-4 節を参照してください。 
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７―５．絶対検量線法（ESTD）による定量 

 

絶対検量線法（ESTD）による定量の操作は、6-5 節を参照してください。 

 

７―６. 解析メソッドの保存 

作成したメソッド（積分、検量線、レポート条件を含む）をシーケンスメソッドに保存し

ます。Method → Save Sequence Method    

メソッドの保存先は、シーケンスコンテナ内です。 

 

＜ヒント＞ 

このメソッドはシーケンスメソッドですが、保存メニュー内に 

｢Save as New Method（新しいマスターメソッドとして保存）」もしくは 

「Update Master Method（マスターメソッドを更新）」 

のオプションがあります。今後、同じ分析をする際に便利です。 

 

＜注意＞ 

「Update Master Method」はマスターメソッドが上書きされます。十分注意して下さい。 
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＜参考＞ マスターメソッドの更新について 

取り込みメソッドの解析部分を編集すると、取り込み＋データ解析の両方の内容を含むメソ

ッドを作成できます。このメソッドを、次のシーケンス分析の際にそのままマスターメソッ

ドとして使用すると便利です。 

 

マスターメソッドの設定によっては、分析終了後に定量レポートを印刷することまで可能で

すが、印刷するには、メニューの Run Time Checklist Standard → Standard Data Analysis 

にチェックがされていることが必要です。 
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７－７．未知濃度サンプルのレポートの印刷 

【データの読み込み】 

定量したいサンプルのデータファイルを読み込みます。 

レビュー画面から、目的のデータ行をダブルクリックでも読み込むことができます。 

（7-1 節 参照） 

 

【レポートの印刷】 

  

 Print Report アイコンを 

クリックしてレポートを出力します。 

 

或いは、メニューから Report  → Print Report をクリックします。 

 

 

７―８. 内部標準法（ISTD）による定量 

 

内部標準法（ISTD）による定量の操作は、6-8 節を参照してください。 
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７―９．シーケンスコンテナ内の連続再解析（シーケンスサマリーレポート） 

 

前節までに、検量線など定量条件を含んだ 

シーケンスメソッドを作成しました。 

ここでは、このシーケンスメソッドと、シーケ 

ンスの選択実行機能を用いて、連続再解析の出力 

方法を紹介します。 

この操作を行うと、同定ピークの平均値、分散、 

相対標準偏差などの統計計算を行った一覧レポート 

（シーケンスサマリーレポート）を出力できます。 

 

シーケンスサマリーレポートは、シーケンスコンテナ内にあるデータについて、一括再解

析を行い、レポートを出力する方法です。 

 

シーケンスサマリーレポートを出力するためには、シーケンスプリファレンスで「ユニ

ークなフォルダをオンにする（シーケンスコンテナをオンにする）」設定が必要となりま

す。「ユニークなフォルダをオンにする（シーケンスコンテナをオンにする）」設定の方

法は 4-4-1 項を参照してください。 

  

シーケンスサマリー 
レポート 



 

- 144 - 

シーケンスサマリーレポートは Standard Statistic Report と Extended Statistic Report の二

種類があります。 

   

 

 

＜注意＞ 

「DA.M」にマニュアル積分条件を保存している場合（本書ではこの方法を紹介していませ

ん）、シーケンス再解析を実行すると DA.M がシーケンスメソッドの内容で上書きされる

ので、注意してください。 

もし、DA.M を利用する解析を行いたい場合は、シーケンス再解析ではなく、レビューウイ

ンドウからのデータ読み込みとレポート出力を逐次実行してください。 

 

＜参考＞  

各データに保管されたマニュアルイベントについては、シーケンス再解析を実行しても上書

きされ（変更を受け）ません。 

Standard Statistic 

Report 

（レポート項目は固定

です） 

 

 

Extended Statistic 

Report 

（レポート項目を選択

可能です） 
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7-4～7-6 節を参照し、検量線テーブル作成、レポート出力方法を設定後、シーケンスメソ

ッドを保存します。 

シーケンスメソッドの保存先はシーケンスコンテナ内です。 

Method → Save Sequence Method 

 

連続再解析の結果の出力方法を設定します。 

メニューから Sequence  → Sequence Parameters を選択し、Sequence Output のタ

ブを選択します。 
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① 連続再解析の結果として、Sequence Summary Report(シーケンスサマリー/通しの

ページ番号が振られたレポート)を印刷するかどうか選択します。 

･Report to Printer ：レポートに出力します（初期設定で選択されています）。 

・Report to File   ：ファイルに出力します。 

・Report to PDF    ：PDF ファイル形式に出力します。 

・Report to HTM    ：HTM ファイル形式に出力します。 

・Print individual report for each run as well：各分析のレポートも出力します。 

 

② シーケンスサマリーレポートと同時に各分析のレポートも出力するには、” Print 

individual report for each run as well”にチェックを入れ、②でレポート出力先を設定

します。 

① 

③ ② 
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・As specified in each method ：メソッド毎に指定された設定で出力します。 

・As specified here：ここで設定した出力先、出力フォーマットに従います。 

 

③  Setup…ボタンをクリックします。シーケンスサマリーレポートで表示する内容を設

定します。デフォルトでは｢9:Summary｣にのみチェックが入っています。 

 

 

④ 「8：Statistics Sample Runs」にチェックを入れ、「Standard Statistic」または「Extended 

Statistic」を選択します。 

ヒント：この 8 をチェックすると、定量できたピークについて、平均値、分散、相対

標準偏差などの一覧レポートが追加できます。 

 

「Extended Statistic Report」を選択した場合、Extended Statistic のタブをクリックし、。 

レポートする項目を選択します。 
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⑤ 再解析対象の未知サンプルデータを指定します。 

Sequence  → Partial Sequence 

をクリックします。 
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  データ採取時の（シーケンスコンテナ内に保管されている）シーケンステーブルが表示

されます。レポートを出力したい行を選択します。 

  （注意）標準サンプル(STD)の行は選択からはずします。意図しない自動リキャリブレ

ーション(検量線の置き換え)を避けるためです。定量対象のサンプルの行のみ選択し

ます。 

 

 ＜参考＞ 

  複数行の選択は、キーボードの Ctrl キーや Shift キーを押しながらクリックします。 

 

⑥ シーケンス実行をクリックすると、連続再解析され、結果が印刷されます。 

「Run Sequence」をクリックすると、連続再解析されます。 

Sequence Output で「Report to Printer」を選択した場合はレポートが印刷されます。 

Sequence Output で「Report to File」「Report to PDF」「Report to HTM」を選択し

た場合は、シーケンスコンテナの中にファイルが生成されます。 
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図：Standard Statistic Report 例（抜粋）
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＜補足：リキャリブレーションを含んだシーケンス再解析による定量＞ 

 

7-9 節では、シーケンスの選択分析機能を使用した連続再解析を紹介しました。 

ここでは、さらに進んで、シーケンス内でリキャリブレーション（検量線更新）を含んだ再

解析シーケンスを紹介します。 

 

注意： 

「DA.M」にマニュアル積分条件を保存している場合、（本書では紹介していません） 

     シーケンス再解析を実行すると DA.M が上書きされるため、 

     マニュアル積分イベントが消えます。 

 

 

前提は、STD,サンプルとも、ピークが MT ウィンドウ内に入っていることが確認できてい

ることです。これは、シーケンスメソッドを完成させた後レビュー画面で確認ができます。 

準備は 7-7 節でシーケンス出力の設定方法までは、同様になります。 

ここで、メニューから、Sequence  → Sequence table（シーケンステーブル）として、

シーケンステーブルを編集します。 
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テーブル内の、STD を測定した行の 

Sample Type（サンプルタイプ）  を「Calibration（キャリブレーション）」に 

Cal Level（Cal レベル）        を 該当する値に 

Update RF（RF（レスポンスファクタ更新）） を「Replace（置き換え）」に(推奨) 

Update MT（MT（マイグレーションタイム更新）を「Replace（置き換え）」に(推奨)  

  

それぞれ設定し、最後に OK をクリックして終了します。必要があれば、シーケンスを

保存します。 

この後、Sequence   →  Start Reprocessing で連続再解析が始まります。 

もしくは、ナビゲーションパネル上のシーケンス再解析実行アイコンをクリックします。 

 

 

シーケンス実行時に「Sample Type」項目が「Calibration」の場合、MT と RF は、そのデ

ータの積分結果の MT と RF で変更されます。 
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第８章 スペクトル解析（Spectrum） 

スペクトル解析は、特徴的な UV スペクトルを有する化合物の定性手段として利用できます。

また、新規の化合物の検出条件最適化など、分析メソッドを開発する際にも有効です。しか

し、間接吸光度法による検出を用いる分析条件（UV 吸収の少ない化合物を検出する分析条

件(例：めっき液分析バッファ、有機酸分析バッファ、陽イオン分析バッファなど)）におい

ては、間接吸収光剤の UV スペクトルが支配的となり、スペクトル解析は有効となりません。 

 

スペクトル解析を行うためのツールバーに切り替えます。 

 

 

 

８－１．スペクトルオプション（Spectra Option） 

 

スペクトル表示条件を設定します。スペクトルツールバー上のアイコンを選択します。 

 

または、メニューバーより 

Spectra  → Spectra Options… を選択します。 

 

スペクトルオプションでは１つの設定画面でスペクトル及び純度チェックに関するパラメ

ータを同時に設定することができます。 

 

次ページのようなパラメータの設定および個々の設定に関する説明が表示されます。 
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＜Spectra（スペクトルの設定）＞ 

 

 

      

    

 

 

 

 

 

 

① Wavelength Range (波長範囲）：□にチェックし、表示するスペクトルの波長

範囲を入力します。 

 

② Spectra per Peak（ピークあたり スペクトル数） 

・Spectra per Peak（ピークあたりスペクトル数） 

：3,5,7,9,All から表示数を設定できます。 

・Threshold（スレッシュホールド） 

：設定した吸光度以上のスペクトルを表示します。 

 

③ Spectra Processing（スペクトル処理） 

・Smooth Factor（スムーズファクタ） 

：スペクトルを滑らかに表示します。ノイズの大きいスペクトルに有効です。 

数字を入力します。 

 

・Spline Factor（スプラインファクタ） 

：データ採取ポイントを通して、スペクトルを滑らかに表示します。 

 

・Logarithm（ロガリズム）     ：自然対数 

・Derivative Order（微分次数）：スペクトルの変化が細かく把握できます。 

① 

② 

③
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＜Reference（リファレンスの設定）＞ 

 

移動相の吸収やマトリックス物質のスペクトル吸収を減算することで影響を補正し、

成分のスペクトルをより正しく表示させるために使用します。 

 

 

 

・None（なし）          ：リファレンススペクトルを設定しません。 

表示されるスペクトルは、検出器が測定したそのまま 

  のスペクトルになります。 

 

・Manual（マニュアル）  ：リファレンススペクトルとして設定した時間での 

スペクトルをリファレンスに設定します。 

目的ピークの前側をリファレンス１に、 

後ろ側をリファレンス２に設定します。 

 

・Automatic（自動）     ：スペクトルモードとベースラインスペクトルによってリ

ファレンススペクトルが自動的に設定されます。 
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＜Display（画面表示の設定）＞ 

 

 

 

① Multi-Spectra（マルチスペクトル）の設定 

・Layout（レイアウト） 

Overlaid（重ね書き）：スペクトルを重ね書きします。 

Separated（分割）  ：スペクトルを分割表示します。 

・Scale（スケール） 

All the same Scale（すべて同じスケール）     

：全スペクトルを同じスケールで表示します。 

Each in full Scale（それぞれをフルスケール） 

：それぞれをフルスケールで表示します。 

 

② Display（表示）の設定 

・Original Spectrum（オリジナルスペクトル） 

：採取したスペクトルを表示します。 

・Reference Spectra（リファレンススペクトル） 

：リファレンススペクトルを表示します。 

・Spectra Titles（スペクトルタイトル） 

：スペクトルのタイトル(採取時間等)を表示します。 
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・nm-Axes（nm-軸） ：スペクトルの波長軸を表示します。 

・mAU-Axes（mAU-軸） ：スペクトルの吸光度軸を表示します。 

・Window Title（ウィンドウタイトル）：ウィンドウのタイトルを表示します。 
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＜Purity（純度チェックの設定）＞ 

 

 

 

 スペクトルデータの保存方法により、計算方法が異なるので、 

基準値も２通りの設定があります。 

 

① Peak Controlled spectra data file 

（ピークコントロールスペクトルデータファイル） 

：“Apex+Baselines（頂点＋ベースライン）”, “ Apex+Slopes+Baselines（頂

点＋スロープ＋ベースライン）”, “All in Peak（ピーク内全て）”で採取

したデータファイルに対しての純度判断の基準値を設定する欄です。 

 

② All Spectra data file（全スペクトルデータファイル） 

：“All（全て）”,“Every 2nd Spectrum（2 スペクトル毎）”で採取したデー

タファイルに対しての純度判断の基準値を設定する欄です。 

 

・Calculate Threshold（スレッシュホールド計算） 

：S/N 比を基に、各ピークに適切なスレッシュホールドを自動的に計算させます。 

・Fixed Threshold（固定スレッシュホールド）    

：スレッシュホールド値を固定して基準値とします。 

① 

② 
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８－２．スペクトルの表示・印刷 

 

８－２－１．スペクトルの表示 

 

① データファイルを読み込みます。 

 

② スペクトルの表示方法を選択します。 

 

 

 

スペクトル オプション(Spectra Option)で設定し

たピークあたりのスペクトル(Spectra Per Peak)

に基づいてスペクトルを表示 

指定した２点間のスペクトルを平均した

スペクトルを表示 

指定したピークの頂点のスペクトルを表示 

フェログラム上で指定した点でのスペクトルを表示 

リファレンススペクトルの設定：フェログラム上のリファレ

ンススペクトルとしたい位置にカーソルを移動してクリック

します。その位置でのスペクトルがリファレンスとして記憶

されます。リファレンス 1,2(Reference Spectrum1,2)の平均

がリファレンススペクトルとして実際のスペクトルから差し

引かれます。 

指定したピークの純度チェックを実施 
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③ 目的のピークにカーソルを移動しクリックします。 

 

８－２－２．スペクトルデータの印刷（Print Spectra） 

  
画面に表示されているスペクトルやウィンドウ内のデータを表示、出力することがで

きます。 

 

① 印刷したいスペクトルが表示されているウィンドウをクリックしアクティブにし

ます。 

② メニューバーから 

File  → Print を選択します。 

 

 

 

 

 

 

 

 

 

 

 

リストから印刷する項目を選択します。 

・Selected Window（選択ウィンドウ）：アクティブ・ウインドウの中のデータを印

刷します。 
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・All Windows（全てのウィンドウ）  ：画面上にある全てのウィンドウ内のデータ

を印刷します。 
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８－３．純度チェックの実行（Purity） 

 

① 純度チェックの実行をします。スペクトルツールバー上のアイコンを選択 

 します。または、メニューバーより 

Spectra  → Spectra Peak Purity を選択します。 

 

② 目的のピークをクリックすると、次の画面が表示されます。 

            a)              b）     d)       c) 

a) スペクトルの重ね書き 

b) シグナルの重ね書き（複数波長で測定した場合） 

c) シミラリティ／スレッシュホールドカーブ 

d) 純度計算に使用されたポイント 

このアイコンをクリックすると、

純度チェックの詳細結果の表示

および詳細なパラメータ設定を
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＜Purity（純度）＞ 

 

純度チェックの結果を表示します。 

純度ファクタとスレッシュホールドの値が表示されます。 

 

 

 

＜Peak Spectra（ピークスペクトル）＞ 

 

ピークスペクトル個々の純度結果を表示します。 

MT、純度、吸光度範囲、純度計算の基準となるスペクトルとの差を表示します。 
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＜Calculation（計算）＞ 

 

純度計算に使用されたスペクトル数が表示されます。 
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８－４．等高線表示（Isoabsorbance Plot） 

 

スペクトルを” All（全て）”または ”Every 2nd Spectrum（2スペクトル毎）”で

採取したデータは、等高線表示することができます。   

① データファイルを読み込みます。 

② メニューバーから Spectra → Iso ／3D Options…を選択します。 

 

      

  

 

 

 

 

 

 

・Color Scheme （カラー配色）：表示する色を選択します。標準的設定は Traditional

です。 

 ・Time（時間）：表示する時間範囲を設定します。 
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・Wavelength（波長）：波長範囲を設定します。 

・Absorbance（吸光度）：吸光度範囲を設定します。 

・Absorbance Scale（吸光度スケール）： 

Lin    ：等高線表示 

Ratio  ：比等高線表示 

Log    ：対数等高線表示 

 

 

 

③ 前ページの画面上の  Make Isoplot をクリックすると、次の画面が表示され

ます。 
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８－４－１．フェログラムの表示 

 

 

      ④                  ⑤ 

 

① Cursor を Quick View にします。 

② 横軸、縦軸の交差したところにカーソルを移動し、表示したいフェログラムの

位置までカーソルをドラッグします。 

③ その位置でのフェログラム（下図）が黒い線で表示されます。 

④  Mark  をクリックすると、フェログラムを選択した波長に印をつけ 

ておくことができます。 

⑤  Print  で等高線表示画面を印刷できます。 

① 

②

③ 
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８－４－２．フェログラムの抽出 

 

 ① Cursor の表示を Signal にします。 

 

 

 

 

 

 

 

 

 

   ②  Mark で印をつけた波長まで、画面上の線をドラッグして移動します。 

 

③ 画面左下の  Copy  をクリックします。  

   画面にフェログラムが抽出、表示されます。フェログラムは解析画面にもコピー

されます。 

 

④ 抽出した図を消去したい場合には、目的のフェログラム、スペクトルをクリック

し、    Delete をクリックします。 

Cursor を Signal にした画面。カーソルの位置の波長

(WL)が自動的に入力されます。必要に応じて BW (バ

ンド幅)、Ref（リファレンス）設定を設定します。
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⑤  Exit をクリックします。         

  

 

⑥ 次の画面が表示されます。Yes をクリックします。 

 

 

 ⑦ 抽出されたフェログラムが表示されます 

 

抽出したフェログラムは積分など通常のデータ同様の処理を行うことが可能です。 
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８－５ ３次元表示（3D Plot） 

 

メニューバーから 

Spectra → 3D Plot. を選択します。 

 

 

 

 

 

 

 

① X,Y,Z のスケールを自由

に変更することができま

す。 

変更したい軸を選択して、

右のスケール内のカーソ

ルを移動します。 

 

② Redraw をクリックしま

す。   

 

③ Close で３次元表示画面

から抜けます。 
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第９章  メンテナンス 

９－１．本体のメンテナンス 

 

この章では、定期的に行う必要がある Agilent 7100 CE 本体のメンテナンスについて説明し

ます。このハンドブックに記載されているメンテナンス以外のメンテナンスや修理が必要な

場合は、アジレント・テクノロジー株式会社のコールセンターへご連絡ください。このハン

ドブックに記載されていないメンテナンスを行って故障が生じた場合、保証の範囲ではあり

ません。 

 

９－２．電極、プレパンチャー、絶縁プレートの洗浄 

目的 

バッファ中の塩、界面活性剤、添加剤などが電極やプレパンチャーに析出する、或いは大気

中に浮遊している帯電物質が絶縁プレート周辺に汚れとして溜まると、次のような故障の原

因となります。 

■ アーク放電や過度のリーク電流の発生 

■ 注入量や移動時間の再現性低下 

■ キャリーオーバーの発生 

■ 加圧機構を用いる、フラッシュ時や試料注入時の動作不良 

 

頻度 

電極、プレパンチャー、絶縁プレートの洗浄はおよそ 1 週間に 1 回程度実施してください。

特に次のような場合は洗浄を行ってください。 

■ アプリケーションの原因以外で分析の再現性(移動時間・面積)が良好でない場合 

■ キャリーオーバーが観察される場合 
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■ テーリングピーク、ピーク割れが観察される場合 

■ アーク放電や過度のリーク電流が観察された場合 

■ 尿素やゲルのように粘性の高いバッファを使用した場合 

■ 高濃度の塩や界面活性剤を含むバッファを使用した場合 

 

手順 

次の手順で洗浄を行います。 

■ Agilent 7100 CE 本体からバイアルとカセットを取り外します。電源をオフにして、電

源ケーブルを外します。 

■ インレット側の電極を取り外します。 

■ 絶縁プレートを本体から取り外し、絶縁プレートのアウトレット側の電極を取り外しま

す。 

■ 本体のフロントカバーを取り外します。 

■ プレパンチャーを取り出します。 

■ 電極を洗浄します。 

■ プレパンチャーを洗浄します。 

■ 絶縁プレートを洗浄します。 

■ プレパンチャーを取り付けます。フロントカバーを取り付けます。 

■ アウトレット側の電極を絶縁プレートに取り付けます。 

■ 絶縁プレートを本体へ取り付けます。 

■ インレット側の電極を取り付けます。 

 

必要な部品 

□ 12mm ボックスレンチ････････････････スタートアップキットに含まれています 
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□ プラスドライバー････････････････スタートアップキットに含まれています 

□ マイナスドライバー････････････････スタートアップキットに含まれています 

□ イソプロパノール入り洗浄ボトル 

□ 純水入り洗浄ボトル 

□ 圧縮エアー(オイルフリー) 

□ 保護具（保護用眼鏡、手袋） 

 

＜警告＞ 

この作業を行う場合は、ラボの一般的な安全規則に従ってください。安全のために保護用眼

鏡とゴム手袋を着用してください。 

 

Agilent 7100 CE 本体の準備 

メンテナンスを行う前に次を実施します。 

-------------------------------------------------------------------------------------------------------------------------

- 

＜ChemStation から操作する場合＞ 

① 画面のランプの絵の上で右クリックします。 

② Switch UV lamp off を選び、ランプを Off にします。 

③ Unload Inlet lifter、Unload Outlet lifter を選び、リフトが持ち上げているバイアルをト

レイに降ろします。 

④ オンライン、オフライン共に全ての ChemStation を終了させます。 

⑤ Agilent 7100 CE 本体の電源を off にします。 

⑥ Agilent 7100 CE 本体から電源ケーブルを抜きます。 

-------------------------------------------------------------------------------------------------------------------------
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＜Lab Advisor から操作する場合＞ 

Lab Advisor ソフトウェアの詳細については、第 10 章を参照して下さい。 

① ChemStation が起動していないことを確認します。或いは、ChemStation が分析を実

行していないことを確認します。 

② Lab Advisor で Agilent 7100 CE 本体のモニタリングを開始します。 

③ メニューから Tools を選択します。 

④ CE Control Screen を選び、右のメニューから Maintenance Positions を選択します。

この操作により、全てのリフトがメンテナンスポジションまで下がります。 

⑤ オンライン、オフライン共に全ての ChemStation を終了させます。 

⑥ Agilent 7100 CE 本体の電源を off にします。 

⑦ Agilent 7100 CE 本体から電源ケーブルを抜きます。 
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【電極の取り外し】 

① カセットホルダーを後ろに倒して、元の位置に戻します。 

② 図を参照して、絶縁プレートを固定している 2 つの金属ネジ外します。ネジを紛失し

ないようご注意ください。 

③ 図を参照して、青色のアースケーブルを固定しているネジを外します。ネジとワッシャ

ーを紛失しないようご注意ください。 

 

図 ネジの取り外し 

 

④ 12mm のボックスレンチでインレット側の電極を取り外します。 

金属ネジ 

カセットホルダー 

絶縁プレート 

金属ネジ 
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図 電極の取り外し 

 

⑤ 赤色の高圧電源ケーブルを上へ静かに持ち上げ、インレット電極を取り出します。 

⑥ 図を参照して、絶縁プレートをゆっくり右へスライドさせた後(1)、傾けて持ち上げて

取り出します(2→3)。この際、アウトレット電極が装置の他の場所に触れないように注

意して取り外してください。 

 

図 絶縁プレートの取り外し 

 

高圧電源ケーブル(赤) 

インレット電極 

アースケーブル

(2)アウトレット電極

側を潜らせる 

(1)右へスライド (3)取りはずす 

(2)持ち上げる 
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⑦ 12mm のボックスレンチを用いて、絶縁プレートからアウトレット電極を取り外しま

す。 

 

＜備考＞ 

アウトレット電極は絶縁プレートを取り外さないと、取り外すことができません。 

 

【フロントカバーの取り外し】 

① トップカバーを開け、キャピラリーカセットを取り外します。 

② フロントカバーの上部にある 2 つのネジをそれぞれ 90°回転させます（マイナスネジ

の刻印が垂直方向から水平方向になるように）。これらのネジは外せないような仕組み

になっています。 

 

 

図 前面カバーの取り外し 

 

③ 前面カバーを注意しながら引き、本体から離します。カバーの上側両端を持ち、ゆっく

90°回転する

マイナスネジ 

マイナスネジ 

フロントカバー 
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りと均等に手前に引いて下さい。右上側にコネクタがあるので、外すために少し力が必

要です。 

 

＜注意＞ 

Agilent 7100 CE 本体の内部(Liquid Handling Module)は下図のように、前面に引き出すこと

ができますが、次に挙げる装置破損のリスクを伴うため、日常的に行う事を推奨しません。 

この操作を実行した場合、装置を元の状態に戻した後、全ての電極とリプレニッシュニード

ルについて Alignment Center によるアライメントの確認が必要となります。(11-2 節) 

 

・チューブの破損により、装置内で液漏れする恐れがあります。冷却水循環装置を使用して

いる場合は、その冷却水の配管を装置から完全に取り外して下さい。 

・装置内のケーブルが切断され、機器が破損する恐れがあります。操作時に注意しないと、

リボンケーブルは容易に破損を受けます。 

 

図 装置内部を引き出した例（日常的に行う事を推奨しません） 

 



 

- 179 - 

【プレパンチャーの取り外し】 

① インレットとアウトレットのリフトは、サンプルトレイの後方にあります。リプレニッ

シュメントシステムのリフトは装置右側手前(向かって)のリプレニッシュニードルの

下にあります。 

 

 

 

図 各リフトの位置 

 

 

リプレニッシュリフト 

アウトレットリフト 

インレットリフト 

リプレニッシュニードル 

& レベルセンサ

テフロンチューブ&コネクタ 

(ラベル 8番) 

テフロンチューブ 

&コネクタ 

( ベ 7番)
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＜注意＞ 

プレパンチャーの取り付け/取り外しの時に、リプレニッシュニードルに触ったり、曲げた

りしないで下さい。 

 

＜警告＞ 

プレパンチャーの先端は非常に鋭利です。プレパンチャーに触れるときは怪我をしないよう

充分注意してください。 

 

② プラスドライバーを用い、インレットリフトのプレパンチャーを留めているプラスチッ

クネジを緩めます。ネジを完全に外さなくてもプレパンチャーを外せます。プレパンチ

ャーを取り外しにくい場合は、プラスチックネジを完全に取り外してください。その際、

プラスチックネジの紛失にご注意ください。 

 

 

図 プレパンチャーのネジの取り外し 

 

プラスチックネジ 

プレパンチャー テフロンチューブ 

チューブコネクタ 

リフト 
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③ インレットプレパンチャーについているテフロンチューブ(ラベル 7 番)を持ち上げ、リ

フトからプレパンチャーを外します。チューブコネクタのネジを外し、テフロンチュー

ブごとプレパンチャーを取り外します。 

 

＜注意＞ 

プレパンチャーに接続しているチューブは外さないでください。頻繁な付け外しは接続部の

緩みの原因となります。緩んでしまった場合は、チューブを少し切断して、プレパンチャー

にはめ直してください。 

 

④ 同様の手順でアウトレットリフトからプレパンチャーを外します。リプレニッシュメン

ト機能を使用している場合は、リプレニッシュリフトのプレパンチャーを外します。リ

プレニッシュリフトのプレパンチャーについては、はじめからチューブは接続されてい

ません。 

 

＜備考＞ 

アウトレットプレパンチャーにはテフロンチューブ(ラベル8番)が接続されていない場合が

あります。一般的なアプリケーションでは、このようにチューブが接続されていない状態、

すなわち、アウトレットプレパンチャーが圧力システムから物理的に取り外されている状態

で使用することを推奨します。しかし、アウトレット側のバイアルに加圧/減圧を行う特別

なアプリケーションを行う場合は、アウトレットプレパンチャーにテフロンチューブ(ラベ

ル 8 番)を接続してください。 

 

＜備考＞ 

プレパンチャーを取り外しにくい場合は、全長 3cm 程度に切断した同径のテフロンチュー

ブ(両端がふさがっていないもの)をプレパンチャーに取り付けておくと、それを持って取り

外せるので、メンテナンス時に便利です。予備のテフロンチューブは本体には付属しません。

別途ご用意ください。 
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【電極の洗浄】 
① 塩の結晶が残らないように、電極を水で洗浄します。 

② イソプロパノールで電極を洗浄します。 

 

 

図 電極の洗浄 

 

③ 洗浄液が残らないように、圧縮エアーで電極の外側と内側を乾かします。 

 

＜注意＞ 

電極を完全に乾かしてから取り付けてください。リーク電流、アーク放電、コンタミネー

ションの原因になります。また、乾燥に温風は使用しないでください。 

 

＜備考＞ 

もし、電極の汚れが取れない場合は、洗浄操作を繰り返してください。また、Agilent 7100 

CE の電極は水或いはイソプロパノールに漬け、超音波洗浄することができます。洗浄時間

は 5 分間を超えないように注意ください(Agilent 1600 CE の電極は超音波洗浄できません)。

その後、ステップの 1~3 を行ってください。それでも復旧しない場合は、新品の電極と交

換します。 

 

＜備考＞ 

電極の外側に取り付けられているシリコン製の O リングが潰れている、磨耗している場合
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は、新しいものと交換してください。圧力もれの原因となります。 

□ シリコン製 O リング(部品番号 0905-1163) 

 

 

【プレパンチャーの洗浄】 

プレパンチャーを洗浄する前に、先端が破損していないか、湾曲していないかを確認してく

ださい。摩耗や破損が確認される場合は、新しいものに交換してください。特にプレパンチ

ャーの漏斗状の内側部分に摩耗による溝が確認される場合は、電極とプレパンチャーの位置

調整を行って下さい。(11-2 節 参照) 

 

＜警告＞ 

プレパンチャーの先端は非常に鋭利です。プレパンチャーに触れるときは怪我をしないよう

充分注意してください。 

 

① 水でプレパンチャーを洗浄します。塩の結晶がついていないか確認します。塩の結晶は

全て洗浄して、取り除きます。特に、テフロンチューブとの接続部分やテフロンチュー

ブ内が塩の結晶で詰まることがないように、よく洗浄して下さい。 

 

図 プレパンチャーの洗浄 
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② イソプロパノールでプレパンチャーとチューブを洗浄します。 

③ 洗浄液が残らないように、圧縮エアーで完全に乾かします。特に、プレパンチャーの穴

の部分とチューブ内をよく乾かします。 

 

もし、プレパンチャーの漏斗状の内側部分の汚れが取れない場合は、プレパンチャーを純水

の入ったビーカーに入れて、5 分間超音波洗浄をかけてください。或いは、小さなブラシで

その部分の汚れを丁寧に落としてください。プレパンチャーに傷をつけないようにご注意く

ださい。その後、2 と 3 のステップを繰り返してください。 

 

＜注意＞ 

プレパンチャーを取り付ける前に、プレパンチャーとチューブ完全に乾かしてください。液

体が少量でも残っていると、加圧が正常に行われなくなり、注入量の再現性の低下の原因と

なります。 

 

【絶縁プレートの洗浄】 

塩の析出や導電性の埃などが絶縁プレート表面に存在すると、リーク電流やアーク放電の原

因になります。電極やプレパンチャーの洗浄時にあわせて行うと予防保全になります。 

 

① 水で湿らせたウエスで絶縁プレートの全面を拭きます。 

② 次に、イソプロパノールで湿らせたウエスで絶縁プレートの全面を拭きます。 

③ 乾いたウエスと圧縮エアーで絶縁プレートを完全に乾かします。 

 

＜注意＞ 

絶縁プレートでの放電を防ぐため、絶縁プレートは完全に乾かした状態で取り付けてくださ

い。また、絶縁プレートは、最高温度 60℃までの自動洗浄機で洗浄することもできます。 
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【プレパンチャーの取り付け】 

① アウトレットリフト(装置に向かって左側)にプレパンチャーを注意して挿入します。ア

プリケーションを CE+p や CEC モードで実行する場合は、プレパンチャーに接続して

いるチューブ(ラベル 8 番)をコネクタ(ラベル 8 番)に接続します。コネクタへ確実に接

続して下さい。 

② プラスチックネジを締め、プレパンチャーを固定します。 

③ インレットリフト(装置に向かって右側)にプレパンチャーを注意して挿入します。プレ

パンチャーに接続しているチューブ(ラベル7番)をコネクタ(ラベル7番)に接続します。

コネクタへ確実に接続して下さい。 

④ プラスチックネジを締め、プレパンチャーを固定します。 

 

＜注意＞ 

プレパンチャーの固定には必ずプラスチックネジを使用して下さい。プレパンチャーの固定

に金属ネジを使用すると、リーク電流やアーク放電が発生し、機器が破損する恐れがありま

す。 

 

⑤ リプレニッシュリフト(装置に向かって右手前)にプレパンチャーを注意して挿入しま

す。このプレパンチャーは初めからチューブが接続されていません。プラスチックネジ

を締め、プレパンチャーを固定します。 

 

 

【電極と絶縁プレートの取り付け】 

① 絶縁プレートのアウトレット側の電極位置に電極を差込みます。 

② 電極を手で軽く回して締め、ネジを仮留めしてください。 

③ 専用の 12mm のボックスレンチで電極を締めます。締めすぎないよう注意して下さい。

また電極を曲げないように注意して下さい。 
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④ 絶縁プレートのカートリッジホルダーの部分を持って、少し傾けた状態で検出器の下に

差し込み(1)、アウトレット側の電極部が検出器の穴の部分に来るようにしてから絶縁

プレートを下ろします(2)。最後に、絶縁プレートをゆっくり左側へ押し付けます(3)。 

 

 

図 絶縁プレートの取り付け 

 

⑤ 絶縁プレートを平らにします。図を参照して、アウトレット電極を検出器の正しい位置

にくるようにします。 

 

(2)おろす 

(1)斜めに差し込

(3)左へスライド 

(2)アウトレット電極

側を潜らせる 
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図 ネジと電極の取り付け 

 

⑥ 2 つの金属ネジで絶縁プレートを固定します。 

⑦ 青色のアースケーブルを絶縁プレートに取り付け、金属ネジとワッシャーで締めます。 

⑧ インレット電極を赤色の高電圧線のリングコネクタに挿入します。絶縁プレートにイン

レット電極がリングコネクタを通り絶縁プレートに固定されるように、軽く手で締めま

す。12mm のボックスレンチを使って固定します。締めすぎないように注意して下さ

い。 

 

【キャピラリーとキャピラリーカセットの取り付け】 

キャピラリーとキャピラリーカセットの取り付けは、1-3 節を参照してください。 

 

【フロントカバーの取り付け】 

① フロントカバーのネジの刻印が水平方向になっていることを確認します。フロントカバ

ーのネジは水平方向になっていないと、はまりません。 

② 耐圧ボトルが設置されたスペースの黒いカバーを少し開いた状態にしておきます。 

高圧電源ケーブル

インレット電極 

アースケーブル

金属ネジ 

金属ネジ 
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③ まず先にフロントカバーの下側を本体に差し込みます。 

④ フロントカバーを注意深く本体側へ押し込みます。右側にコネクタがあるので注意して

取り付けてください。 

⑤ 耐圧ボトルが設置されたスペースの黒いカバーの左下隅を押し、閉じます。 

⑥ フロントカバーの上部にある 2 つのネジをそれぞれ 90°回転させます（マイナスネジ

の刻印が水平方向から垂直方向になるように）。 

⑦ トップカバーを閉めます。 

⑧ 電源コードを接続し、Agilent 7100 CE 本体の電源ボタンを押し、on にします。 

⑨ コンピューターを起動し、ChemStation をスタートさせます。 

 

 

 

図 前面カバーの取り付け 

 

 

90°回転する

マイナスネジ 

マイナスネジ 

フロントカバー 
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９－３．検出部とアラインメントインターフェースの洗浄 

ここではキャピラリーの検出部とアラインメントインターフェースのスリットの洗浄方法

を説明します。インターフェースのスリット部分が塞がると、ノイズやエラーの原因になり

ます。 

 

頻度 

必要時、S/N 比が悪化した、アラインメントインターフェースのスリットに汚れが見られた

場合に行って下さい。キャピラリーをアラインメントインターフェース付近で破損し、イン

ターフェース内に残った破片を除去する場合も実施します。 

 

必要な部品 

□ 綿の布または柔らかいティッシュ(ケバのたたないもの) 

□ イソプロパノール 

□ キャピラリー挿入ツール 

□ オイルフリーの圧縮エアー 

□ 超音波洗浄器 

□ ビーカー(100ml) 

□ 保護具（保護用眼鏡、手袋） 

 

＜警告＞ 

この作業を行う場合は、安全のために保護用眼鏡とゴム手袋を着用してください。 
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手順 

■ キャピラリーカセットを取り外す。 

■ カセットからキャピラリーを取り外す。 

■ キャピラリーからアラインメントインターフェースを外す。 

■ 検出部の洗浄 

■ アラインメントインターフェースの洗浄 

 

【キャピラリーカセットの取り外し】 

① HPCE ダイアグラムで Change Cassette を選びます。 

② ”System is ready for cassette change”と表示されたら、トップカバーを開けます。 

③ Agilent 7100 CE 本体からキャピラリーカセットを取り外します。 

 

【キャピラリーカセットからのキャピラリーの取り外し】 

【キャピラリーからのアラインメントインターフェースの取り外し】 

 

詳細は 1-3 節を参照してください。 

 

＜警告＞ 

キャピラリーカセットを開けてキャピラリーを取り外す時は、目を保護するために安全メガ

ネを着用して下さい。 

 

＜注意＞ 

キャピラリーカセットを開けるとき、無理な力を加えるとカセット内部の部品が壊れること

があります。 
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＜注意＞ 

キャピラリーを動かしている間は、必ずアラインメントインターフェースの銀色のリングを

押し続けてください。手を放してキャピラリーを動かすと、キャピラリーが破損する恐れが

あります。 

キャピラリーを差し込む際に、セル窓の後ろのキャピラリーやストッパー部分を持たないよ

うにしてください。キャピラリーのセル窓が破損する恐れがあります。 

 

 

【キャピラリーの検出窓の洗浄】 

イソプロパノールで湿らせた綿の布かケバ立ちのない柔らかいティッシュで、キャピラリー

の検出部分(ポリイミドの茶色コーティングが剥がされている検出窓部分)を注意してやさ

しく拭きます。 

 

【アラインメントインターフェースの洗浄】 

① イソプロパノールの入ったビーカーにアラインメントインターフェースを入れます。ビ

ーカーを超音波洗浄器に入れて、5 分間超音波洗浄をします。 

② 圧縮エアーをアラインメントインターフェースに吹き付け、乾燥させます。 

 

＜注意＞ 

圧縮エアーは、最大圧力 2bar 以下の状態で使用ください。また、オイル入りの圧縮エアー

は使用しないで下さい。 

 

＜注意＞ 

アラインメントインターフェースは充分乾燥させてください。液体が残ったまま分析に用い
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ると、リーク電流、アーク放電の原因となります。 

 

③ スリットがきれいになったかを拡大鏡や顕微鏡でチェックして下さい。 

 

【キャピラリーとキャピラリーカセットの取り付け】 

キャピラリーとキャピラリーカセットの取り付けは、1-3 節を参照してください。 
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９－４．エアフィルターの交換 

目的 

Agilent7100CE 本体への空気の吸引口に取り付けられているエアフィルターの交換手順に

ついて説明します。本体内部のエアポンプは、外部の環境からこのエアフィルターを経由し

た空気を取り込み、装置前面にあるバッファ用ボトル内部を加圧することで空気をためてい

ます。この加圧された空気はキャピラリーのフラッシングやサンプル注入時に使用されます。 

 

頻度 

エアフィルターの交換は、非常に埃の多い環境で使用している時には頻繁に行ってください。

また、エアフィルターの詰まりにより、システムの動作に必要な圧力を作れなくなった場合

にも交換する必要があります。少なくとも 3 カ月毎に交換する事をお勧めします。 

 

必要な部品 

□ エアフィルター (部品番号 3150-0619) 

（本体付属のアクセサリキットにスペアのフィルターが 1 つ含まれています） 

 

手順 

エアフィルターはバッファ用ボトルと廃液用ボトルが収められているスペースにあり、簡単

に交換することができます。 

① バッファ用ボトルと廃液用ボトルが設置されているスペースの黒いカバーを開ける。カ

バーの右下(装置に向かって)の隅を押すと、ロックが外れカバーが開きます。 

② スペースの右側面にエアフィルターがあるので、新しいものと交換します。 

 



 

- 194 - 

 

図 エアフィルターの位置 

 

③ 黒いカバーを閉じ、カバーの右下の隅を押してロックします。 

 

交換後、装置の加圧、減圧が正常に行われない場合は、以下の点をチェックします。 

■ 圧力ボトル(バッファ用ボトル)の密閉性 

■ 真空ボトル(廃液用ボトル)の密閉性 

■ ボトル配管の緩み 

 

これらをチェックしても解決しない場合は、アジレント・テクノロジー株式会社のコールセ

ンターまでご連絡ください。 

 

＜注意＞ 

エアフィルターなしで動作させないでください。埃が装置のバルブシステムへダメージを与
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えます。 

 

 

９－５．ランプの交換とランプ強度チェック 

目的 

ここでは 7100CE の重水素ランプの交換手順について説明します。ランプの交換は、ラン

プの強度が下がり、ベースラインノイズが増加したときに行います。 

 

頻度 

ランプの交換は、ノイズレベルが顕著に増加し、ランプ以外の理由が考えられないとき(例：

アラインメントインターフェースのスリット部分の汚れ、キャピラリー内部での吸着 etc)、

またはランプが点灯しない場合に実施します。ランプを交換する前にランプの強度チェック

を必ず実施し、他の原因(キャピラリー内への気泡の混入、アラインメントインターフェー

スのスリット部の汚れ、キャピラリーのセル窓部分の汚れ etc)ノイズが増加していないかを

確認して下さい。 

一般に、ランプの点灯時間が 2000 時間を超えると、ランプの強度が使用開始時より 50%

低下します。そのため、デフォルトとして、ランプ交換時期の目安を 2000 時間としていま

す。但し、アプリケーションや分析の目的によっては、2000 時間未満で交換が必要なこと

もあります。 

ランプの点灯時間の確認、ランプ強度テストについては、Lab Advisor ソフトウェアから行

います。本節でも簡単に紹介しますが、詳細は 10-2 節を参照して下さい。 

 

必要な部品 

■ ポジドライバー (本体付属のアクセサリキットに含まれています) 

■ Agilent 7100 CE 専用のランプ 

■ キャピラリーカセット 
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■ 緑色のアラインメントインターフェース 

 

＜注意＞ 

弊社から販売する Agilent 7100 CE 専用ランプ以外のランプはサポート対象外です。必ず専

用ランプを使用ください。専用ランプに付属しているタグには、ランプの点灯に必要なデ

ータや詳細情報が記録されています。タグの無いランプを使用すると、点灯しない、及び、

装置エラーの原因となります。 

 

【ランプ点灯時間、ランプ強度の確認】 

＜ランプ点灯時間の確認＞ 

① Lab Advisor を起動し、Agilent 7100 CE 本体のモニタリングを開始します。 

② メニューから Early Maintenace Feedback を選択します。 

③ 表の“Accumulated UV lamp ON-Time”部分の Value が、ランプの累積点灯時間です。 

 

＜ランプ強度テストの実行＞ 

・ランプの光量を安定させるため、テストを行う 30 分以上前から、重水素ランプを点灯さ

せておきます。 

・キャピラリーを通さず、緑アラインメントインターフェースのみを装着したキャピラリ

ーカセットを装置にセットします。 

① Lab Advisor を起動し、Agilent 7100 CE 本体のモニタリングを開始します。 

② メニューから Tests を選択します。 

③ Detector test suite を選択し、Run Test Now をクリックします。 

④ テスト項目の、”Noise, drift and temperature stability”のチェックのみを外し、Start Run

をクリックします。（ノイズテストを実行すると、テスト時間がかかります。） 

⑤ テスト結果を確認します。 
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【ランプの取り外し】 

ランプの交換を行う前に次のことを実施して下さい。 

① HPCE Diagram 画面のランプの絵の上で右クリックします。 

② Switch UV lamp off を選び、ランプを Off にします。 

③ Unload Inlet lifter、Unload Outlet lifter を選び、リフトが持ち上げているバイアルを降

ろします。 

④ オンライン、オフライン共に全ての ChemStation を終了させます 

⑤ Agilent7100CE 本体の電源を off にします。 

⑥ Agilent7100CE 本体から電源ケーブルを抜きます。 

 

＜警告＞ 

ランプが点灯したままディテクターカバーを開けると、ランプの強い紫外線が目に悪影響を

与えます。必ずランプが off になった状態でディテクターカバーを開けてください。 

 

⑦ トップカバーを開けます。 

⑧ ランプカバーの前面にある留め具を押して、カバーを上に開けます。 

⑨ ランプのコネクタを外します。コネクタを外す際は、ケーブルを引っ張らずにコネクタ

部分を持って外してください。 

 

＜警告＞ やけどの危険 

Agilent 7100 CE 本体を直前まで使用していた場合は、ランプがとても熱くなっています。

冷めるまで待ってからランプに触れてください。 
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⑩ ランプについている 2 本のスクリューネジをポジドライバーで緩めます。 

⑪ ランプを注意深く取り出します。 

 

 

図 ランプの交換 

【新しいランプの取り付け】 

① 新しいランプを扱う時は、金属のリング部分を持ってください。ランプのガラス表面を

絶対に触らないで下さい。ガラスについた指紋は光を吸収し、ランプ強度を下げます。

万が一触ってしまった場合は、ケバのない柔らかい布か紙にメタノールまたはエタノー

ルを浸したもので、ガラス表面の指紋を完全に拭き取ってください。 

位置あわせピン 

スクリューネジ 

コネクタ 

留め具 
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② 新しいランプをランプ室の中に差し込みます。ランプのリング上にある穴の位置を、ラ

ンプ室についている位置合わせ用のピンと合わせて下さい。 

③ ランプについている 2 つのスクリューネジをポジドライバーで締めます。 

④ ランプケーブルのアダプターを Agilent 7100 CE 本体のコネクタへしっかり差し込みま

す。 

⑤ ランプカバーを閉じます。トップカバーを閉じます。 

 

【ランプ強度のチェック方法】 

ランプ強度をチェックは、Lab Adviser ソフトウェアの検出器テストの強度テストから行い

ます。 

 

① キャピラリーを通さずに、緑色のアラインメントインターフェースのみをキャピラリー

カセットにセットします。カセットを Agilent 7100 CE 本体にセットします。 

② Agilent 7100 CE 本体の電源をオンにします。 

③ ChemStation ソフトウェアを起動します。 

④ 画面のランプの絵の上で右クリックし、Switch UV lamp on を選び、ランプを点灯させ

ます。 

⑤ ランプのウォームアップに必要な時間は約 1 時間です。 

⑥ Lab Adviser ソフトウェアの検出器テストの強度テストを実行して、新しいランプの初

期ランプ強度を調べます。結果を参照用に保存します。 

 

【ランプ強度テストが合格しない場合】 

新品のランプを設置したにもかかわらず、強度テストに合格しない場合は、次の点を確認し

てください。 
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■ ランプは正しい位置に取り付けられているか？ 

■ キャピラリーカセットは正しい位置に取り付けられているか？ 

■ 緑色のアラインメントインターフェースを使用しているか？ 

■ 緑色のアラインメントインターフェースはキャピラリーなしの状態になっているか？ 

■ アラインメントインターフェースのスリット部分が汚れていないか？ 

 

もし、これらの点をチェックした後も、強度テストに合格しない場合は、アジレント・テク

ノロジー株式会社のコールセンターまでご連絡ください。
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第１０章  Lab Advisor（ラボアドバイザー） 

 

Lab Advisor ソフトウェアは Agilent 7100 CE の各部動作テスト、ならびに消耗品（重水素

ランプ）の使用状況等を確認するためのものです。通常の分析では用いませんが、装置のメ

ンテナンスやエラー発生時の確認にこのソフトウェアを用います。 

 

ユーザーが使用する主な機能は下記の通りです。 

■ ランプの累積点灯時間を調べる、点灯時間のリミットを設定する（Early Maintenance 

Feed(EMF)機能を使用する）（10-2 節） 

■ 検出器テスト(ランプ強度、ノイズ測定など)を実行する（10-3 節） 

■ メンテナンスモードを使用する（リプレニッシュメント使用前の洗浄操作、電極・リプ

レニッシュニードルのアライメント調整を行う）（10-4 節） 

■ エラー発生時のログを確認する（10-5 節） 

 

 

１０－１． ラボアドバイザーの起動と終了 

 

・ChemStation が起動している状態でも Lab Advisor は起動します。 

・Lab Advisor でランプ強度テストを行う場合、テスト開始前にあらかじめ ChemStation で

30分以上からランプをONにしておくと、ランプ光量が安定した状態でテストできます。 
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【Lab Advisor の起動と装置のモニター開始】 

① Lab Advisor を起動します。 

  Windows  Start メニューから Agilent Technologies → Lab Advisor をクリック

するか、デスクトップ上にあるアイコンをクリックします。 

 

② Lab Advisor ソフトが起動します。 

③ 画面上の『Lab at a Glance』内で表示されている（青く反転している）装置表示部分

を右クリックします。 

④ 表示されるプルダウンメニュー内から Start Monitoring をクリックします。 
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⑤ 装置のモニターが開始します。Agilent 7100 CE の絵の横に、緑のチェックマークが表

示され、Lab Advisor が装置をモニター中であることを示します。 

 

 

 

 

【Lab Advisor の終了】 

Lab at a Glance 画面に戻り、上記装置部を右クリックしメニューから、Stop Monitoring

をクリックして終了します。 
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【Lab Advisor のメニュー】 

Lab Advisor 画面の左側にメニューが表示されます。このメニューをクリックすることによ

り、画面が切り替わります。ここでは主なメニューのみ紹介します。 

 

＜Lab at a Glance＞ 
Lab Advisor で管理される装置一覧が表示されます。 

 

＜Configuration＞ 
Lab Advisor の詳細な設定や情報を確認できます。

通常この設定は変更しません。 

 

＜System Information＞ 
装置本体、及び DAD のファームウェアのバージョ

ンを確認できます。通常用いません。 

 

＜Tests＞ 
CE 本体、および DAD 検出器のテストを実行しま

す。ランプ強度テストやノイズテスト時に用います。 

 
＜Early Maintenance Feedback (EMF)＞ 
装置の使用状況をもとにしたメンテナンスをスケジュールできます。ランプの累積点灯時間

の管理はここで行います。 

 

＜Logs & Results＞ 
装置の動作、エラー等の履歴(ログ)が表示されます。 

 

＜Tools＞ 
メンテナンスモードになります。リプレニッシュメントシステムの洗浄、電極/リプレニッ

シュニードルのアライメントはここで行います。 
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１０－２． ランプの累積点灯時間の確認、点灯時間のリミット設定 

（Early Maintenance Feedback(EMF)機能の使用） 

 

Early Maintenance Feedback(EMF)メニューで用いる代表的な操作は次の通りです。 

・ランプの累積点灯時間を確認する 

・ランプ点灯時間のリセットする 

・ランプ点灯時間のアラームを設定する 

 

例えば、DAD で使用する重水素ランプに対し、前回のメンテナンス経験を基にして点灯時

間の使用リミットを入力します。点灯時間がそのリミットに達すると、EMF インジケータ

の色が緑→赤と変化して、ランプの交換時期を知ることができます。 

ランプの交換方法については、9-5 節を参照して下さい。 

 

(注意) 

EMF で設定したリミットを超えても、メソッドやシーケンスに基づく分析が中断すること

はありません。分析は通常通り進行できます。 

 

Early Maintenace Feedback メニューより、設定します。 

① 左のメニューから Early Maintenance Feedback をクリックします。 

② Early Maintenance Feedback 画面に切り替わります。 
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図 Early Maintenance Feedback 画面 

 

【ランプの累積点灯時間の確認】 

”Accumulated UV Lamp ON-Time”がランプの点灯時間です。Value に現在の累積点灯時間

が表示されます。警告時間とリミット時間も表示されます。 

 

 

 
ランプ点灯時間 現在の 

累積点灯時間 警告時間 

（黄色点灯）

リミット到達時間 

（赤色点灯）
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【ランプ点灯時間のリセット】 

ランプを交換し、ランプの累積点灯時間をゼロにリセットするには、表の”Accumulated UV 

Lamp ON-Time”部分をクリックして選択した後、Reset Value をクリックします。 

 

 

【ランプ点灯時間のアラームを設定する】 

ランプの累積点灯時間の警告やリミットの設定は、通常はデフォルトで用います。分析目

的に合わせて、そのリミット時間を変更することができます。変更する場合は、表

の”Accumulated UV Lamp ON-Time”部分をクリックして選択した後、Save Changes をク

リックします。 

 

 

Warning(警告時間設定) Value(実測値) Limit(リミット到達時間設定) 

 

 

＜注意＞ 

・ 必要がない限り、Stop Tracking をクリックしないで下さい。現在の状況を追跡（トラ

ッキング）しなくなります。再開するには Stop Tracking をクリックして下さい。 

・ Rest Value をクリックしないで下さい。現在の値がゼロにリセットされます。ランプ

交換後に点灯時間をリセットする時のみ用いてください。 

 

点灯時間をゼロに

リセットするとき

のみクリック 
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１０－３． 検出器テストの実行 

 

① 左のメニューから Tests をクリックします。 

② Tests 画面に切り替わります。 

 

③ Test の中から Detector test suite を選択し、Run Test Now をクリックします。 

④ テスト開始画面が開きます。 
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【ランプ強度テストの実行】 

テスト開始前に、キャピラリーカセット（キャピラリーを通さず、緑アラインメントイン

ターフェースのみを装着したもの）を装置にセットします。 

 

テスト開始の 30 分以上前に、ChemStation であらかじめランプを点灯させておくと、ラン

プのウォームアップに必要な 30 分を待たず、すぐにテストが開始します。 

 

① Detector tests の + をクリックして、展開します。 

 

左図の通り、テスト項目の内容を設定し

ます。テスト項目の、 

”Noise, drift and temperature stability”の

チェックのみを外します。 

（ノイズテストを実行すると、テストが

完了するまでに時間がかかります。） 

 

 

 

 

 

② Start Run をクリックします。テスト開始前からすでにランプが 30 分以上点灯してい

る場合、すぐにテストが開始します。テスト開始前にランプが消灯していた場合は、

ランプが点灯し、そのウォームアップ時間である 30分経過後に、テストが開始します。 

③ テストが完了します。 

④ テスト結果を印刷、あるいはファイル保存するには、Print Results をクリックします。
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保存可能なファイル形式は Excel ファイルと pdf ファイルです。 
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【全ての検出器テストの実行】 
テスト開始前に、キャピラリーカセット（キャピラリーを通さず、緑アラインメントイン

ターフェースのみを装着したもの）を装置にセットします。 

 

・テスト開始の 30 分以上前に、ChemStation であらかじめランプを点灯させておくと、ラ

ンプのウォームアップに必要な 30 分を待たず、すぐにテストが開始します。 

・ノイズ、ドリフト、温度安定性テストを行うため、テストに時間がかかります。 

 

① 下図の通り、テスト項目の内容を設定します。 

 

 

② Start Run をクリックします。テスト開始前からすでにランプが 30 分以上点灯してい

る場合、すぐにテストが開始します。テスト開始前にランプが消灯していた場合は、

ランプが点灯し、そのウォームアップ時間である 30分経過後に、テストが開始します。 

③ 途中で、以下のメッセージが表示されます。キャピラリーカセットが装置にすでにセッ

ト済みであれば、OK をクリックしてください。 
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④ テストが完了します。 

④ テスト結果を印刷、あるいはファイル保存するには、Print Results をクリックします。

保存可能なファイル形式は Excel ファイルと pdf ファイルです。 
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【テスト画面の紹介】 
 

・General 画面：現在実施中のテスト項目内容の表示、進行状況、実測値を表示します。 

 

                            刻々と変化します   

・Limit 画面：各テスト項目の測定基準値を表示します。 
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・Signal 画面：ノイズ等のオンライン実測プロットを表示します。 

 

            刻々と変化します    

 

・以上、全てのテストが終了すると、Passed（合格）、Failed（不合格）の判定が 

 表示されて、終了します。 
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１０－４． メンテナンスモード 

 

Tools メニューより、リプレニッシュメント使用時のシステム内洗浄操作や、電極とリプレ

ニッシュニードルの位置調整を行います。 

 

① 左のメニューから Tools をクリックします。Tools 画面に切り替わります。 

 

② Tools Selection の中から CE Control Screen を選択し、Start をクリックします。 
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③ Tools : CE Control Screen 画面に切り替わります。 

 

CE Control Screen 画面は、下記のタブで構成されています。 

・IRP System 

・Replenishiment System 

・Vials 

ここで紹介するのは、Replenishiment System のみとします。 

 

【リプレニッシュメント使用時のシステム洗浄】 

① Replenishiment System のタブをクリックします。 

② 右側に表示されるメニューバーから洗浄動作を選択します。 

リプレニッシュメントシステムの洗浄の詳細については、11-1 節を参照して下さい。 

 

＜注意＞ 

Lab Advisor から装置のコントロールを始めると、画面下部のバーに鍵のマークが表示され、

ChemStation からコントロールできなくなります。装置制御の優先権が Lab Advisor に移る

ためです。鍵のマークをクリックしロックを外すと、ChemStation からコントロールでき

るようになります。 

 

   

 ↓（鍵のマークをクリックし、解除してから ChemStation でコントロールする） 
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「Replenishment System」メニューバー 

 代表的な実施項目を紹介します。    

クリーンレベルセンサー実行 

クリーンチューブ実行 

フラッシュチューブ実行 

リプレニッシュメント用耐圧ボトル交換 

メンテナンスポジションへのリフト位置調整 

アライメント調整 

 

 

 

 

 

 

 

 システムのリセット 

 

 Tools 画面に戻ります。 
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１０－５． エラーログの確認 

 

Logs & Result メニューから、Agilent 7100 CE の動作、エラー等の履歴を表示します。 

① 左のメニューから Logs & Results をクリックします。 

② Logs & Results 画面に切り替わります。 
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第１１章 補足１ 

１１－１． リプレニッシュメント（バッファ自動交換）システムの洗浄 

 

目的 

リプレニッシュメント（バッファ自動交換）システムは、サンプルトレイに置かれたバイア

ルの中の古いバッファを捨て、新しいバッファを補充するシステムです。長時間連続分析を

行う場合、バッファの組成が変化するのを防ぐために行います。このシステムを正常に機能

させるには、使用前に事前準備が必要です。 

 

＜注意＞ 

界面活性剤が入ったバッファや高塩濃度のバッファの使用は、システム内での詰まりの原因、

レベルセンサーの誤作動の原因となります。使用しないでください。 

 

＜注意＞ 

塩が入ったバッファを使用する場合は、リプレニッシュニードルの場所で詰まりが発生する

場合があります。ニードルの詰まりを防ぐために、純水を 1.8cm の高さに満たし、キャッ

プをしたバイアルを 49 番（ホームポジション）にセットしてください。ChemStation ソフ

トウェアの画面で 2 つのボトルの絵の間を右クリックして、Set Replenish Vial を選択し 49

番を指定します。この操作により、ニードルの先端が純水につかり、乾燥による塩の析出を

防ぎます。また、適時リプレニッシュニードルに付属するレベルセンサーの洗浄を行ってく

ださい(11-1 節)。 

 

＜注意＞ 

リプレニッシュメントシステムは、侵食性または腐食性のあるバッファ、有機溶媒、或いは

これらから蒸発した成分によってダメージを受ける可能性があります。以下の点に注意して
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下さい。 

・侵食性または腐食性のあるバッファ、有機溶媒の使用を避けて下さい。 

リプレニッシュメントシステムで使用するバッファやバッファの揮発成分は、ポリテトラフ

ルオロエチレン(PTFE)、ステンレススチール(SST、グレード 316)、フッ素ゴム(FPM、Viton)、

ポリエーテルエーテルケトン(PEEK)、フッ化エチレン-プロピレン樹脂(FEP)、ガラス(フィ

ルターとボトル)と接触します。これらを腐食する成分を含むバッファは使用しないでくだ

さい。また、バッファの使用許容 pH 範囲は pH3～11 です。 

 

・高濃度のギ酸や酢酸などのバッファはステンレスを腐食させ、システム内での詰まりの原

因となります。ギ酸は最大濃度 0.1%まで使用できますが、腐食性があります。腐食性バッ

ファの使用はリプレニッシュメントシステムへダメージを与えることが報告されています。 

 

・指定された条件を超えるバッファ組成を使用する場合は、リプレニッシュメントシステム

を使わずに、個別のバイアルを使用して分析を実施して下さい。 

 

頻度 

リプレニッシュメントシステムのボトルやチューブは、バッファのコンタミネーションを防

ぐため、定期的に洗浄しなければなりません。特に次のような場合は洗浄を行ってください。 

■ 初めて使用する場合 

■ バッファの交換時 

■ リプレニッシュメントシステムをしばらく使用しない場合 

 

＜警告＞ 

リプレニッシュメントシステムでは、部品番号 9300-1748 または 5042-6478 の耐圧ボトル

のみ使用できます。ボトルに圧力がかかるため、特別な保護コーティングが施されています。 
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図 リプレニッシュメントシステム 

 

 

必要なもの 

□ バイアルとキャップ   部品番号 5182-0538 

□ ガラスバイアル   部品番号 5182-0567 

またはポリプロプレンバイアル  部品番号 5181-1512 

□ バイアルキャップ(ポリウレタン製) 

廃液用ボトル 

バッファ用ボトル 

ガラスフィルター 

リプレニッシュリフト 

リプレニッシュニードル 

& レベルセンサー
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□ リプレニッシュメント用耐圧ボトル (装置に装備済) 

□ 水／イソプロパノール／バッファ (使用目的による) 

□ ChemStation ソフトウェア、または Lab Advisor ソフトウェア 

□ 保護具（保護用眼鏡と手袋） 

 

洗浄の手順 

■ 耐圧ボトルにかかっている圧力をリリースし、取り外します。 

■ 耐圧ボトル(バッファ用ボトル)に洗浄液を入れます。 

■ 耐圧ボトル(廃液用ボトル)を空にします。 

■ 耐圧ボトルを装置に接続します。 

■ Flush tubes を実行し、流路を洗浄します。 

■ Clean tubes を実行し、流路を洗浄します。 
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【リプレニッシュメントシステムを最初に使用する場合】 
------------------------------------------------------------------------------------------------------------------------- 

＜ChemStation から操作する場合＞ 

① HPCE Diagram の中でリプレニッシュメントシステムのボトルの絵をクリックします。

Electrolyte と Waste のどちらのボトルでもかまいません。 

     

 

② メニューの中から Change Bottles を選択します。この操作により、ボトルを外す前に

ボトルの中にかかっていた圧力が抜けます。図のように”System is ready for bottle 

change”と表示されたのを必ず確認してからボトルを外してください。 

 

------------------------------------------------------------------------------------------------------------------------- 
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＜Lab Advisor から操作する場合＞ 

① Tools : CE Control Screen ＞ Replenishment System の画面を表示させます。 

② メニューの中から Change Bottles を選択します。この操作により、ボトルを外す前に

ボトルの中にかかっていた圧力が抜けます。図のように”Pressure and vacuum have 

been released”と表示されたのを必ず確認してからボトルを外してください。 
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------------------------------------------------------------------------------------------------------------------------- 

 

③ 耐圧ボトルが設置されているスペースの前面についている黒いカバーを開けます。カバ

ーの右下(装置に向かって)の隅を押すと、ロックが外れカバーが開きます。 

 

＜警告＞ 

廃液には、泳動バッファ成分やサンプル成分が含まれています。ボトル内の液体を取り扱う

時は、ゴム手袋と保護眼鏡を着用してください。 

 

④ リプレニッシュメントシステムの耐圧ボトルのキャップを外します。ボトルのキャップ

にはチューブとフィルターがつながっています。フィルターを汚染しないように注意し

て下さい。 
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図 チューブとフィルター 

 

⑤ バッファ用ボトル(装置に向かって左側)に純水 200ml を入れます。水はあらかじめ孔径

0.25μm 以下のフィルターを通したものを使用して下さい。 

500mL ボトル(部品番号 9300-1748)の場合、100～400mL の範囲で液体を入れること

ができます。100mL ボトル(部品番号 5042-6478)の場合、40～80mL の範囲で液体を入

れることができます。いずれのボトルを使用する場合、ガラスフィルターが液体の中

に完全に沈み込むようにしてください。 

⑥ 廃液用ボトル(装置に向かって右側)を空にします。 

バッファ用ボトル 

廃液用ボトル 

ガラスフィルター 
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⑦ バッファ用ボトルと廃液用ボトルをそれぞれ元の位置に戻し、キャップをしっかりと締

めます。 

------------------------------------------------------------------------------------------------------------------------- 

＜ChemStation から操作する場合＞----- Clean Tubes のみ実施 

⑧ Done を選択します。ボトル内部が再び加圧されます。 

⑨ システムが Ready 状態になるまで待ちます。 

⑩ バッファ用ボトルと廃液用ボトルの間をクリックします。 

⑪ 内部の流路を全てクリーニングするため、Clean Tubes を選択します。 

     

⑫ キャップをした空のバイアルをサンプルトレイの(例として)46 番に置きます。 

⑬ トレイにセットした空のバイアルのバイアル番号(ここでは 46 番)と、洗浄繰り返し回

数を 5 回と設定します。 

⑭ 洗浄プログラムがスタートします。 

 

＜注意＞  

2010年 3月 10日現在(ChemStation Rev.B.04.02[118])、ChemStationにおいて Flush Tubes
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のメニューを選択できません。Clean Tubes を繰り返し実行するか、Lab Advisor から手順

10 以降を実施して下さい。Lab Advisor での操作が終わり、再び ChemStation から装置を

コントロールする場合は、Lab Advisor の左下隅の鍵のマークをクリックして Lab Advisor

からのコントロールを解除して下さい。 

------------------------------------------------------------------------------------------------------------------------- 

＜Lab Advisor から操作する場合＞----- Flush Tubes と Clean Tubes を実施 

⑧ OK を選択します。ボトル内部が再び加圧されます。 

⑨ 圧力システムが Ready 状態になるまでに要した時間が表示されます。再び OK を選択

します。 

⑩ バッファ用ボトルと廃液用ボトルの間のチューブとバルブを洗浄するため、Flush 

Tubes を選択します。フラッシュ時間を 20sec に設定します。このステップでは、リ

プレニッシュニードルとそのバルブ側の流路の洗浄は行いません。 

 

⑪ 内部の流路を完全にクリーニングするため、Clean Tubes を選択します。 
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⑫ キャップをした空のバイアルをサンプルトレイの(例として)46 番に置きます。 

⑬ トレイにセットした空のバイアルのバイアル番号(ここでは 46 番)と、洗浄繰り返し回

数を 5 回と設定します。 

⑭ 洗浄プログラムがスタートします。 

------------------------------------------------------------------------------------------------------------------------- 

 

注意点 

装置の加圧、減圧が正常に行われない場合は、以下の点をチェックして下さい。 

■ バッファ用ボトルの密閉性 

■ 廃液用ボトルの密閉性 

■ エアフィルターの目詰まり 

 

これらをチェックしても解決しない場合は、アジレント・テクノロジー株式会社のコールセ

ンターまでご連絡ください。 
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【リプレニッシュメントシステムでバッファの組成を変更する場合】 

------------------------------------------------------------------------------------------------------------------------- 

＜ChemStation から操作する場合＞ 

① HPCE Diagram の中でリプレニッシュメントシステムのボトルをクリックします。 

② メニューの中から Change Bottles を選択します。この操作により、ボトルを外す前に

ボトルの中にかかっていた圧力が抜けます。”System is ready for bottle change”と表示

されたのを確認してからボトルを外してください。 

------------------------------------------------------------------------------------------------------------------------- 

＜Lab Advisor から操作する場合＞ 

① Tools : CE Control Screen ＞ Replenishment System の画面を表示させます。 

② メニューの中から Change Bottles を選択します。この操作により、ボトルを外す前に

ボトルの中にかかっていた圧力が抜けます。”Pressure and vacuum have been released”

と表示されたのを確認してからボトルを外してください。 

------------------------------------------------------------------------------------------------------------------------- 

 

③ 耐圧ボトルが設置されているスペースの前面についている黒いカバーを開けます。カバ

ーの右下(装置に向かって)の隅を押すと、ロックが外れカバーが開きます。 

 

＜警告＞ 

廃液には、泳動バッファ成分やサンプル成分が含まれています。ボトル内の液体を取り扱う

時は、ゴム手袋と保護眼鏡を着用してください。 

 

④ リプレニッシュメントシステムの耐圧ボトルのキャップを外します。ボトルのキャップ

にはチューブとフィルターがつながっています。フィルターを汚染しないように注意し

て下さい。 



 

- 233 - 

⑤ バッファ用ボトル(装置に向かって左側)にバッファ 200ml を入れます。バッファはあら

かじめ孔径 0.25μm 以下のフィルターを通したものを使用して下さい。 

500mL ボトル(部品番号 9300-1748)の場合、100～400mL の範囲で液体を入れること

ができます。100mL ボトル(部品番号 5042-6478)の場合、40～80mL の範囲で液体を入

れることができます。いずれのボトルを使用する場合、ガラスフィルターが液体の中

に完全に沈み込むようにしてください。 

⑥ 廃液用ボトル(装置に向かって右側)を空にします。 

⑦ バッファ用ボトルと廃液用ボトルをそれぞれ元の位置に戻し、キャップをしっかりと締

めます。 

------------------------------------------------------------------------------------------------------------------------- 

＜ChemStation から操作する場合＞-----Clean Tubes のみ実施 

⑧ Done を選択します。ボトル内部が再び加圧されます。 

⑨ システムが Ready 状態になるまで待ちます。 

⑩ バッファ用ボトルと廃液用ボトルの間をクリックします。 

⑪ 内部の流路を全てクリーニングするため、Clean Tubes を選択します。 

⑫ キャップをした空のバイアルをサンプルトレイの(例として)46 番に置きます。 

⑬ トレイにセットした空のバイアルのバイアル番号(ここでは 46 番)と、洗浄繰り返し回

数を 5 回と設定します。 

⑭ 洗浄プログラムがスタートします。 

 

＜注意＞ 2010 年 3 月 10 日現在(ChemStation Rev.B.04.02[118])、ChemStation において

Flush Tubes のメニューを選択できません。Clean Tubes を繰り返し実行するか、Lab 

Advisor から手順 10 以降を実施して下さい。Lab Advisor での操作が終わり、再び

ChemStation から装置をコントロールする場合は、Lab Advisor の左下隅の鍵のマークをク

リックして Lab Advisor からのコントロールを解除して下さい。 

------------------------------------------------------------------------------------------------------------------------- 
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＜Lab Advisor から操作する場合＞----- Flush Tubes と Clean Tubes を実施 

⑧ OK を選択します。ボトル内部が再び加圧されます。 

⑨ 圧力システムが Ready 状態になるまでに要した時間が表示されます。再び OK を選択

します。 

⑩ バッファ用ボトルと廃液用ボトルの間のチューブとバルブを洗浄するため、Flush 

Tubes を選択します。フラッシュ時間を 20sec に設定します。このステップでは、リ

プレニッシュニードルとそのバルブ側の流路の洗浄は行いません。 

⑪ 内部の流路を完全にクリーニングするため、Clean Tubes を選択します。 

⑫ キャップをした空のバイアルをサンプルトレイの(例として)46 番に置きます。 

⑬ トレイにセットした空のバイアルのバイアル番号(ここでは 46 番)と、洗浄繰り返し回

数を 5 回と設定します。 

⑭ 洗浄プログラムがスタートします。 

 

＜備考＞ 

リプレニッシュメントシステムの容量は約 5mL です。洗浄には 10 倍の容量の液体をフラ

ッシングする必要があります。必要なフラッシュ時間は、使用するバッファの粘性に大きく

影響されます。まず Flush tubes でメイン流路を洗浄し、次に Clean tubes でリプレニッシ

ュメント流路を洗浄することにより、洗浄に用いるバッファの消費を抑えることができます。
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【リプレニッシュメントシステムをしばらく使用しない場合】 

リプレニッシュメントシステムをしばらく使用しない場合は、最初に純水で洗浄した後、さ

らにイソプロパノールで洗浄します。 

 

洗浄の手順 

■ 耐圧ボトルに洗浄液を入れます。 

■ Flush tubes を実行し、流路を洗浄します。 

■ Clean tubes を実行し、流路を洗浄します。 

■ Clean level sensor を実行し、レベルセンサーを洗浄します。 

 

① Lab Advisor ソフトウェアを開き、装置のモニタリングを開始します。 

② Tools : CE Control Screen ＞ Replenishment System の画面を表示させます。 

③ メニューの中から Change Bottles を選択します。この操作により、ボトルを外す前に

ボトルの中にかかっていた圧力が抜けます。”Pressure and vacuum have been released”

と表示されたのを確認してからボトルを外してください。 

④ 耐圧ボトルが設置されているスペースの前面についている黒いカバーを開けます。カバ

ーの右下(装置に向かって)の隅を押すと、ロックが外れカバーが開きます。 

 

＜警告＞ 

廃液には、泳動バッファ成分やサンプル成分が含まれています。ボトル内の液体を取り扱う

時は、ゴム手袋と保護眼鏡を着用してください。 

 

⑤ リプレニッシュメントシステムの耐圧ボトルのキャップを外します。ボトルのキャップ

にはチューブとフィルターがつながっています。フィルターを汚染しないように注意し

て下さい。 
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⑥ バッファ用ボトル(装置に向かって左側)に純水 200ml を入れます。水はあらかじめ孔径

0.25μm 以下のフィルターを通したものを使用して下さい。 

500mL ボトル(部品番号 9300-1748)の場合、100～400mL の範囲で液体を入れること

ができます。100mL ボトル(部品番号 5042-6478)の場合、40～80mL の範囲で液体を入

れることができます。いずれのボトルを使用する場合、ガラスフィルターが液体の中

に完全に沈み込むようにしてください。 

⑦ 廃液用ボトル(装置に向かって右側)を空にします。 

⑧ バッファ用ボトルと廃液用ボトルをそれぞれ元の位置に戻し、キャップをしっかりと締

めます。 

⑨ OK を選択します。ボトル内部が再び加圧されます。 

⑩ 圧力システムが Ready 状態になるまでに要した時間が表示されます。再び OK を選択

します。 

⑪ バッファ用ボトルと廃液用ボトルの間のチューブとバルブを洗浄するため、Flush 

Tubes を選択します。フラッシュ時間を 20sec に設定します。このステップでは、リ

プレニッシュニードルとそのバルブ側の流路の洗浄は行いません。 

⑫ 内部の流路を完全にクリーニングするため、Clean Tubes を選択します。 

⑬ キャップをした空のバイアルをサンプルトレイの(例として)46 番に置きます。 

⑭ トレイにセットした空のバイアルのバイアル番号(ここでは 46 番)と、洗浄繰り返し回

数を 5 回と設定します。 

⑮ 洗浄プログラムがスタートします。 

⑯ 純水に換えて、イソプロパノールを用いて、洗浄操作を繰り返します。バッファ用ボト

ルの液を入れ替えるときは、必ず廃液ボトルを空にしてください。 
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【レベルセンサーの洗浄】 

目的 

リプレニッシュニードルは、長さの異なる 2 つの細いニードルが合わさった形状をしてい

ます。長いニードルからバッファを吐出および吸引を行い、短いニードルは液面高さ(レベ

ル)センサーとして働きます。レベルセンサーの洗浄は、センサー内で析出する可能性のあ

るバッファ中の成分を溶解させるために行います。レベルセンサーの洗浄と同時に、レベル

センサー回路の流路も洗浄します。 

 

頻度 

■ リプレニッシュメント操作中にレベルセンシングに失敗した場合 

■ Lab Advisor の IRP(Injection Replenishment and Pressure)レベルセンシングテストに失

敗した場合 

■ リプレニッシュメントシステムをしばらく使用しない場合 

 

必要なもの 

□ 1.5cm の高さまで洗浄液(純水など)を入れ、キャップをしたバイアル 

 

＜注意＞ 

洗浄液の液面高さは 1.5cm を超えないでください。洗浄液はバッファの成分が析出しない

ものを選んでください。 
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動作 

この機能では、下記の(1)→(2)の洗浄サイクルを 8 回繰り返します。 

(1) 短いニードルを洗浄液に入れ、洗浄液を短いニードルに少し吸い込む。 

(2) 短いニードルから洗浄液を吐出し、空気を短いニードルに少し吸い込む。 

 

操作 

この操作は Lab Advisor から実施します。 

① メニューの中から Clean level sensor を選択します。 

② 高さ 1.5cm まで洗浄液(純水など)をバイアルに入れ、キャップをしたものをサンプルト

レイの(例として)48 番に置きます。 

③ トレイにセットしたバイアル番号(ここでは 48 番)を設定します。洗浄繰り返し回数を

8 回と設定します。 

④ 洗浄プログラムがスタートします。 
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１１－２．電極とリプレニッシュニードルの位置調整 

目的 

電極(或いはリプレニッシュニードル)とプレパンチャーの位置が適切でないと、プレパンチ

ャーの漏斗状の内側部分に摩耗による溝が確認される事があります。溝が深いと密閉性が不

十分となり、フラッシュ、注入、または CEC アプリケーションなどの高圧を使用する際に、

問題が発生する恐れがあります。 

 

頻度 

電極は調整がほとんど不要な設計になっていますが、下記に挙げる場合、念のため調整を行

ってください。 

■ （必須）Agilent 7100 CE の装置内部(Liquid Handling Module)を前面に引き出して戻し

た後 

■ 誤って電極/リプレニッシュニードルを曲げた恐れがある場合 

■ 電極を新品に交換した後に、電極のアライメントが不適切であると判断される場合（通

常、アライメントが不適切になることはありません。） 

■ 絶縁プレートを新品に交換した後に、電極のアライメントが不適切であると判断される

場合（通常、アライメントが不適切になることはありません。） 

 

必要な部品 

□ 電極アラインメントツール････････････････スタートアップキットに含まれています 

ない場合は、不要な長いキャピラリーで代用できます。 

□ 空のバイアルにスナップキャップを付けたもの 

□ Lab Advisor ソフトウェア 

□ 保護用眼鏡 
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① Lab Advisor ソフトウェアを起動し、Instrument Monitoring が行われていることを確認

します。モニターしている 7100CE を選択して、Tools : CE Control Screen の画面を表

示させます。 

② メニューの中から Alignment center を選択します。 

③ フロントカバーをつけた状態で動作させるか、フロントカバーを外した状態で動作させ

るかを選択します。フロントカバーありの場合は、電極とプレパンチャーのアライメン

ト状況を目視するのみになります。フロントカバーなしの場合は、電極に直接アクセス

することができるため、調整が可能です。 
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【フロントカバーを付けたまま動作させる場合】 

④ Installed を選択します。 

 

 

＜警告＞ 

動作部がカバーされているため、早い動きで装置が動作します。動作中は、トレイドアーや

フロントカバーを開けないでください。動作中に開けると、トレイモーターがブロックされ

るため、装置をリセットし直す必要が生じます 

 

⑤ 上記の警告(ソフトウェアの画面と同じ内容)を読んで確認したら、”I have read the 

above warnings”のチェックボックスにチェックを入れます。 

⑥ Continue を選びます。 
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⑦ アライメントを確認したい電極あるいはリプレニッシュニードルのリフトを選択しま

す。 

⑧ 短い電極(部品番号 G7100-60033)を使用している場合は、チェックボックスにチェッ

クを入れます。 

⑨ キャップをした空のバイアルをトレイにセットし、そのバイアル番号を入力します。 

⑩ Prepare を選択します。 

⑪ リフトが上がり、電極(或いはリプレニッシュニードル)に近い位置で停止します。 

⑫ 電極アラインメントツールのキャピラリーを挿入します。キャピラリーの先端がバイア

ルまでまっすぐ届けば、電極の中心とプレパンチャーの穴の中央が一致していると判断

できます。もし、キャピラリーがバイアルまでまっすぐに届かない場合は、電極の中心

とプレパンチャーの穴の中央がずれていると判断されます。電極(或いはリプレニッシ

ュニードル)を注意深くゆっくりと手で押し曲げて、電極の中心とプレパンチャーの穴

の中央が合うように調整します。 

 

＜注意＞ 

 Alignment center メニューを終了しないと、フロントカバーを開けての調整ができません。 

 

⑬ アライメントの最終確認のため、Check を選択します。 

⑭ リフトが 10 回上下動し、電極(リプレニッシュニードル)とプレパンチャーのアライメ

ント状況を目視します。この動作がスムーズであれば、良好なアライメント状態である

と判断します。もし、この動作中に、電極(或いはリプレニッシュニードル)がぶれて動

く場合は、再度電極の調整が必要と判断します。 
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【フロントカバーを外して動作させる場合】 

装置内部がオープンになるので、視認性がよく電極の微調整を直接行えます。しかし、可動

部がむき出しになり、安全性にリスクが生じますので、リフトとトレイはゆっくり動作しま

す。 

④ Removed を選択します。 

 

 

＜警告＞ 

装置の可動部には決して手を触れないでください。動作中は、装置内部に決して触れないで

ください。怪我の危険があります。 

・トレイを手で動かさないでください。 

・トレイのバイアルを取り除いたり、新しく加えたりしないでください。 
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・ソフトウェアの指示があるまで、フロントカバーを取り付けないでください。 

・保護用眼鏡の着用をお願いします。 

 

⑤ 上記の警告(ソフトウェアの画面と同じ内容)を読んで確認したら、”I have read the 

above warnings”のチェックボックスにチェックを入れます。 

⑥ フロントカバーを外します。フロントカバーを外すことにより、次の操作へ進めます。 

⑦ Continue を選びます。 

⑧ アライメントを確認したい電極あるいはリプレニッシュニードルのリフトを選択しま

す。 

⑨ 短い電極(部品番号 G7100-60033)を使用している場合は、チェックボックスにチェッ

クを入れます。 

⑩ キャップをした空のバイアルをトレイにセットし、そのバイアル番号を入力します。 

⑪ Prepare を選択します。 

⑫ リフトが上がり、電極(或いはリプレニッシュニードル)に近い位置で停止します。 

⑬ 電極アラインメントツールのキャピラリーを挿入します。キャピラリーの先端がバイア

ルまでまっすぐ届けば、電極の中心とプレパンチャーの穴の中央が一致していると判断

できます。もし、キャピラリーがバイアルまでまっすぐに届かない場合は、電極の中心

とプレパンチャーの穴の中央がずれていると判断されます。電極(或いはリプレニッシ

ュニードル)を注意深くゆっくりと手で押し曲げて、電極の中心とプレパンチャーの穴

の中央が合うように調整します。 

⑭ Check を選択します。 

⑮ リフトが 10 回上下動し、電極(リプレニッシュニードル)とプレパンチャーのアライメ

ント状況を目視します。この動作がスムーズであれば、良好なアライメントであると判

断します。もし、この動作中に、電極(或いはリプレニッシュニードル)がぶれて動く場

合は、再度電極の調整が必要と判断します。 
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第１２章 補足２（Agilent の質量分析計と接続する場合） 

 

ここでは、Agilent CE/MS システムとして使用するケースを例に挙げます。 

Agilent CE/MS システムは、CE と質量分析装置(以下 MS)とシース液送液用ポンプ(以下シ

ース液用ポンプ)から構成されます。装置のコンフィグレーションの詳細は、構成システム

によって異なりますので、ここでは述べません。 

Agilent 1600 CE については、接続方法が Agilent 7100 CE と異なるため本章は適用外とな

ります。 

 

【ChemStation の設定について】 

① ChemStation ソフトウェアでツールバーより Instrument → More CE → CE 

Configuration を選択します。 

 

② ”MS Installed”にチェックマークを入れます。 
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③ システムダイアグラムの絵が次の通りに変更されます。 
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【接続について】 

Agilent 7100 CE で Agilent の MS と接続する際に次の 4 点が必要です。 

 

■ アースケーブル 

通常は、Agilent 7100 CE 筐体の金属部分と検出器筐体の金属部分を接続します。 

 

(参考) 

Agilent 7100 CE は、アウトレット側の電位をアースにとり、インレット側へ設ける電位差

を正/負とすることにより、印加電圧の極性(Positive/Negative)を切り替えています。 

Agilent 7100 CE 単体で用いる場合は、アウトレット側の電極は装置内の絶縁プレート上で

アースケーブルと接続する構造をしているため、このケーブルは必要ありません。 

 

■ APG リモートケーブル 

Agilent の装置間のスタート等の同期を取るために APG リモートケーブルを使用していま

す。この APG リモートケーブルは Agilent 製品のみサポートしています。 

 

■ CAN ケーブル 

Agilent の装置間の通信に用います。この CAN ケーブルは Agilent 製品のみサポートしてい

ます。 

 

■ LAN ケーブル 

Agilent の装置をコントロールするソフトウェア(Mass Hunter や ChemStation)がインスト

ールされたワークステーションとの通信に用います。 
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１２－１．ChemStation から CE と MS の両方をコントロールする場合 

(シングル四重極に限定) 

 

Agilent CE/MS システムとして使用するには次のポイントを確認して下さい。 

■ CE と MS をアースケーブルで接続します。 

■ MS とワークステーションを LAN で接続します。 

■ CE とワークステーションを LAN で接続します。 

■ CE と MS を APG リモートケーブルで接続します。 

■ CE とシース液用ポンプを CAN ケーブルで接続します。(シース液用ポンプが

ChemStation からコントロールされる場合) 

 

設定 

■ ChemStation の CE 分析メソッド中のプレコンディショニングが終了し、試料が注入さ

れて、電圧印加が開始するタイミングで MS 測定が開始します。 

■ MS シグナルのオンラインプロットは、MS 測定開始のタイミング以降から表示される

ようになります。 

■ ChemStationで設定したCEの分析時間(Stop time)に達すると、CEのエンド信号がAPG

リモートケーブルを通じて、MS へ伝達され MS 分析がストップします。MS の分析時

間(Stop Time)を No Limit にしておくと、CE の分析時間(Stop time)を CE/MS 分析全体

の分析時間とすることができます。 
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１２－２．Mass Hunter からコントロールする MS と接続する場合 

 

Agilent CE/MS システムとして使用するには次のポイントを確認して下さい。 

接続 

■ CE と MS をアースケーブルで接続します。 

■ MS とワークステーションを LAN で接続します。 

■ CE とワークステーションを LAN で接続します。 

■ CE と MS を APG リモートケーブルで接続します。 

■ CE とシース液用ポンプを CAN ケーブルで接続します。(シース液用ポンプが

ChemStation からコントロールされる場合) 

 

設定 

■ ワークリストパラメーターの設定において”External Start”を選択して下さい。 

■ 分析開始には、まず MassHunter のスタートボタンを押して、MassHunter 上に表示さ

れるステイタスが”Waiting”になっていることを確認します。次に、ChemStation のスタ

ートボタンを押します。 

■ ChemStation の CE 分析メソッド中のプレコンディショニングが終了し、試料が注入さ

れて、電圧印加が開始するタイミングで MS 測定が開始されます。 

■ MS シグナルのオンラインプロットは、MS 測定開始のタイミングにかかわらず、プレ

コンディショニング中も含め、表示されます。 

■ ChemStationで設定したCEの分析時間(Stop time)に達すると、CEのエンド信号がAPG

リモートケーブルを通じて、MS へ伝達されます。MS の分析時間(Stop Time)を No Limit

にしておくと、CE の分析時間(Stop time)を CE/MS 分析全体の分析時間とすることがで

きます。 
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１２－３．DAD を使用しないで CE/MS 分析を行う場合 

CE 単体で使用する場合は、DAD の重水素ランプが点灯していないと装置が Ready 状態に

なりません。CE/MS 分析時に DAD を併用しない場合などは、重水素ランプを点灯させず

に装置を Ready 状態にすることができます。 

 

① CE メソッドの DAD 設定タブの”Advanced”を開き、”Lamps is required for acquisition”

の”UV Lamp”のチェックを外します。 

 

 

② その他、DAD 設定タブの”Signals”と”Autobalance”のチェックを外します。 
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③ OK を押します。 

④ ランプが点灯しなくても、下図の通り Ready 状態になります。 



 

- 252 - 

第１３章 補足３ 

１３－１．ファイルとフォルダ 

 

階層ディレクトリの構造と、ファイル、フォルダの概念は ChemStation を自由に操る上で、

知っておかなければならない重要なことです。 

 

【ファイル】 

ChemStation を動かしているのはハードディスクに格納されているプログラムです。プロ

グラムは機能単位に分かれて格納されており、それぞれに名前が付けられ、その名前を指定

することでそのプログラムが実行されます。このような情報(この場合はプログラムですが、

生デー夕、テキスト、図形データ等の全ての情報)の単位を「ファイル」と呼び、そのファ

イルに付けられている名前を「ファイル名」と呼びます。ファイル名は英数字の名前と拡張

子から成り、名前と拡張子の間はピリオドで区別します。 

 

例：AUTOEXEC.BAT 

  （名前）.（拡張子） 

 

ChemStation のオペレーション時に使用する主な拡張子は次の通りです。 

 

 .D  データファイル 

 .M  メソッドファイル 

 .S  シーケンスファイル 

 .UVL  スペクトルライブラリファイル 

   .LOG  ログファイル 
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名前と拡張子には、英数字が使用可能です。但し、縦線(I)、ドット(・)、コロン(: )、不等号(<>)、セ

ミコロン(; )、ダブルコーテーション(")などは使用不可です。アンダーパー(_)のみ使用可能です。 CON、

AUX、PRN、NUL などのデバイス・ファイル名はディスク上のファイル名に使用できません。 

 

データ、メソッド、シーケンスはそれぞれ「.D」「.M」「.S」という拡張子をつけたフォ

ルダであり、フォルダの中にデータ、メソッド、シーケンスに関する情報がまとめて格納さ

れています。データ、メソッド、シーケンスをコピー/移動/削除する際には拡張子がついた

フォルダごとコピー/移動/削除します。 

 

 

 

 

例えば左図の「TEST01.D」というデータファイルは、

「ACQ.M」（データ採取時使用したメソッド）や「DA.M」

（解析用メソッド）、RUN.LOG（ログファイル）をはじ

め、さまざまな情報が一つのフォルダに格納されていま

す。 

このデータをバックアップするには、「TEST01.D」ごと

バックアップ先にコピーします。 
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【フォルダ】 

ファイルはディスクに記録されていますが、そのファイルの一覧がフォルダ(ディレクトリ)

です。フォルダにはファイルの大きさ（容量）や、ファイルが作成あるいは更新された日時

も記録されています。フォルダはツリー構造で下に成長していきます。このフォルダの中の

最上位のフォルダ、のことをルート(根幹)フォルダといいます。そしてルートフォルダに対

して下層のフォルダのことをサブフォルダ(サブディレクトリ)といいます。 

ケミステーションでのデフォルトのディレクトリの階層構造は以下のようになっています。 

 

※「＼＼C:＼Chem32＼1＼Data＼」はパス名と呼ばれ、ファイルに至るフォルダの道筋を

示します。ファイル名が同じでもパス名が異なると別のファイルとして存在できます。正し

いディレクトリからファイルを呼び出すように気をつけてください。 
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【メソッド/シーケンス/データ保存パスの設定】 

デフォルトのケミステーションではシーケンス、データ、メソッドを保存するパス名は以下

のようになっています。 

 ＼＼C:＼Chem32＼#＼Sequence＼  シーケンス保存パス 

 ＼＼C:＼Chem32＼#＼Data＼    データ保存パス 

 ＼＼C:＼Chem32＼#＼Methods＼CE＼  メソッド保存パス 

 ＼＼C:＼Chem32＼#＼speclibs＼       スペクトルライブラリ保存パス 

※ #には装置名が入ります。デフォルトの装置名は「1」です。 

上記のディレクトリに含まれるファイルは定期的にバックアップを取っておくことをお勧

めします。 

 

＜ヒント；メソッド/シーケンス/データ保存パスの設定＞ 

必要に応じて、各ファイル保存先のパスを複数設定することが可能です。 

  View → Preferences  
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Add キーを押して、保存したい先のパス名を選択してください。選択するパスは、予め、

Explorer 等で作成しておく必要があります。 

 

注意：各ファイルのデフォルトのパスは削除できません。 

注意：すでに登録されたパスのさらに下の階層のディレクトリを追加することはできません 

 

【ファイルの管理】 

Windows スタートボタンを右クリックし、Explorer を選択します。ウィンドウの左側のボ

ックスにフォルダの一覧表示がツリー構造で表示され、ウィンドウの右側のボックスに左側

のボックスで選択したフォルダの内容が表示されます。ファイル/フォルダのドラック、又

は右クリックしたファイル/フォルダ管理のメニューから、ファイルのコピー/ペースト等を

行うことができます。エクスプローラーを使用すると、ファイル管理が簡単に行えます。フ

ァイルのバックアップ（コピー）をしたり、不要なデータファイルを削除したりする場合に

便利です。 
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＜ヒント：データ保存フォルダの階層構造について＞ 

ケミステーションの新しいデータ管理基本構造であるシーケンスコンテナの機能を使用す

るか使用しないかによって、データ保存フォルダの階層構造が異なります。ユニークなフォ

ルダ（シーケンスコンテナ）のオン/オフについては 4－2 節を参照してください。 

 

＜ユニークなフォルダ（シーケンスコンテナ）をオフにした場合＞ 

データフォルダの階層構造は下記のようになります。 

 

※Sample Information の設定方法は 3-1 節、Sequence Parameter の設定方法は 5-1 節

を参照してください。 

※同じディレクトリ内に同じ名前のデータファイルは複数存在できません。ディレク

トリ内にすでにあるデータファイルと同じ名前を設定して分析を行った場合はデー

タが上書きされますのでご注意ください。 

…
…

データ保存パス

Sample Information または Sequence Parameter に

て保存先のサブディレクトリを設定しない場合、デ

ータ保存パスの直下にデータファイル（***.D）が保

存されます。 

Sample Information または Sequence Parameter に

て保存先のサブディレクトリを設定した場合、サブ

ディレクトリの直下にデータファイル（***.D）が保

存されます。 
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＜ユニークなフォルダ（シーケンスコンテナ）をオンにした場合＞ 

データフォルダの階層構造は下記のようになります。 

 

※Sample Information の設定方法は 3-1 節、Sequence Parameter の設定方法は 5-1 節

を参照してください。 

※シーケンスコンテナはシーケンススタート時に自動的に生成されます。これにより

ディレクトリ内にすでにあるデータファイルが上書きされるのを防ぎます。 

…
…

Sample Information にて保存先のサブディ

レクトリを設定しないシングルラン分析の

場合、データ保存パスの直下にデータファイ

ル（***.D）が保存されます。 

Sequence Parameterにて保存先のサブディ

レクトリを設定しないシーケンス分析の場

合、データ保存パスの下にシーケンスコンテ

ナが生成され、シーケンスコンテナの下にデ

ータファイル（***.D）とシーケンスメソッ

ド（***.M）が生成されます。 

Sample Information にて保存先のサブディ

レクトリを設定したシングルラン分析の場

合、サブディレクトリの直下にデータファイ

ル（***.D）が保存されます。 

Sequence Parameterにて保存先のサブディ

レクトリを設定したシーケンス分析の場合、

の下にシーケンスコンテナが生成され、シー

ケンスコンテナの下にデータファイル

（***.D）とシーケンスメソッド（***.M）が

保存されます。

データ保存パス



 

- 259 - 

１３－２  イージーシーケンスの利用 

１３－２－１．イージーシーケンス（Easy Sequence）とは 

  

＜注意＞ 

イージーシーケンス機能は、「あらかじめ設定済みのシーケンス分析（イージーシーケン

スセットアップ）」について、複数のシーケンスを ChemStation に登録し順に分析する機

能です。大量のサンプルをルーチンで分析する際には有効な機能ですが、通常のキャピラ

リー電気泳動の分析では、イージーシーケンス機能はほとんど使用されることはありませ

ん。本項では参考として、イージーシーケンス機能を使用した分析の流れを説明していま

す。 

シーケンス分析実行中に、予定していなかったサンプルを追加で分析したい場合、または

サンプルの分析順序を変更したい場合は、現在のシーケンスを編集する方法が簡単です。シ

ーケンス実行中でもメニューの Sequence → Sequence Table を選択して、シーケンステ

ーブルを編集することができます。（5-5 節＜ヒント：サンプルの追加/分析順序の変更＞参

照） 
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イージーシーケンスでは、 

・複数のシーケンスをキューに溜めて、順に分析 

ができます。 

・キューの順序を変えることが可能です。 

・サンプル名、データ名を関連付けて 

 カウントアップできます。 

・周期的キャリブレーションのプランが視覚的に 

 組み立てられます。 

・同じシーケンスの繰り返しなら、サンプル登録が簡単です。 

 

 

 

 

イージーシーケンスでは使用上、次の制限があります。 

・１つのシーケンスの中に組み込めるのは 1つのメソッドのみです。 

・設定可能なバイアル順は、番号順に連続した順のみです。 

・周期的キャリブレーションは、ブラケット（挟み込み）のみ使用可能です。 

・周期的キャリブレーションで使用可能な更新方法は、1つのみです。 

 （設定できないケース：はじめに「置き換え」以降を「平均」） 
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イージーシーケンスを利用するには、あらかじめメソッドを作成しておく必要があります。

また、シーケンスコンテナの設定をオンにしてください。 

 

イージーシーケンスはタブで切り替えを行いながら設定します。 

イージーシーケンスの操作タブは Method & Run Control画面からアクセスすることができ

ます。 

① Easy Sequence Setup（イージーシーケンスセットアップ）タブ 

 イージーシーケンステンプレート（.est）を作成するためのタブです。 

サンプルカウンタ、データ命名法等を指定します。 

② Easy Sequence（イージーシーケンス）タブ 

 イージーシーケンステンプレート（.est）を利用して、 

 開始位置、サンプル数等を入れて、実際のサンプルリストを作成し 

 キューに登録するタブです。 

③ Sequence Queue（シーケンスキュー）タブ 

 現在キューに溜まっているシーケンス一覧を見ることができます。 

 シーケンスの順を変更することもできます。 

 

 

 

 

 

 

イージーシーケンス機能の基本操作は以下の通りです。 

  

② ③ ①
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イージー 
シーケンス 
セットアップ 
を作成する。 

（.estテンプレート

を作る） 

  次の一連サンプル

を用意する 

次  次 
↓    ↓ ↓ ↓ 

イージー 
シーケンス画面で 
.estテンプレート 
を読みだす。 

  イージー 
シーケンス画面で 
.estテンプレート 
を読みだす。 

 

 

↓    ↓ ↓ ↓ 

開始ロケーション 
を入力する。 

  開始ロケーション 
を入力する。 

 

↓    ↓ ↓ 

サンプル数 
を入力する。 

  サンプル数 
を入力する。 

 

↓    ↓ ↓ ↓ 

「サンプルリスト 
の作成」 

ボタンを押す。 

  「サンプルリスト 
の作成」 

ボタンを押す。 

 

↓    ↓ ↓ ↓ 

「保存して 
キューに追加」 
ボタンを押す。 

  「保存して 
キューに追加」 
ボタンを押す。 

 
 

↓    ↓ ↓ ↓ 

イージー 
シーケンス 
（.es）を 

名前を付けて 
保存する。 

  イージー 
シーケンス 
（.es）を 

名前を付けて 
保存する。 

 
 

↓    ↓ ↓ ↓ 

シーケンスが 
キューに 
登録される 

  シーケンスが 
キューに 
登録される 

キューに キューに 
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１３－２－２．イージーシーケンスセットアップテンプレートを作成する 

ここでは、イージーシーケンスセットアップテンプレート（.est）について記します。 

 （例として 

 「周期的キャリブレーションなし」 

 「サンプル名は「repro0001」,「repro0002」, 「repro0003」… の順」 

 「データ名は、「サンプル名.D」つまり「repro0001.D」,「repro0002.D」, …の順」 

  「データフォルダは、シーケンスコンテナ使用する」 

 「シーケンス保存名は、日付とする」 

    のテンプレートを作成します。） 

 

① 「Easy Sequence Setup」タブをクリックします。 

② 新しいテンプレート（.est）を作成するときは、 Clear all  ボタンを押してください。 

① 

② 
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③ ④ 念のため、 

Calibration タブの、 

キャリブレーションの設定が、 

「キャリブレーションなし」に 

なっていることを確認して下さい。 

 

Sample タブの各項目を設定します。 

 

 

⑤ 

⑥ 

⑦ 

⑧ 

⑨ 

⑩ 

⑪ 

⑫ 

③ 
④ 
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⑤ 使用するマスターメソッドを、一種類選んでください。「…」をクリックすると、選択

のダイアログボックスが開きます。 

⑥ 開始ロケーションを指定します。これは後のサンプルリスト作成時に変更できます。 

⑦ サンプル数を指定します。これは後のサンプルリスト作成時に変更できます。 

⑧ サンプル名の名前の付け方を指定します。 

ここでサンプル名にカウントアップの指

定をすると、後の手順のサンプルリスト

作成時に、名前の一部がカウンタになります。 

  入力欄中の三角マークをクリックすると、カウンタが選択できます。 

  例の中の <C> は、カウンタ部分を示します。任意の文字列を追加できます。 

  この場合、サンプル名は「repro0001」,「repro0002」, 「repro0003」のように 

  数字部分がカウントアップされます。 

⑨ データ保存ディレクトリを指定します。このフォルダの下にシーケンスコンテナが作成

されます。シーケンスコンテナの命名法は、 

 View → Preferences の設定に準じます。 

⑩ データファイルの名前の付け方を指定してください。 

  入力欄中の三角マークをクリックすると、 

「Counter」「Sample Name」が選択できます。 

  任意の文字列を追加することもできます。 

  また、後のステップの「サンプルリストの作成」「保存してキューに追加」の 

  操作の前にも変更することができます。 

   ヒント：例では、前出のサンプル名と同じになるように 

       設定しています。サンプル名とデータ名.D が、同じ名前になります。） 
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⑪ サンプルリスト作成時（後のステップ）で、シーケンスが作成されます。 

  このシーケンスの保存場所を選択してください。 

  デフォルトの C:¥chem32¥sequence で問題ありません。 

⑫ 保存するシーケンスの名前の付け方を指定してください。 

  入力欄中の三角マークをクリックすると、 

  「カウンタ」「サンプル名」が選択 

できます。任意の文字列を追加することも

できます。例では、日付が付くように設定しています。 

 

ヒント：後のステップの「保存してキューに追加」の操作の前にも変更することが 

        できます。その時にサンプルの大分類名を追加することもできます。 

 

設定が終了したら、イージーシーケンステンプレート（.est）を保存してください。 

上書き保存   名前をつけて保存  拡張パラメータ 

 

 初回は、「名前を付けて保存」してください。拡張子の「.est」は、自動で付きます。 

 

補足： シーケンスをキューに溜めて、連続的に実行する予定がある場合は、 

    以下の 2 点を確認してください。  
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１）シーケンスが次に進み、別のメソッドが読み込まれて、 

  分析条件が変わった時の安定待ち時間 

  Extended Parameters  の  Sequence Parameters タブ の  「Wait」に 

  メソッドが変わった後に、何分待ってから分析を開始するかを入力してください。 

 

２）ポストシーケンスコマンドの設定 

Extended Parameters  の 「Sequence Parameters」タブ の 

   「Post Sequence Command/Macro」に 

  「STANDBY」など装置を停止させるコマンドが入っていないことを確認して下さい。 

  実行中のシーケンスが終了した時点で STANBY になると、機器は NotReady になるの

で次のキューのシーケンスが始められません。 

 

拡張パラメータの変更をしたら、改めて、イージーシーケンスセットアップ（.est.）を保

存してください。 

 

 



 

- 268 - 

補足：非表示チェックボックスについて 

 イージーシーケンスセットアップ画面の「Easy 

Sequence Table Columns」で「Hide」のチェック

ボックスをオンにすると、その項目は、イージーシ

ーケンス画面（サンプルリスト作成の画面）に表示

されなくなります。 

サンプルリスト作成時の画面を簡易にできます

が、.est ファイルの管理など、運用上の注意が必要

です。 
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１３－２－３．イージーシーケンスをキューに追加する 

ここでは、サンプルリストを作成して、シーケンスをキューに溜める方法について記してい

ます。 

 

前準備として、オペレータ名を入力してください。メニューから、 

 Run Control → Sample information  

のダイアログボックス中の、「Operator」の欄にオペレータ名を入力します。この名前は、

データファイルに埋め込まれます。

後からの変更はできません。 

 

① イージーシーケンスタブをクリ

ックして、イージーシーケンス画面

を表示します。 

 

② イージーシーケンスセットアップ（.est）を開きます。 

  読み込みダイアログボックスが現れるので目的のテンプレートを読み込みます。 

 

⑤ 

③ 
④ 

① 

② 
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③ 開始ロケーション（実際にサンプルを並べる開始地点）を指定します。 

④ サンプラーに並べる実際のサンプル数を入力します。 

  注意：48 番を超えない範囲で設定してください。 

      また、48 番の後に、1番に戻る設定はできません 。 

 

⑤ 画面中央の  Fill Samples  ボタンをクリックします。 

  画面の下方にサンプルリストが表示されます。 

 

 ヒント：サンプルリストは、イージーシーケンスセットアップ（.est）の通りに 

    作成されますが、サンプルリストテーブル上でも編集が可能です。 

 その際には、カウントアップ順などに気を付けてください。 

 

⑦ 画面上のそのほかの各欄「メソッド情報」「データ情報」「シーケンス情報」に 

    間違いがないか確認してください。 

   （イージーシーケンスセットアップ .est の通りです。） 

  



 

- 271 - 

 

 注意：次のステップで、シーケンスがすぐに始まる場合があります。 

   このまますぐにシーケンスを開始する場合は、 

ここで「機器コントロール」タブに戻って、カラム等コンディショニングを

実施してください。 

 

⑧ 画面中央下部の、  Save and Add to Queue  ボタンをクリックします。  

この操作では、イージーシーケンス（.es）を保存して

から、このシーケンスをキューに登録します。 

 

画面にはイージーシーケンス（.es）の保存を促す画面が現れます。 

（イージーシーケンス（.es）を保存しないと、サンプルリストは登録されません。） 

 

適切な名前を付けて、イージーシーケンス(.es)を保存してください。 

 

装置が、レディ状態で、現在のメソッドが読み込み後の変更を受けていなければ、 

キューに溜まったシーケンスがすぐに実行されます。 
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１３－２－４．イージーシーケンスを実行する 

ここでは、キューにあるシーケンスの実行について記します。 

1 つめのシーケンスがキューに溜まった時、シーケンスがすぐにスタートするかどうかは、 

機器の状態により違います。 

 

（１）機器がレディ状態で、現在のメソッド（カレントメソッド） 

が読み込み後、変更を受けていない場合。 

 

→ シーケンスキューはすぐにスタートします。 

 

 

 

 

（２）機器が、スタンバイなどノットレディーの場合。 

  機器がオンになってはいるが安定待ちの場合。 

  現在のメソッド(カレントメソッド)、シーケンスが、読み込み後変更を受けている場合。 

 

→ シーケンスキューは「Pending（保留中）」になります。シーケンスキューを一時停止

し、シーケンスキューの始めに使用されるマスターメソッドを読み込み、機器がレデ

ィ状態になるのを確認します。その後シーケンスキューの一時停止を解除します。 
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ここでは、イージーシーケンスの開始について、全ページの（２）のケースを説明します。 

 

① シーケンスキュータブをクリックして、シーケンスキュー画面に移ります。 

  （シーケンスキューは保留になっています） 

② シーケンスキューを一時停止させます。 

③ 機器コントロールタブをクリックして画面を変えます。 

④ 各機器のオン操作等の準備をします。 

⑤ シーケンスキューの始めに使用されるマスターメソッドを読み込みます。 

⑥ 機器のレディを確認し、必要ならばキャピラリーのコンディショニング等を行います。 

⑦ シーケンスキュータブをクリックして、シーケンスキュー画面に移ります。 

  （シーケンスキューは先ほど一時停止にした状態のままです。） 

 

⑧ シーケンスキューの一時停止を解除します。シーケンスが開始されます。 

⑦ 

⑧ 

① 

② 

③ 
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１３－２－５．キューの操作 

ここでは、シーケンスキューのアイコン操作を記します。 

 

現在進んでいるキューを一時停止します。 

現在実行しているシーケンスは、停止しません。 

キューは一時停止して進みません。 

 

一時停止したキューを再開します。 

 

キューのシーケンスの順序を変更できます。 

変更させたいシーケンスの行をクリックすると、行の色が反転します。 

この状態で、順序を早めたいときは上向きボタンを、 

順序を後にしたいときは、下向きのボタンを押します。 

 

キューのシーケンスを削除できます。 

削除するには、対象のシーケンスの行をクリックして、行の色が反転させて

から、ボタンをクリックします。 

 

現在のキューを、印刷します。 

 

キューにあるシーケンスを編集できます。（サンプル名、データ名等にカウ

ンタを使う場合が多いので、お勧めしません） 
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補足：シーケンスの途中停止について 

   現在実行中の連続分析の一時停止/停止の方法は、 

   5-6 節の「シーケンスの一時停止」の通りですが、イージーシーケンスを使用して 

   キューにシーケンスが溜まっている場合注意が必要です。 

 

   シーケンスキューに、シーケンスが溜まっている時、 

   シーケンスの停止、または中断をするときは、 

   あらかじめシーケンスキューを一時停止してください。   

 

   キューを一時停止しないで、シーケンス停止、または中断すると、 

   キューの次のシーケンスが始まってしまいます。 

   （シーケンスが停止／中断したあと、機器とソフトウェアはレディになるため。） 

 

   シーケンスキューを使用していて、現在のシーケンスを一時停止する場合には、 

メニューから、 Run Control → Pause と操作します。 

再開するには、 Run Control → Resume と操作します。 

（シーケンス自体が一時停止しているため、キューも進みません） 
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ヒント：イージーシーケンスキューが最後まで終わったら、機器をスタンバイにするには 

 キューの最後のシーケンスの設定で、最後にスタンバイになるようポストシーケ

ンスコマンドを設定します。 

     

＜ポストシーケンスコマンドの設定＞ 

Easy Sequence Setup タブを開き、 

     Extended Parameters  の 「Sequence Parameters」タブ の 

  「Post Sequence Command/Macro」にチェックを入れ「LAMPALL OFF」を選

択します。 

 

拡張パラメータの変更をしたら、改めて、イージーシーケンスセットアップ（.est）を保存

してください。 

 

注意：もし後からシーケンスを追加した場合には、 

   STANDBY 設定がされているシーケンスが最後になるように、 

   順序を変更してください。 
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１３－２－６．同じ、または類似のイージーシーケンスを実行する 

ここでは、すでに作成したイージーシーケンステンプレート（.est）から、 

類似のシーケンスをキューに組み入れる方法について記します。 

 

日常、同じ分析を繰り返す用途ならば、イージーシーケンステンプレートを作成しておけば、 

操作を簡略化できます。 

 

① 機器をレディ状態にして、オペレータ名を入力し、初めに使用されウマスターメソッド

を読みだしておきます。必要ならキャピラリーのコンディショニング等の準備をします。 

② 「カウンタのリセット」「命名法の文字列を変える」必要等の時は、「Easy Sequence 

Setup」タブでイージーシーケンステンプレート（.est）を編集します。 

  カウンタのリセットは各設定項目の右向き三角を 

  クリックすると、リセットボタンが出てきます。 

③ 「Easy Sequence」タブでイージーシーケンステンプレートを読み出します。 

④ 「Starting Vial Location」と「Number of Samples」を入力後「Fill Samples」ボタ

ンを押します。 

⑤ 「Save and Add to Queue」ボタンで、「.es ファイル」を保存してキューに追加しま

す。 

⑥ 装置がレディになれば分析が開始されます。 

⑦ 結果はオフラインソフトウェアのシーケンスコンテナ内で解析できます。 
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補足：類似分析をする際には、 

   「イージーシーケンスセットアップファイル（.est）」を使用することを 

   お勧めします。カウンタの値は、「.est」が持っています。 

    

   イージーシーケンス「.es」を読み出して使うとすると 

   前回保存した時と同じサンプルリストが出てきます。 

   つまり、同じサンプル名、同じデータファイル名になります。 

   しかし、イージーシーケンス機能を使用する上での推奨設定の 

   「ユニークなフォルダをオン」にして、フォルダの命名に「日付と時刻」を 

   入れておけば、後から取ったデータは別フォルダに溜まるので、 

   上書きの心配はありません。 

   ただし、サンプル群を特定するために、フォルダ名やログブックなどの記録から 

   実行された時刻を頼りにしなければいけません。 

    

  このため、「.est」の設定で、各種名前の付け方は、 

   Sample Name  → 識別できる文字列＋カウンタ 

   （日によってサンプル群の名称が異なる場合が多い） 

   Data File Name  → サンプル名 

        （解析時の１対１対応が容易に行える） 

Sequence Name     → 日付と時刻、または識別できる文字列との組み合わせ 

（実験ノートと、実験項目などを付き合わせが容易になる） 

  のような設定が考えられます。    
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１３－２－７．周期的キャリブレーションのプランを作成する 

ここでは、イージーシーケンスの機能の一つである、「周期的キャリブレーション」プラン

の設定について記します。イージーシーケンスでは、「周期的キャリブレーション」と「ブ

ラケットキャリブレーション」の２種類についてプランの作成ができます。 

 

ここでは周期的キャリブレーションのプランの設定を例にあげます。 

使用するメソッドの条件は、 

・キャリブレーションテーブルが作製されている 

・各成分のマイグレーションタイムが、正しく設定されている 

です。ここでは例として、  

「１点検量線」 「６回に１回リキャリブレーションする」 

のプランを作成します。 
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① 「Easy Sequence Setup」タブの、「Calibration」タブをクリックします。 

② キャリブレーションモードを「Cyclic」（周期的）に設定します。 

③ 「注入」項目で、サンプル何回に１回の 

   リキャリブレーションするかを設定します。 

④ キャリブレーションアイコンを、「周期的画面」に 

ドラッグします。 

  

① ② 

③設定 

④ドラッグする 
⑤設定

ここに概要が表示されます 

⑥変更の適用
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⑤ リキャリブレーションの設定をします。 

 

  ・Calibration Name： 

   キャリブレーションサンプルの 

   名前を設定します。 

  ・Vial location； 

   キャリブレーションサンプルの 

   位置を指定します。 

  ・Injections/Vial：  注入回数を設定します。 

  ・Calibration level： 検量線の何点目であるかを指定します。 

  ・Update Response Factor： 

  このキャリブレーションサンプルの値で、レスポンスファクタをどのように変更するか

を指定します。 

  ・Update Retention Time： 

このキャリブレーションサンプルの測定結果のマイグレーションタイム（MT）で、

＜E ウィンドウの位置の更新方法をどのようにするか指定します。 
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⑥ 入力したら Accept Changes ボタンをクリックして下さい。 

 

多点検量線の場合は、各レベルについて、④⑤のステップを繰り返してください。 

 

キャリブレーションプランの概要が表示されます。確認の上、「サンプルタブ」の編集に 

進んでください。編集終了後は、イージーシーケンスセットアップ（.est）を 

保存してください。 

 

手順のガイドは、オンラインヘルプもご参照ください 

 

注意：イージーシーケンス機能では、 

「Update Response Factor（レスポンスファクタ更新）」「Update Retention Ti

me（更新、CE の場合はマイグレーションタイム更新）」の方法が、毎回同じ様に

設定されます。 

    （以下のような設定はできません：初回のキャリブレーションで、ＲＦ、ＲＴを 

    更新する。2 回目以降は平均する） 

リキャリブレーション方法が同一でないシーケンスを作成するには、ケミステーシ

ョンのシーケンステーブルで作成してください。 
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補足：QC サンプル、ブランクランについて 

周期的キャリブレーションを含むイージーシーケンスでは、 

シーケンスの中に「QC サンプル」、「ブランク」を設定することができます。 

これらのサンプルに対しては、 

別のサンプル名 

別のメソッド 

固有のロケーション 

さらに、 

ブランクに対しては、注入の有り／無し 

が設定できます。 
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１３－２－８．イージーシーケンスの設定と操作のヒント 

ここではイージーシーケンスの設定と操作のヒントをいくつか紹介します。 

詳細は、各節もしくはオンラインへルプもご参照ください。 

 

① データの上書きがされないようにするには、どのような設定が必要でしょう？ 
  ユニークフォルダを必ずオンにして、名前のパターンに<Date><Time>を入れてくださ

い。 

   操作は、メニューから、View → Preferences 

 
② シーケンスをキューに溜める時の注意点はなんでしょう？ 
  拡張パラメータに注意してください。 

「Wait {xx} minutes after loading a new method」

の項目に、必要な待ち時間を設定するようにして

ください。 

 

③ カウンタをリセットするにはどのような操作をしますか？ 

  イージーシーケンスセットアップ（.est）に 

戻って、カウンタをリセットしてください。 

  「Sample Name」欄の右矢印ボタンでダイアロ 

グボックスを出し、「Reset」を押してください。 

  .est を上書き保存しなくてもカウンタはリセットされます。 

 

④ いつも「mysample0001」～のようなサンプルリストを作成するにはどうすればいい

でしょう？ 
  .est セットアップの「サンプル名」欄に、 

  「mysample<C>」と入力後、右矢印ボタンで 

  ダイアログボックスを出し、「リセット」を 

   押してください。 

（文字列部分を変更した場合、.est を、名前を付けて（または上書き）保存が必要です）  
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⑤ サンプル名や、データ名の、プレフィックスを書き換えるにはどのような操作をしま

すか？ 

  .est セットアップまで戻って、プレフィックス部分を書き換えてください。 

  .est を上書き保存し、「Fill Samples」サンプルリストを作成してください。 

  「Fill Samples」後のリスト上での修正でもできます。 

 
⑥ サンプル数がいつもと違う時はどのような操作をしますか？ 

  イージーシーケンス画面の、「サンプル数」欄に数値を入力後、 

  「サンプルリスト作成」ボタンを押してください。 

    

 

⑦ 開始ロケーションを変更したいときはどうすればいいでしょう？ 
  イージーシーケンス画面の、「Starting Vial Location」欄に数値を入力後、 

  「Fill Samples」ボタンを押してください。 

 

    

 

⑧ イージーシーケンスを使用して、キューにシーケンスが溜まっています。 

  シーケンスと一旦停止させるにはどうしたらよいでしょう？ 

まず、右図のアイコンをクリックしシーケンスキューを一時停止してくだ

さい。 

そのあと、メニューの Run Control → Pause Sequence またはステータス画面の

Pause を選択します。 

再開するには、メニューの Run Control → Resume Sequence またはステータス

画面の Resume を選択します。 
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第１４章  よりよい分析のために（分析上の注意点） 

１４－１．水酸化ナトリウム水溶液によるキャピラリー洗浄とその効果 

 

実試料分析した場合、実試料中に含まれる夾雑成分（例えばタンパク質など）などがキャピ

ラリー内壁に吸着するなどして、ピーク形状の悪化やベースラインの変動、移動時間の遅れ

などの現象が生じる場合があります。その場合、0.1N 程度の水酸化ナトリウム水溶液でキ

ャピラリーを洗浄（フラッシング）することで、現象が改善される場合があります。 

ただし、水酸化ナトリウム水溶液でキャピラリーを用いてキャピラリーを洗浄すると、洗浄

しない場合と比較してキャピラリーの寿命が短くなる場合があります。 

 

【マニュアル操作にて水酸化ナトリウム水溶液で洗浄する場合】 

一般には以下のような順序で洗浄（コンディショニング）を行います。 

10min    0.1N 水酸化ナトリウム水溶液 

 ↓ 

10min    超純水 

 ↓ 

20～30min  使用するバッファ  

洗浄する時間は状況に応じて変更してください。 

マニュアル操作につきましては、1-4 節をご参照ください。    

 

【プレコンディショニングにて水酸化ナトリウム水溶液で洗浄する場合】 

分析毎（毎回）に洗浄を行う場合は、メソッドのプレコンディショニングでタイムテーブル

を設定します。 

 



 

- 287 - 

 

（例） 

   

 Vial# 1 廃液バイアル 

 Vial# 2 廃液バイアル 

 （廃液バイアルを別にすることで、NaOH のコンタミネーションを防ぎます。） 

 Vial# 3 純水の入ったバイアル 

 Vial# 4 0.1N 水酸化ナトリウム水溶液の入ったバイアル 

 Vial# 5 フラッシング用バッファの入ったバイアル 

 

※多段階での洗浄やフラッシングの時間は適宜編集してください。 

※バイアル番号は一例です。適宜バイアル番号の設定を行ってください。 

 

 

＜注意＞ 

間接吸光度法を用いた条件（例えば有機酸分析用バッファ、無機陰イオン分析用バッファ、

めっき液分析用バッファなど）の場合、水酸化ナトリウム水溶液を用いてキャピラリーを洗

浄すると、洗浄前との移動時間のずれやベースラインの階段状の変動、ベースラインのノイ

ズの増大等の現象が発生する場合があります。洗浄後は標準液を数回分析するなどして確認

してください。 

また、PVA などのコーティングキャピラリーは水酸化ナトリウム水溶液での洗浄は絶対に

Inlet の電極を純水の入っ

たバイアルに浸し、フラッ

シング用のバッファに

NaOH がコンタミネーショ

ンするのを防ぎます。 
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行わないでください。コーティングが劣化し、本来の性能が得られなくなります。コーティ

ングキャピラリーは、付属の取扱説明書に記載のある溶媒等で洗浄してください。 

 

＜注意＞ 

キャピラリーの洗浄には、水酸化ナトリウム水溶液以外の溶媒が適している場合があります。

その他の洗浄溶媒としては、0.1N 塩酸水溶液、アルコールなどがあります。分析条件や試

料の性質に合わせて適宜変更して下さい。 

また、洗浄溶媒に測定対象の化合物（水酸化ナトリウム水溶液で洗浄した場合にナトリウム

イオンを測定）が含まれる場合、洗浄後の分析に影響を与える場合がありますので、ご注意

ください。 
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１４－２．キャピラリーの保管方法 

 

分析終了後、フューズドシリカキャピラリーは純水でフラッシングし、さらに続いて空気で

フラッシングして保管しておくと、長く使用することが可能です。 

 

【翌日、あるいは数日後すぐに使用する場合】 

装置にキャピラリーが取り付けられた状態のままで問題ありません。その場合、バッファバ

イアルがリフトで持ち上げられ、キャピラリーの先端がバッファに浸かっている状態にして

おいてください。 

コーティングキャピラリーの場合は、キャピラリーに付属している説明書に従い、キャピラ

リーを洗浄してください。 

 

【しばらく使用しない場合】 

分析終了後、10 分間純水でフラッシングし、さらに５分間空気でフラッシングした後、装

置からキャピラリーを取り外して、箱に入れて保管してください。 

 

50mM 以上の高濃度のバッファや、ドデシル硫酸ナトリム（SDS）、シクロデキストリン

等の添加剤を加えたバッファを使用した場合は、必ず水で洗浄してから空気をフラッシング

し、乾燥させてから保管してください。 

 

【Basic Anion Buffer などの pH の高いバッファを使用した場合】 

Basic Anion Buffer（pH12.1）などの pH の高いバッファを使用した場合は、必ず純水で洗

浄した後、空気でフラッシングしてキャピラリー内を乾燥させてから保管してください。 

数日放置する場合でも、分析終了後にキャピラリーの中を水で置換することにより、キャピ

ラリーの劣化を防ぎます。 
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シーケンスの最後に洗浄メソッドを実行すると、自動で洗浄することが可能なため便利です。

詳細は 14-3 節をご参照ください。 
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１４－３．シーケンス終了時のキャピラリー洗浄について 

 

分析終了後、フューズドシリカキャピラリーは超純水でフラッシングし、さらに続いて空気

でフラッシングして保管しておくと、長く使用することが可能です。 

ここでは、シーケンス終了時のキャピラリーの洗浄方法について、説明します。 

 

キャピラリー洗浄用にメソッドを作成し、シーケンスの最後でその洗浄用メソッドを実行し

ます。 

 

【用意するもの】 

洗浄用の超純水が入ったバイアル ×1 個 

空のバイアル（キャップあり） ×2 個 

 

【洗浄用メソッドの例】 

バイアルセッティング 

バイアル バイアル番号 

廃液用 1 

洗浄用超純水 2 

空（キャップあり） 3 

空（キャップあり） 4 
（※）バイアルセッティングは一例です。状況に応じて変更してください。 

 

Method 設定例 

Vials   Inlet home：3  Outlet home：4 
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Cassette Temperature 分析用のメソッドと同じ 

High Voltage System Enable High Voltage のチェックを外します 

Stoptime   0.2min（0.01min 以下は設定できません） 

Preconditioning  1）Flush  600sec  Inlet：2  Outlet：1 

   2）Flush  300sec  Inlet：3  Outlet：4 

Injection   no Injection（設定なし） 

 

設定したメソッドに名前をつけて保存し、そのメソッドをシーケンスの最後に実行するよう

なシーケンステーブルを作成、実行します。 

ここでは、超純水で 10min（600sec）、空気で 5min（300sec）をフラッシングする方法を

説明しています。コーティングキャピラリーの場合は、付属の取扱説明書に従った洗浄方法

で洗浄してください。 

 

＜注意＞ 

超純水で洗浄後に空気でフラッシングする際に、界面活性剤を含むバッファ（例：ドデシル

硫酸ナトリウムを含むバッファ、有機酸分析用バッファ、有害陰イオン分析用バッファなど）

が廃液用バイアル内に含まれていると、バイアル内で泡が発生する場合があります。 

その場合は、上述のように廃液用バイアルの空のバイアルを用意するか、分析用とは別に廃

液用バイアルを用意してください。 
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１４－４．高濃度のバッファを用いる場合の電圧印加方法について 

 

非常に高濃度のバッファを用いる場合、バッファによっては電流値が非常に高くなる場合が

あります。この場合、高電流が急激に流れることなどにより、キャピラリーが折れるなどし

て電流が流れなくなることがあります。 

電流が 100μA 以上流れるような条件の場合には、分析中に電圧を印加する際に、徐々に印

加電圧を上げることで、キャピラリーへの急激なダメージを防ぐことが可能です。 

 

メソッドの設定方法を以下に示します。 

① メソッドの電圧設定（High Voltage System）で、Voltage を 0kV に設定します。 

 

 

 

 

 

 

 

 

 

時間 

電圧 

0.3min 

0kVに設定し

ます。 
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② Timetable にて、0.3min で 0kV から目的の印加電圧に到達するようなタイムテーブル

を作成します。 

 

 

＜注意＞ 

キャピラリーの劣化の原因は、高い電流値だけではありません。上述の方法を用いていても、

その他の要因等によりキャピラリーが劣化する場合があります。 
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１４－５．消耗品およびその他の部品リスト 

 

ここでは Agilent7100 キャピラリー電気泳動システムの消耗品リストを紹介します。 

部品番号 品名 交換の目安 備考 

5190-0917 長寿命重水素ランプ 
（RFIDタグ付） 

寿命は 2000 時間程度。 
長期保管はお勧めできな

いので必要時に購入。 

※1 

G7100-60007 電極（標準） 必要時、破損時、変形時

（通常は洗浄のみ。） 
※1 

G7100-60033 電極（ショート） 必要時、破損時、変形時

（通常は洗浄のみ。） 
※1 

G1600-67201 プレパンチャー 必要時、破損時、変形時

（通常は洗浄のみ。） 
 

3150-0619 エアフィルター 3 ヶ月に一度  

G7100-60002 キャピラリーカセット 必要時、破損時、変形時 ※1 

5182-0567 バイアル 1ml（バッファ用、ポ

リプロピレン製、100個入）  
消耗品  

5182-9697 バイアル 2ml（CEバッファ用、

透明ガラス製、100個入）  
消耗品  

5183-4623 バイアル 2ml（CEバッファ用、

透明ガラス製、500個入）  
消耗品  

9301-0978 サンプルバイアル 250μl（ポリプ

ロピレン製マイクロバイアル、

1000個入） 

消耗品  

5181-1512 スナップキャップ 
100個入(ポリウレタン、半透明) 

消耗品  

5042-6491 スナップキャップ 
500個入(ポリウレタン製、半透明)

消耗品  

G1600-62402 プラスチックネジ 
（プレパンチャー用)10個入 

変形時、紛失時  

5041-2168 ガラスフィルター リプレニッシュ使用時

は交換対象 
 

5062-8544 O－リング(5個入) 3-6 ヶ月に一度。破損時、

紛失時 
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5183-4669 CE用キャピラリーカッター 
(ダイヤモンド刃) 

切れ味低下で替刃のみ

交換。※CE/MS 用  
5183-4670 同上キャピラリーカッター用 

交換用ダイヤモンド刃 
切れ味が低下したら交

換。※CE/MS 用  
5181-8836 セラミックス製 

キャピラリーカッター(4枚入) 
キャピラリーのカット

に使用。あると便利。  
※ 1 は 7100 キャピラリー電気泳動システム専用部品です。1600 キャピラリー電気泳動シ

ステムでは使用できませんので、ご注意ください。 

 

その他の部品 

部品番号 品名 備考 
G7100-60210 標準キャピラリー用アラインメントインターフェース 

内径50μm カラー：緑 ※1 
G7100-60310 標準キャピラリー用アラインメントインターフェース 

内径75μm（100μm、150μm） カラー：青 ※1 
G7100-60150 バブルセルキャピラリー用アラインメントインターフェー

ス 
内径25μm カラー：黒 ※1 

G7100-60230 バブルセルキャピラリー用アラインメントインターフェー

ス 
内径50μm カラー：赤 ※1 

G7100-60330 バブルセルキャピラリー用アラインメントインターフェー

ス 
内径75μm カラー：黄 ※1 

G7100-60400 CE/MS用アラインメントインターフェース（非金属仕様） 
外径360μm カラー：ブルーグレイ ※1 

G1600-60002 CE/MS用キャピラリーカセット  
G7100-62700 ダイオードアレイ用光学フィルター、260nm 

ポリアクリルアミド等を充填したキャピラリーを用いた 
DNAおよびオリゴヌクレオチド分析用 ※1 

※ 1 は 7100 キャピラリー電気泳動システム専用部品です。1600 キャピラリー電気泳動シ

ステムでは使用できませんので、ご注意ください。 
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標準フューズドシリカキャピラリー 

部品番号 品名 備考 
G1600-63211 標準フューズドシリカキャピラリー 

内径50μm 全長33cm 有効長24.5cm カラー：緑  
G1600-60211 標準フューズドシリカキャピラリー 

内径50μm 全長48.5cm 有効長40cm カラー：緑  
G1600-61211 標準フューズドシリカキャピラリー 

内径50μm 全長64.5cm 有効長56cm カラー：緑  
G1600-62211 標準フューズドシリカキャピラリー 

内径50μm 全長80.5cm 有効長72cm カラー：緑  
G1600-64211 標準フューズドシリカキャピラリー 

内径50μm 全長112.5cm 有効長104cm カラー：緑  
G1600-63311 標準フューズドシリカキャピラリー 

内径75μm 全長33cm 有効長24.5cm カラー：青  
G1600-60311 標準フューズドシリカキャピラリー 

内径75μm 全長48.5cm 有効長40cm カラー：青   
G1600-61311 標準フューズドシリカキャピラリー 

内径75μm 全長64.5cm 有効長56cm カラー：青  
G1600-62311 標準フューズドシリカキャピラリー 

内径75μm 全長80.5cm 有効長72cm カラー：青  
G1600-64311 標準フューズドシリカキャピラリー 

内径75μm 全長112.5cm 有効長104cm カラー：青  
G1600-63411 標準フューズドシリカキャピラリー 

内径100μm 全長33cm 有効長24.5cm カラー：グレー  
G1600-60411 標準フューズドシリカキャピラリー 

内径100μm 全長48.5cm 有効長40cm カラー：グレー  
G1600-61411 標準フューズドシリカキャピラリー 

内径100μm 全長64.5cm 有効長56cm カラー：グレー  
G1600-62411 標準フューズドシリカキャピラリー 

内径100μm 全長80.5cm 有効長72cm カラー：グレー  
G1600-64411 標準フューズドシリカキャピラリー 

内径100μm 全長112.5cm 有効長104cm カラー：グレー  
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バブルセルフューズドシリカキャピラリー 

部品番号 品名 備考 
G1600-60132 バブルセルフューズドシリカキャピラリー 

内径25μm バブルファクタ5 光路長125μm 
全長48.5cm 有効長40cm カラー：黒  

G1600-61132 バブルセルフューズドシリカキャピラリー 
内径25μm バブルファクタ5 光路長125μm 
全長64.5cm 有効長56cm カラー：黒  

G1600-62132 バブルセルフューズドシリカキャピラリー 
内径25μm バブルファクタ5 光路長125μm 
全長80.5cm 有効長72cm カラー：黒  

G1600-60233 バブルセルフューズドシリカキャピラリー 
内径50μm バブルファクタ3 光路長150μm 
全長43.5cm 有効長35cm カラー：赤   

G1600-60232 バブルセルフューズドシリカキャピラリー 
内径50μm バブルファクタ3 光路長150μm 
全長48.5cm 有効長40cm カラー：赤  

G1600-61232 バブルセルフューズドシリカキャピラリー 
内径50μm バブルファクタ3 光路長150μm 
全長64.5cm 有効長56cm カラー：黒  

G1600-62232 バブルセルフューズドシリカキャピラリー 
内径50μm  バブルファクタ3 光路長150μm 
全長80.5cm 有効長72cm カラー：赤  

G1600-64232 バブルセルフューズドシリカキャピラリー 
内径50μm バブルファクタ3 光路長150μm 
全長112.5cm 有効長104cm カラー：赤  

G1600-60332 バブルセルフューズドシリカキャピラリー 
内径75μm バブルファクタ2.7 光路長200μm 
全長48.5cm 有効長40cm カラー：黄  

G1600-61332 バブルセルフューズドシリカキャピラリー 
内径75μm バブルファクタ2.7 光路長200μm 
全長64.5cm 有効長56cm カラー：黄  

G1600-62332 バブルセルフューズドシリカキャピラリー 
内径75μm バブルファクタ2.7 光路長200μm 
全長80.5cm 有効長72cm カラー：黄  

G1600-64332 バブルセルフューズドシリカキャピラリー 
内径75μm バブルファクタ2.7 光路長200μm 
全長112.5cm 有効長104cm カラー：黄  
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PVA コーティングキャピラリー 

部品番号 品名 備考 
G1600-61219 PVAコーティングキャピラリー 

内径50μm 全長64.5cm 有効長56cm カラー：緑  
G1600-61239 PVAコーティングキャピラリー 

内径50μm バブルファクタ3 光路長150μm 
全長64.5cm 有効長56cm カラー：赤   

G1600-67219 PVAコーティングキャピラリー 
内径50μm 全長125cm 有効長21.5cm カラー：青 

※2 
CE/MS 用

G1600-67319 PVAコーティングキャピラリー 
内径75μm 全長125cm 有効長21.5cm カラー：青 

※2 
CE/MS 用

G1600-60419 PVAコーティングキャピラリー 
内径100μm 全長48.5cm 有効長40cm カラー：グレー  

G1600-61419 PVAコーティングキャピラリー 
内径100μm 全長64.5cm 有効長56cm カラー：グレー  

※ 2 CE/MS 用の PVA キャピラリーは、MS-UV 検出器のアライメントインターフェースの

青色コードと一致する青色のアライメントストッパーが付いています。CE/MS 用の内

径 50μm の PVA コーティングキャピラリーのアライメントストッパーには、識別しや

すくするための黒点が付いています。 

 

＜注意＞ 

PVA コーティングキャピラリーはキャピラリーの内壁表面をポリビニルアルコールでコー

ティングしたキャピラリーです。このコーティングにより内壁表面のシラノール基の解離が

抑えられるため、電気浸透流が抑制されます。この PVA コーティングキャピラリーの使用

可能な pH 範囲は、pH2.5～9.5 です。ホウ酸バッファはこのキャピラリーでは使用できま

せんので、ご注意ください。 
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CEP コーティングキャピラリー 

部品番号 品名 備考 
G1600-62318 CEPコーティングキャピラリー 

内径75μm 全長80.5cm 有効長72cm   
 

＜注意＞ 

CEP コーティングキャピラリーはキャピラリーの内壁表面をポリマーでコーティングした

キャピラリーです。このコーティングにより内壁表面のシラノール基の活性が抑えられ、電

気浸透流が抑制されます。このCEPコーティングキャピラリーの使用可能な pH範囲は pH2

～8 程度です。CEP コーティングキャピラリーはホウ酸バッファでの使用が可能です。 



 

 

 



 

 

 

 

 

 

 

 

 

本書の内容の一部または全部を無断で複写・転載することは禁止されています。 

 

 トレーニング受付、操作･修理のご相談は： 

 アジレント・テクノロジー株式会社 

 カストマコンタクトセンター 

 

 〒192-8510 東京都八王子市高倉町 9-1 

  Tel:（フリーダイアル）0120-477-111 

  受付時間 9:00～12:00, 13:00～18:00 

  （土日祝祭日、年末年始を除く） 

  

  Fax:（フリーダイアル）0120-565-154 

  E-mail: email_japan@agilent.com 

 

 http://www.chem-agilent.com 


